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Chapter 1:

The APL Environment

Introduction

The Dyalog APL Development Environment includes a Session Manager, an Editor,
and a Tracer all of which operate in windows on the screen. The session window is
created when you start APL and is present until you terminate your APL session. In
addition there may be a number of edit and/or trace Windows, which are created and
destroyed dynamically as required. All APL windows are under the control of Win-
dows and may be selected, moved, resized, maximised and minimised using the stand-
ard facilities that Windows provides.

APL Keyboards

The Classic and Unicode Editions of Dyalog APL for Windows use different tech-
niques for mapping keystrokes to APL characters and to special command shortcuts.

The Classic Edition uses a proprietary technique for these mappings. The Unicode
Edition uses Microsoft’s IME (Input Method Editor) technology. Many other applic-
ations use the same technology, which means that the Dyalog Unicode IME may be
used not only with Dyalog APL for Windows Unicode Edition, but also with word
processing applications, spreadsheets, terminal emulators etc. Therefore with the
Dyalog Unicode IME installed, and with a suitable font selected, APL characters can
be entered and viewed in many other applications.

In both Classic and Unicode Editions APL characters are generated when the user
presses certain combinations of meta keys in conjunction with the normal character
keys. Meta keys include Shift, Ctrl and Alt.

For both input techniques it is possible to alter the mapping of keystrokes to APL
characters, and to add support for new languages. It is also possible to alter the key-
strokes which define special command keyboard shortcuts. For further details, see
Unicode Edition Keyboard on page 6 or Classic Edition Keyboard on page 11
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Unicode Edition and the Dyalog Unicode IME

The Dyalog Unicode IME is the input mechanism for generating APL characters for
Unicode editions of Dyalog APL. The version of the IME supplied with version 14.1
can be used with version 12.1 and later, provided that they are patched to a version
created on or after 15t April 2011.

The Dyalog Unicode IME defines the mapping of keystrokes to Unicode characters.
Only keystrokes which resolve to characters that either do not appear on the standard
keyboard or which differ from those that appear on the standard keyboard are
included in the selectable translate table. In effect the Dyalog Unicode IME can be
regarded as an overlay of the standard keyboard which contains just APL characters.

The Dyalog Unicode IME supplied with Version 14.1 includes support for Belgian,
Danish, Finnish, French, German, Italian, Spanish Swedish and British and American
English keyboards, based on the Dyalog hardware keyboard layout; these keyboard
layouts are described at http://dfns.dyalog.com/n_keyboards.htm. Note that for Dan-
ish, British and American English keyboards the older layouts, based on the Dyalog
APL Ctrl Keyboard, are included in the UnicodeIME\aplkeys directory.

The default keyboard mapping for unsupported languages is American English.

The IME translate tables include mappings for the special command keystrokes used
by Dyalog APL.

These command keystroke mappings are ignored by applications unless the applic-
ation is explicitly named in the Dyalog Unicode IME configuration. It is expected
that only terminal emulators used for running UNIX-based versions of Dyalog APL
will use this feature.

In particular, Dyalog APL for Windows Unicode Edition does not use the mappings
in the translate tables; the mappings are defined under Options/Configure/Keyboard
Shortcuts (see Installation & Configuration Guide: Configuration Dialog: Key-
board Shortcut Tab).

Note that the Dyalog Unicode IME replaces any previous IME, as well as the Dyalog
Ctrl and Dyalog AltGr keyboards.

Classic Edition

The mapping for each of the [JAV positions and its associated keystroke is defined by
a selectable translate table. JAV includes all the APL symbols used by Dyalog APL
as well as all the (non-APL) characters which appear on a standard keyboard. This
mapping only works with Classic Edition.

The Classic Edition installation also includes the Dyalog Unicode IME (described
below) so that users may enter APL characters into other applications; the Dyalog
Unicode IME is however not used by the Classic Edition itself.
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The Classic Edition includes support for Danish, Finnish, French, German, Italian,
Swedish, and both British and American English keyboards. The default keyboard
mapping for unsupported languages is American English.

Session Manager

The Dyalog APL/W session is fully configurable. Not only can you change the
appearance of the menus, tool bars and status bars, but you can add new objects of
your choice and attach your own APL functions and expressions to them. Functions
and variables can be stored in the session namespace. This is independent of the act-
ive workspace; so there is no conflict with workspace names, and your utilities
remain permanently accessible for the duration of the session. Finally, you may set
up different session configurations for different purposes which can be saved and
loaded as required.

The session window is defined by an object called JSE. This is very similar to a
Form object, but has certain special properties. The menu bar, tool bar and status bars
on the session window are in fact MenuBar, ToolControl and StatusBar objects
owned by [JSE. All of the other components such as menu items and tool buttons are
also standard GUI objects. You may use [JWC to create new session objects and you
may use OWS to change the properties of existing ones. OWG and OWN may also be
used with JSE and its children.
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Components of the session that perform actions (Menultem and Button objects) do so
because their Event properties are defined to execute system operations or APL
expressions. System operations comprise a pre-defined set of actions that can be per-
formed by Dyalog APL/W. These are coded as keywords within square brackets. For
example, the system operation [WSClear] producesa clear ws, after first dis-
playing a dialog box for confirmation. You may customise your session by adding or
deleting objects and by attaching system operations or APL expressions to them.

Like any other object, [JSE is a namespace that may contain functions and variables.
Furthermore, (JSE is independent of the active workspace and is unaffected by )
LOAD and ) CLEAR. It is therefore sensible to store commonly used utilities, par-
ticularly those utilities that are invoked by events on session objects, in [JSE itself,
rather than in each of your application workspaces.

The possibility of configuring your APL session so extensively leads to the require-
ment to have different sessions for different purposes. To meet this need, sessions are
stored in special files with a .DSE (Dyalog Session) extension. The default session
(i.e. the one loaded when you start APL) is specified by the session_file parameter.
Y ou may customise this session and then save it over the default one or in a separate
file. You can load a new session from file at any stage without affecting your active
workspace.

Positioning the Cursor

The cursor may be positioned within the current APL window by moving the mouse
pointer to the desired location and then clicking the Left Button. The APL cursor
will then move to the character under the pointer.

Selection

Dragging the mouse selects the text from the point where the mouse button is
depressed to the point where the button is released. When you select multiple lines,
the use of the left mouse button always selects text from the start of the line. A con-
tiguous block of text can be selected by dragging with the right mouse button.

Double-clicking the left mouse button to the left of a line selects the whole line,
including the end-of-line character.

Scrolling

Data can be scrolled in a window using the mouse in conjunction with the scrollbar.
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Invoking the Editor

The Editor can be invoked by placing the mouse pointer over the name of an editable
object and double-clicking the left button on the mouse. If you double-click on the
empty Input Line it acts as "Naked Edit" and opens an edit window for the sus-
pended function (if any) on the APL stack. For further details, see Invoking the Editor
on page 115. See also "Installation and Configuration Guide: DoubleClickEdit".

The Current Object

If you position the input cursor over the name of an object in the session window,
that object becomes the current object. This name is stored in the CurObj property of
the Session object and may be used by an application or a utility program. This
means that you can click the mouse over a name and then select a menu item or click
a button that executes code that accesses the name.

The Session Pop-up Menu

Clicking the right mouse button brings up the Session pop-up menu. This is
described later in this chapter.

Drag-and-Drop Editing

Drag-and-Drop editing is the easiest way to move or copy a selection a short distance
within an edit window or between edit windows.

To move text using drag-and-drop editing:

1. Select the text you want to move.

2. Point to the selected text and then press and hold down the left mouse but-
ton. When the drag-and-drop pointer appears, drag the cursor to a new loc-
ation.

3. Release the mouse button to drop the text into place.

To copy text using drag-and-drop editing:

1. Select the text you want to move.

2. Hold down the Ctrl key, point to the selected text and then press and hold
down the left mouse button. When the drag-and-drop pointer appears, drag
the cursor to a new location.

3. Release the mouse button to drop the text into place.

If you drag-and-drop text within the Session window, the text is copied and not
moved whether or not you use the Ctrl key.
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Interrupts

To generate an interrupt, click on the Dyalog APL icon in the Windows System
Tray; then choose Weak Interrupt or Strong Interrupt. To close the menu, click
Cancel. Altematively, to generate a weak interrupt, press Ctrl+Break, or select
Interrupt from the Action menu on the Session Window.

Unicode Edition Keyboard

Introduction

Unicode Edition supports the use of standard Windows keyboards that have the addi-
tional capability to generate APL characters when the user presses Ctrl, Alt, AltGr (or
some other combination of meta keys) in combination with the normal character
keys.

Dyalog APL is supplied with the Dyalog Unicode IME keyboard for a range of dif-
ferent languages as listed below. The intention is that only APL characters and char-
acters that appear in locations different from the underlying keyboard are defined;
any other keystroke is passed through as is.

Installation

During the Installation of Dyalog APL Unicode Edition, setup installs the Dyalog
Unicode IME (IME). For any given Input Language the IME consists of an additional
service for that Input Language, and a translate table which maps keystrokes for the
appropriate keyboard to Unicode code points for APL characters

An IME service is installed for every Input Language that the user who installs
Dyalog APL has defined, as well as every Input Language for which Dyalog has sup-
port.

The keyboard mappings are defined for the following national languages: Belgian,
Danish, Finnish, French, German, Italian, Spanish, Swedish and British and Amer-
ican English

These mappings are described at http://dfns.dyalog.com/n_keyboards.htm.

For any other Input Language the American English translate table is selected. Note
that some Input Languages are defined to be substitutes for other Input Languages;
for example Australian English Input is a substitute for American English Input, Aus-
trian German Input a substitute for German German Input. In these cases the IME will
install the appropriate translate table. It is also possible to create support for new lan-
guages or to modify the existing support. See the IME User Guide for further details.
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Configuring the Dyalog APL IME

The following description uses screenshots taken from a Windows 7 PC with three
Input Languages configured for the current user: English (United Kingdom) - the
default Input Language, Danish (Denmark) and English (United States).

The Dyalog Unicode IME is added as an additional service to all keyboards defined
to the user and the administrator at the time that the IME was installed.

For each IME the underlying keyboard layout file will be the same as that defined for
the base keyboard. The layout file is a DLL created by Microsoft.

The language specified in the description of the IME is the name of the IME translate
table that has been associated with the IME for the specific keyboard. In the case of
languages not supported by the IME the keyboard will default to en-US. With the
IME as supplied with Version 13.2 altering this text requires editing the appropriate
Registry value.

The IME may be configured from within APL or from Windows.

From within Dyalog APL

To change the properties of the IME go to Options/Configure/Unicode Input tab
and select Configure Layout:

ﬁ Dyalog APL/W-64 Configuration l T
Trace/Edit ] Auto Complete ] SALT ] User Commands ] Object Syntax ] NET Framewori ]

General  Unicode Input l Keyboard Shortouts ] Workspace ] Help / DMX ] Windows ] Session ] Log ]

Dyalog can automatically load pour selected keyboard when the session window iz made visible:

v tetivate selected kephoard [T Show keyboards for all languages

FEevboard:

Dyalog AFL IME [en-GE] =l

Configure Layout,..

oK | Cancel
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From Windows

Right click on either the Input Language icon or the Keyboard layout icon in the
TaskBar and select Settings:

Restore the Language bar
Addioral icons i taskbar

Adjust the Language band position

v Auto Adjust
Settings...

Bh

General | Language Bar | Advanced Key Seftings |

Default input language

Select one of the installed input languages to use as the default for all input
fields.

| Englsh (United Kingdem) - United Kingdom -

Imstalled services

Select the services that you warnt for each input language shown in the list.
|z the Add and Remove buttons to modify this list.

English {United Kingdom) i
“...#55 Keyboand E
-~ = United Kingdom
-« = [hyalog APL IME (enGEB}
B Danish {Denmark)
.‘él Keyboard i {
- = [anizh
- = Dyalog APL IME {da-DK}
English {United States}
- Keyboard / Move Lip
w5
~ » [yalog APL IME (en-LU5} =|| Mave Down

m

S ]
METITVE

Propeties.

[ ok ][ cancet || ooy
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To alter the configuration of any of the installed IMEs, select that IME and click on
Properties:

Dyalog APL Input Method Editor Properties Iilﬂ—hj

General l About ]

Input Translate T able:

|E:'\F'ru:ugram FileshDyaloghdnicodelME \aplkeyshen-GB.din Browsze. ..

[v Enable Overstrikes

[ Owerstrikes do not require the '05" introducer key [expenmental]

v illze Overstike popup

QK | Cancel

L

Input translate table:

The translate table defines the mapping between APL characters and the keystrokes
that generate those APL characters. It is possible to alter the mapping or to create sup-
port for new keyboards by altering the translate table, or by selecting a different trans-
late table. See the IME User Guide for more details.

Overstrikes:

In the original implementations of APL, many of the special symbols could only be
generated by overstriking one character on top of another as is reflected in the appear-
ance of the glyphs. For example, the symbol for Grade Up (4) is actually the symbol
for delta (A) superimposed on the symbol for vertical bar (])

In Dyalog APL such symbols can be generated either by a single keystroke, or (in
Replace mode) by overtyping one symbol with another. For example 4 may be gen-
erated using Shift+Ctrl+4, or by switching to Replace mode and typing the three key-
strokes Ctrl+h, Left-Cursor, Ctrl+m.

Using the Dyalog Unicode IME the character can also be entered by pressing
Ctrl+Bksp, Ctrl+m, Ctrl+h. Note that Ctrl+Bksp is the default Overstrike Introducer
Key (key code OS).



10

Dyalog APL/W User Guide

Use Overstrike popup:

With this option selected, when the character following the Overstrike Introducer
Key is pressed, a popup box displays all the overstrikes which contain the last char-
acter typed: in the example below Ctrl+Bksp has been followed by Ctrl+h:

b CLEAR WS - Dyalog APL/W N o [ 2 |3
File Edit View Windows 5Session Log Action™ Options Tools Threads

-

Help
ws O =0 @ Object B! HH ?& i%) b £ || Tool :El:lrt_ Session
Language Bar g x] %J

B[ B[] [TEFEY FEEFRERR (REE & 3

i 5

F

Editar

Debugger B8l x|
Ready... Rep |NUM '
CurObj: & {Ur [E:=1 Obq:0 |[OTRAP |OS5I:0 |[OI0:1 |[OML:0

Note the fine (red) line under the A in the Session window. This indicates that an
overstrike creation operation is in progress.

The input of the symbol A can be completed by pressing Ctrtm, or by moving the
selection up and down the pop-up list using Cursor-Up or Cursor-Down.
Overstrikes do not require the OS introducer key (exper-
imental):

With this option selected, the IME identifies characters which are part of a valid over-
strike, and when such a character is entered into the session, begins an overstrike cre-
ation operation. This mode is experimental in the IME supplied with Version 13.2.
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Classic Edition Keyboard

The standard Version 13.2 Classic Edition keyboard tables are files supplied in the
aplkeys sub-directory named cc.din where cc is the standard 2-character country
code,e.g. uk.din.

Note that the standard tables do not support the entry of APL underscored characters
AABCDEFGHIJKLMNOPQRSTUVWXYZ.

The standard table supports two modes of use; traditional (mode 0) and unified
(mode 1). The keyboard starts in mode 1 and may be switched between modes by
clicking the Uni/Apl field in the status bar or by keying * on the Numeric-Keypad.

Unified Layout

The following picture illustrates the standard UK keyboard Unified layout.

File Edt View Keyboard Options Help

| F1| F2| P3| Fra Fs

|1 2|af4]|s|e]|7|8fa]of-]=]
| o] ulefr|t]|u|ov]i]ofel|c|al

| ol s|afe]ofn]|ofwfa]:]f]u]

o0 5] 5= ) ]

Fe | F7| F8 | Fa| F1o| F11| Fiz

Exec

r ctr1| | {Blank} | r ] r Ctr]|

| MO 5 M1

C:\Program Files\DyaloghDiyalog 4PL 12,1 Classichaplkeysuk.din - Keyboard=UIE = 241
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APL symbols are entered using the Ctrl and Ctrl+Shift keys as illustrated below.

File Edt View Keyboard Options Help
Esc | F2s| F2s| F27| 28| F2s| Fao| Fa1| Faz| Fas| Fa4| Fas| Fas|
2 0 S ) ) = ) e ) ) )

Exec
ol I N N N N N N I

b e r ) fe ] afe ] o] e] =] |
L 2 N Y S O AT Y I
v ctrl | | {Blank> | Fiaiter | = ctrl |
| C MO G M

|C:\Program Files\Dyalog\Dyalog APL 121 Classichaphkeys\uk din - Kegboard=UK* | 24.1

File Edt View Keyboard Options Help

2221 o

- e

|
l!lo
|

| =] 3] ¢ ¢] ] l-l’ﬁlﬁl-lﬂlE
- xec
2 1 I | =| | =]o]o]
(20 N U 0 N N
AL B I T I Y Y A
v Cctrl | | {Blank} | roaiter | @ ctr |
| C MO G oM

\C:\Program Files\Dyalog\Dyalog APL 12.1 Classichapkeys\uk.din - Keyboard=UK * 24,1




Chapter 1: The APL Environment 13

Traditional Layout

The following picture illustrates the standard UK keyboard Traditional layout.

Fle Edt Vew Keyboard Options Heb
esc| F1| F2| Fa| Fa| Fs| Fe| F7 | F8 | Fa| Fio] F11] Fi2f

| 1] 2| 3] afs]e|r]efs|of ||
o] ] o] o) e | ] -

| e s| o]l F]s|u]a]k]]c] ]«

e | e|lz|x|c|luls|n|n|.].| ]rt]
I ctrl | | {Blank> | miaiter | Fictrl|
| cw cwn

|L'.t‘-Frogm Files\DyaloghDyalog APL 12.1 Classichaplkeys\ud. din - Keyboard=UK, * 241

APL symbols are entered using the Shift and Ctrl+Shift keys as illustrated below.

Fle Edt View Keyboard Options He
Esc | F13| F14| F1s| F1e] F17| Fi8| F1s| F2o| F21| F22| F23| F24]

o ] e e ]
Sl N 3 N N N Y BN Y

S S N S N I -1 S N

2 I I I N X

Exec

u

I ctrl | | {Blank> | mauter | I ctel |

[ FMo O
|C:\Program Fies\DyaloghDyalog APL 12.1 Classichapkeys\uk.din - Keyboard=UK " | |24
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Fle Edt View Keyboard Options Hel
R N O O N o v o v v
LAl B Lol el fo [ e ol ]
T Y O T I Y i
AN Y Y L U
A N Y U O AN N N
@ ctrl | | (Blank> | m | # ctr1|
| & MO M
C:\Program Files\Dyalog\Dyalog APL 12.1 Classichaplkeys\uk.din - Keyboard=UK * 241

Line-Drawing Symbols

Classic Edition includes 12 single-line graphics characters for drawing lines and
boxes. Line-drawing characters are entered using the keys on the numeric keypad in
conjunction with the Ctrl key as shown below. Num Lock must be on.

Normal Ctrl
7 8 9 r T L
4 5 6 |- .|_ _I
1 ) 3 L 4 d
0 : | —

Note:to accommodate other characters, line-drawing symbols are located in the non-
printable area of the font layout. Although these characters can normally be used in
output to the session (function: DISP in the UTIL workspace uses them), many
printer drivers and some display drivers will not display characters from these
positions in the font.
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Keyboard Shortcuts

The terms keyboard shortcut (Unicode Edition) and command (Classic Edition) are
used herein to describe a keystroke that generates an action, rather than one that pro-
duces a symbol.

Unicode Edition

Unicode Edition provides a number of shortcut keys that may be used to perform
actions. For compatibility with Classic Edition and with previous Versions of
Dyalog APL, these are identified by 2-character codes; for example the action to start
the Tracer is identified by the code <TC>, and mapped to user-configurable key-
strokes.

In the Unicode Edition, Keyboard Shortcuts are defined using Option-
s/Configure/Keyboard Shortcuts and stored in the Windows Registry. Note that the
Unicode IME translate tables have definitions for the Keyboard Shortcuts too; these
are ignored by the interpreter, and are intended for use with terminal emulators being
used in conjunction with non-GUI versions of Dyalog APL.

To the right of the last symbol in the Language Bar is the Keyboard Shortcut icon

. If you hover the mouse over this icon, a pop-up tip is displayed to remind you of
your keyboard shortcuts as illustrated below.

S5 CLEAR WS - Dyalog APL/W M=
File Edit View Windows Zession Log Action Options Tools Threads Help
ws [1 = 08 E & | Object B B 55 b x| [ Tool @ G) B W Edt X Ca || Session [ [APL3IBS Unicode v |[ 16—

Language Bar o=l ﬁ
[T TTe®RlT] (AUl FREREREEE [AH=PIRE] [flo<] LETelelele] [EELT] [ofelel#] [laflull] = @
[Dyalog APL/W Wersion 13.0.7841
Serfal Mo : 0000LZ A
Unicode Edition (@ Other Keyboard Shortcuts
E;z’;zgegzelgfg:?ﬁmgzi1E”'ld QT: Quit (and lose changes): Shift+Esc

' TB: Tab between windows: (Nane)
clesr ws ET: Back Tab between windows: (Nane)

EP: Exit (and save changes): Esc

RS: Right Screen: (Mane)

LS: Left Screen: (Nane)

CT: Cut: (None)

CP: Copy: (Naone)

PT: Paste: (None)

RD: Reformat: Hum divide

DK: Delete Block: Control+Delete

FD: Foruard or Redo: Control+Shift+Enter

BK: Backward or Undo: Control+Shift+Back

SC: Search: (Nane)

RP: Replace: (Nane)

NK: Next: (Nane)

PV: Previous: (None)

ED: Edit: Shift+Enter

TC: Trace: Control+Enter

FX: Fix the current function: (None)

LH: Toggle Line numbers: Hum -

BH: Run to exit (in tracer): (None)

BP: toggle breakpoint: (Nane)

RM: Resume execution (in tracer): (None)

TL: toggle localisation: Control+Up

UA: undo all changes: (Nane)

A0: Add comments: (Nane)

DO: Del comments: (None)

BL: Bo to Line: (Nane)

TO: Toggle outline: (Nane)

MO: Boto matching outline: (Nane)

S1: Exit script and fix entire seript:  (None)

$2: Exit script and only fix functions: (None) 8
_ : ; . =

bebugger 0S: Begin overstrike sequence: (None) e

Ready...

CurObj: a:1 Ope:o [OTRAP DsI:o [Oro:i [DML:o
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Classic Edition

Commands fall into four categories, namely cursor movement, selection, editing dir-
ectives and special operations, and are summarised in the following tables. The input
codes in the first column of the tables are the codes by which the commands are iden-
tified in the Input Translate Table.

Table 1: Cursor Movement Commands

Input .

Code Keystroke Description

LS Ctrl+PgUp Scrolls left by a page

RS Ctrl+PgDn Scrolls right by a page

us PgUp Scrolls up by a page

DS PgDn Scrolls down by a page

LC Left Arrow Moves the cursor one character position to the left

RC Right Arrow Moves the cursor one character position to the
right

DC Down Arrow Moves t.he cursor to the currenF character position
on the line below the current line

uc Up Arrow Moves t_he cursor to the curreth character position
on the line above the current line

UL Ctrl+ Home M.ove the cursor to the top-left position in the
window

DL Ctrl+End Move.s the cursor to the bottom-right position in
the window

RL End Moves the cursor to the end of the current line

LL Home Moves the cursor to the beginning of the current
line

LW Ctrlt Left Arrow Moves the cursor to the beginning of the word to
the left of the cursor

Ctrl+Right Moves the cursor to the end of the word to the
RW .
Arrow right of the cursor
TB Ctrl+Tab Switches to the next session/edit/trace window
BT Ctrl+Shift+Tab | Switches to the previous session/edit/trace window
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Table 2: Selection Commands

Input N
Code Keystroke Description
Le Shifi+ Left Arrow Extends the selection one character position to
the left
Re Shift+Right Extends the selection one character position to
Arrow the right
Ctrl+Shift+Left | Extends the selection to the beginning of the
Lw
Arrow word to the left of the cursor
Ctrl+Shift+Right | Extends the selection to the end of the word to
Rw .
Arrow the right of the cursor
Uc Shift+Up Arrow Eth—‘:I.ldS the sele(j‘tlon to the current cha.racter
position on the line above the current line
De Shift+Down Extends the selection to the current character
Arrow position on the line below the current line
Ll Shifi+ Home Extends .the selection to the beginning of the
current line
RI Shifi+End Extends the selection to the end of the current
line
Ul Ctrl+ Shift+ Home Extel.lds the gelectlon to the beginning of the first
line in the window
DI Ctrl+Shift-End Exten.ds the selection to the end of the last line in
the window
Us Shift+PgUp Extends the selection up by a page.
Ds Shift+PgDn Extends the selection down by a page
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Table 3: Editing Directives

g?;et Keystroke Description
DI Delete Deletes the selection
Del he current line in an Edit win .
DK Ctrl+Delete Dzl::z ;efez?edeliiles ?n thi Se:sito:;v LS;.W
CT Shifi+ Delete E{I?Ir:;oox;iz the selection and copies it to the
CP Ctrl+Insert Copies the selection into the clipboard
FD Ctrl+Shift+Enter | Reapplies the most recent undo operation
BK Ctrl+Shift+Bksp | Performs an undo operation
PT Shifi+ Insert C(?pies the contents .of the clipboard into a
window at the location selected
OP Ctrl+Shifi-Insert :Ls:r(t:dziltzia;rll(bl/i)ne immediately after the current
HT Tab Indents text
TH Shift+Tab Removes indentation
RD Keypad-slash Reformats a function (editor only)
TL Ctrl+Alt+L Toggles localisation of the current name
GL Ctrl+Alt+G Go to [line]
AO Ctrl+Alt+, Add Comments
DO Ctrl+Alt+. Delete Comments
AC Align Comments
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Table 4: Special Operations

21(?(111: Keystroke Description

IN Insert Insert on/off

LN Keypad-minus | Line numbers on/off
ER Enter Execute

ED Shift+Enter Edit

TC Ctrl+Enter Trace

EP Esc Exit

QT Shift+Esc Quit
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The Session Colour Scheme

Within the Development Environment, different colours are used to identify different
types of information. These colours are normally defined by registry entries and may
be changed using the Colour Configuration dialog box as described later in this
chapter. In the Classic Edition, colours may alternatively be defined in the Output
Translate Table (normally WIN.DOT). This table recognises up to 256 foreground
and 256 background colours which are referenced by colour indices 0-255. These col-
our indices are mapped to physical colours in terms of their Red, Green and Blue
intensities (also 0-255). Foreground and background colours are specified inde-
pendently as Cnnn or Bnnn. For example, the following entry in the Output Trans-
late Table defines colour 250 to be red on magenta.

C250: 255 0 O + Red foreground
B250: 255 0 255 + Magenta background

The first table below shows the colours used for different session components. The
second table shows how different colours are used to identify different types of data
in edit windows.

Table 5: Default Colour Scheme - Session

Colour |Used for Default

249 Input and marked lines Red on White

250 Session log Black on White

252 Tracer : Suspended Function Yellow on Black

253 Tracer : Pendent Function Yellow on Dark Grey
245 Tracer : Current Line White on Red

Table 6: Default Colour Scheme Edit windows

Colour |Array Type Editable |Default

236 Simple character matrix Yes Green on Black
239 Simple numeric No White on Dk Grey
241 Simple mixed No Cyan on Dk Grey
242 Character vector of vectors Yes Cyan on Black
243 Nested array No Cyan on Dk Grey
245 0OR object No White on Red

248 Function or Operator No White on Dk Cyan
254 Function or Operator Yes White on Blue
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Syntax Colouring in the Session

As an adjunct to the overall Session Colour Scheme, you may choose to apply a syn-
tax colouring scheme to the current Session Input line(s). You may also extend syn-
tax colouring to previously entered input lines, although this only applies to input
lines in the current session; syntax colouring information is not remembered in the
Session Log.

Syntax colouring may be used to highlight the context of names and other elements
when the line was entered. For example, you can identify global names and local
names by allocating them different colours.

See Installation & Configuration Guide: Colour Selection Dialog for further details.
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The Session Window

The primary purpose of the session window is to provide a scrolling area within
which you may enter APL expressions and view results. This area is described as the
session log. Normally, the session window will have a menu bar at the top with a
tool bar below it. At the bottom of the session window is a status bar. However, these
components of the session may be extensively customised and, although this chapter
describes a typical session layout, your own session may look distinctly different. A
typical Session is illustrated below.

55 CLEAR WS - Dyalog APLIW E]@

fie Edit Wiew Windows Sesson Log Action Options Iools Thysads Help

ws O D ) obiect B B S VB @ (T DG O Ed o o || Session [ [AFL3S Unicode. = || 18-
Language Bar 7| g x

FEDEREEREF [MMLIEE ERER-EER A IOY) [efo[o[=]] [[Jel+lo[s] [FELL] [ofofel[#] [elrlul]s] &
Dyalog APL/W Version 13.0. 7841

Serial Mo @ 0000LZ

Unicede Editian

Pre-release Develapment Build

Wed Feb 02 15:22:1h 2011

lear ws

Lt

lelo |x

Editor

Debugger | a|x|
Ready. .. Ins
CurObj: &1 Obe:o |OTRAP [OSI:o [OI0:1 [OML:zo

A typical Session window

Window Management

When you start APL, the session is loaded from the file specified by the session_file
parameter. The position and size of the session window are defined by the Posn and
Size properties of the Session object OSE, which will be as they were when the ses-
sion file was last saved.

The name of the active workspace is shown in the title bar of the window, and
changes if you rename the workspace or ) LOAD another.

You can move, resize, minimise or maximise the Session Window using the standard
Windows facilities.
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In addition to the Session Window itself, there are various subsidiary windows
which are described later in the Chapter. In general, these subsidiary windows may
be docked inside the Session window, or may be stand-alone floating windows. You
may dock and undock these windows as required. The standard Session layout illus-
trated above, contains docked Editor, Tracer and SIStack windows.

Note that the session window is only displayed when it is required, i.e. when APL

requests input from or output to the session. This means that end-user applications

that do not interact with the user through the session, will not have an APL session
window.

Docking

Nearly all of the windows used in the Dyalog APL IDE may be docked in the Ses-
sion window or be stand-alone floating windows. When windows are docked in the
Session, the Session window is split into resizable panes, separated by splitters. The
following example, using the Status window, illustrates the principles involved.
(The use of the Status window is described later in this Chapter.)

To start with, the Status window is hidden. You may display it by selecting the
Status menu item from the Tools menu. It initially appears as a floating (undocked)
window as shown below.
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If you press the left mouse button down over the Status window title bar, and drag it,

you will find that when the mouse pointer is close to an edge of the Session window,
the drag rectangle indicates a docking zone as shown below. This indicates the space
that the window will occupy if you now release the mouse button to dock it.
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The next picture shows the result of the docking operation. The Session window is
now split into 2 panes, with the Status window in the upper pane and the Session log
window in the lower pane. You can resize the panes by dragging with the mouse.

You will notice that a docked window has a title bar (in this case, the caption is
Status) and 3 buttons which are used to Minimise, Maximise and Close the docked
window.
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The next picture shows the result of minimising the Status window pane. All that
remains of it is its title bar. The Minimise button has changed to a Restore button,

which is used to restore the pane to its original size.
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You can pick up a docked window and then re-dock it along a different edge of the
Session as illustrated below.
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Docking the Status window along the left edge of the Session causes the Session win-
dow to be split into two vertical panes. Notice how the title bar is now drawn ver-
tically.
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If you click the right mouse button over any window, its context menu is displayed.
Ifthe window is dockable, the context menu contains the following options:

Undocks the docked window. The window is displayed at

Undock .. . . . .

ndoc whatever position and size it occupied prior to being docked.
Hlde. Hides the title bar of the docked window,
Caption

Specifies whether the window is currently dockable or is locked
Dockable | in its current state. You can use this to prevent the window from
being docked or undocked accidentally.

The last picture shows the effect of using Hide Caption to remove the title bar. In this

state, you can resize the pane with the mouse, but the Minimise, Maximise and Close

buttons are not available. However, you can restore the object's title bar using its con-
text menu.
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Entering and Executing Expressions

Introduction

The session contains the input line and the session log. The input line is the last line
in the session, and is (normally) the line into which you type an expression to be eval-
uated.

The session log is a history of previously entered expressions and the results they pro-
duced.

If you are using a log file, the Session log is loaded into memory when APL is started
from the file specified by the log_file parameter. When you close your APL session,
the Session log is written back out to the log file, replacing its previous contents.

In general you type an expression into the input line, then press Enter (ER) to run it.
After execution, the expression and any displayed results become part of the session
log.

You can move around in the session using the scrollbar, the cursor keys, and the
PgUp and PgDn keys. In addition, Ctrl+Home (UL) moves the cursor to the begin-
ning of the top-line in the Log and Ctrl+End (DL) moves the cursor to the end of the
last (i.e. the current) line in the session log. Home (LL) and End (RL) move the cursor
to the beginning and end respectively of the line containing the cursor.



30

Dyalog APL/W User Guide

Language Bar

The Language Bar is an optional window which is initially docked to the Session
Window, to make it easy to pick APL symbols without using the keyboard.

If you hover the mouse pointer over a symbol in the APL Language Bar, a pop-up tip
is displayed to remind you of'its usage. If you click on a symbol in the Language Bar,
that symbol is inserted at the cursor in the current line in the Session.
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Auto Complete

As you start to enter characters in an APL expression, the Auto Complete suggestions
pop-up window (AC for short) offers you a choice based upon the characters you
have already entered and the current context.

For example, if you entera [1, AC displays a list of all the system functions and vari-
ables. If you then enter the character r, the list shrinks to those system functions and
variables beginning with the letter r, namely Orefs,dr |, and Ort L. Instead of
entering the remaining characters, you may select the appropriate choice in the AC
list. This is done by pressing the right cursor key or (in PocketAPL) by tapping the
choice in the list.

If you begin to enter a name, AC will display a list of namespaces, variables, func-
tions, operators that are defined in the current namespace. If you are editing a func-
tion, AC will also include names that are localised in the function header.

Ifthe current space is a GUI namespace, the list will also include Properties, Events
and Methods exposed by that object.
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As an additional refinement, AC remembers a certain number of previous auto com-
plete operations, and uses this information to highlight the most recent choice you
made.

For example, suppose that you enter the two characters ) c. AC offers you )clear
thru' ) cs, and you choose ) cs from the list. The next time you enter the two char-
acters ) c, AC displays the same list of choices, but this time ) cs is pre-selected.

You can disable or customise Auto Completion from the Auto Complete page in the
Configuration dialog box which is described later in this chapter.

Executing an Expression

To execute an expression, you type it into the input line, then press Enter (ER).
Alternatively, you can select Execute from the Action menu. Following execution,
the expression and any displayed results become part of the session log.

Instead of entering a new expression in the input line, you can move back through
the session log and re-execute a previous expression (or line of a result) by simply
pointing at it with the cursor and pressing Enter. Alternatively, you can select
Execute from the Action menu. You may alter the line before executing it. If you do
so, it will be displayed using colour 249 (Red on White), the same as that used for
the input line. When you press Enter the new line is copied to the input line prior to
being executed. The original line is restored and redisplayed in the normal session
log colour 250 (Black on White).

An alternative way to retrieve a previously entered expression is to use
Ctrl+Shift+Bksp (BK) and Ctrl+Shift+Enter (FD). These commands cycle backwards
and forwards through the input history, successively copying previously entered
expressions over the current line. When you reach the expression you want, simply
press Enter to re-run it. These operations may also be performed from the Edit menu
in the session window.

Executing Several Expressions

You can execute several expressions, by changing more than one line in the session

log before pressing Enter. Each line that you change will be displayed using colour

249 (Red on White). When you press Enter, these marked lines are copied down and
executed in the order they appear in the log.

Note that you don't actually have to change a line to mark it for re-execution; you
can mark it by overtyping a character with the same character, or by deleting a lead-
ing space for instance.
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It is also possible to execute a contiguous block of lines. To do this, you must first
select the lines (by dragging the mouse or using the keyboard) and then copy them
into the clipboard using Shift+Delete (CT) or Ctrl+Insert (CP). You then paste them
back into the session using Shift+Insert (PT). Lines pasted into the session are always
marked (Red on White) and will therefore be executed when you press Enter. To
execute lines from an edit window, you use a similar procedure. First select the lines
you want to execute, then cut or copy the selection to the clipboard. Then move to
the session window and paste them in, then press Enter to execute them.

Session Print Width (PW)

Throughout its history, APL has used a system variable [JPW to specify the width of
the user's terminal or screen. Session output that is longer than [JPW is automatically
wrapped and split into multiple lines on the display. This feature of APL was
designed in the days of hard-copy terminals and has become less relevant in modern
Windows environments.

Dyalog APL continues to support the traditional use of JPW, but also provides an
alternative option to have the system wrap Session output according to the width of
the Session Window. This behaviour may be selected by checking the Auto PW
checkbox in the Session tab of the Configuration dialog box.

Using Find/Replace in the Session

The search and replace facilities work not just in the Editor as you would expect, but
also in the Session. For example, if you have just entered a series of expressions
involving a variable called SALES and you want to perform the same calculations
using NEWSALES, the following commands will achieve it:

Enter SALES in the Find box,and NEWSALES in the Replace box. Now click the
Replace All button. You will see all occurrences of SALES change to NEWSALES.
Furthermore, each changed line in the session becomes marked (Red on White). Now
click on the session and press Enter (or select Execute from the Action menu).

Once displayed, the Find or Find/Replace dialog box remains on the screen until it is
either closed or replaced by the other. This is particularly convenient if the same oper-
ations are to be performed over and over again, and/or in several windows. Find and
Find/Replace operations are effective in the window that previously had the focus.
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Value Tips

If you hover the mouse pointer over a name in the Session or Debugger window,
APL will display a pop-up window containing the value of the symbol under the
mouse pointer.

For example, in the following picture the mouse pointer was moved over the name of
the variable HW in the Session window.
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The next picture illustrates the Value Tip displayed when the mouse is hovered over
the name of the variable MAT.
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Similarly, if you hover the mouse pointer over the name of a function, the system dis-
plays the body of the function as a pop-up, as illustrated below.
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Value Tips for External Functions

Value Tips can also be used to investigate the syntax of external functions. If you
hover over the name of an external function, the Value Tip displays its Function Sig-
nature.

For example, in the example below, the mouse is hovered over the external function
dt.AddMonths and shows that it requires a single integer as its argument.
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Should the external function provide more than one signature, they are all shown in
the Value Tip as illustrated below. Here the function ToString has four different
overloads.

B CLEAR WS ([System.DateTime])- Dyalog APL/W-64 > =

File Edit View Windows Session Log Action Options Teols Threads Help
|ws O & 0 bl 2] |[Obiect B B 5 V B bu b2 @ 15 | |Tool O G B 3 ||Edt || Session

Language Bar P =] 1 ﬁ
L[ [e[Bleft]2] [1TI[sfr]s[-] [=lfel<[>[=l#] [v[s[2[F] [t[+]=[-]0]a]¥] [rle]v]] & | m
Unicode Edition A
Non-commercial License
Thu Feb 06 14:3%:44% 201%
clear ws

OUSING='System’
dt+DateTime.Now
Jes dt
|#.[System.DateTime]
YMETHODS
Add AddDays AddHours AddMilliseconds AddMinutes
AddMonths AddSeconds AddTicks AddYears Compare
CompareTo DaysInMonth Equals FromBinary FromFileTime
FromFileTimeUte FromOADate GetDateTimeFormats GetHashCode
GetType GetTypeCode IsDaylightSavingTime IslLeapYear Parse
ParseExact ReferenceEquals SpecifyKind Subtract ToBinary
ToFileTime ToFileTimelte TolLocalTime TolLongDateString
TolLongTimeString ToOADate ToShortDateString
ToShortTimeString ToString TolniversalTime TrvParse
TryParseExact System.String ToString()
System.5tring ToString(System.String)
System.5tring ToString(System.IFormatProvider)
System.String ToString(System.String, System.IFc

Debugger

J|Ready... Function Signature |

J|Cur0hj: |&:1 |ObQ=0 [OTRAPLSI:0 |OI0:1 [ML:1
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Configuring Value Tips

You may enable/disable Value Tips and select other options from the General tab of
the Configuration dialog box as shown below.

You may experiment by changing the value of the delay before which Value Tips are
displayed, until you find a comfortable setting.

Note that the colour scheme used to display the Value Tip for a function need not
necessarily be the same colour scheme as you use for the function editor.

B Dyalog APL/W Configuration
Trace/Edit ] Auta Complete ] SALT ] User Commands ] Object Syntax ]
General l Unicode |nput ] Keyboard Shortcuts ] YWwiortkspace ] ‘windows ] Session ] Log ]

Recently uzed file list size; g

v Display Value Tips after, |500 [z

Colour Scheme: |Default j

Iv Enable Native Look and Feet

[ Apply Native Look and Feel to docked captions

LConfiguration zaved in:
HEEY_CURREMT_USERSOFTWARE \DyaloghDyalog APLAY 13.0 Unicode

Ok, | Cancel
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Array Editor

The Array Editor! allows you to edit arbitrary arrays. It is invoked by either:

e Clicking the icon in the Session toolbar when the mouse pointer is over
the name of a suitable variable.

e Calling the user command Jaedi t, specifying the name of a suitable vari-
able as its argument.

e Calling it directly via [INA

The Array Editor draws data using a format that is similar to the output of the
DISPLAY function. For example:

.
Array Editor Elﬂlﬂ

File Edit Actions Insert Options Help

Characters: |ABCH=EF:EE

Numbers : |o 1 |4 5 6 |3.14 5.6E723 [0J1

Scalars:

Vectors: IFour‘ score and seven years ago

Matrices: [t 2 3 4~
5 6 7 8
© 10 11 12 |
‘ iy
P »
Type: General array =: 3 =fp: 5 pp: 2 p: 51 =:

1Array Editor Version 1 Release 1 © Copyright davidliebtag.com 2012, 2013
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Documentation

Full documentation for the Array Editor, including a list of the keystrokes it uses, is
available from the Help menu in the Array Editor's window.

Supported Arrays

The Array Editor supports arrays that consist solely of characters and/or numbers.
You may not use it to edit an array that contains an object reference or a [JOR.

Reject unsupported data

The way that the Arrays Editor reacts to unsupported arrays is determined by the
value of the Reject unsupported data option which is accessed by the
Options/Reject unsupported data menu item on the Array Editor menubar.

Ifthis is set to true (the default), and you try to edit an array containing an object ref-
erence, the Array Editor will refuse to start and the system will generate an error mes-
sage.

[SE.NumEd.numed: Unexpected error in array editor:

DOMAIN ERROR Argument contained data that is
neither simple or nested.

Ifthis option is cleared, the Array editor will start but you will not be able to do any-
thing. It is therefore advisable that you leave this option set.

Notes

e The Array Editor is supplied only with Unicode Editions of Dyalog
APL/W. Please visit www.davidliebtag.com for details about availability
and support for Classic Editions of Dyalog APL/W.

Namespaces are not supported.

Internal representations returned by [JOR are not supported.

Only one instance of the Array Editor may be executed at a time.

All calls to interpreter primitives use a value of 3 for OML.

Negative numbers must be represented using high minus signs. For example,
~3 not -3.
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Implementation

The Array Editor is implemented by a DLL named dlaedit.d11 (32-bit) or
dlaedit64.dll (64-bit).

The DLL exports two functions: DyalogEditArray and

DyalogEditArrayTit le. The latteris used when you click the the £l icon in
the Session toolbar (via the APL function JSE . NumEd . numed) and by the user
command Jaedit

Calling the Array Editor Directly
If you wish to use the Array Editor directly, you may do so as follows using [JNA L

Forboth DyalogEditArray and DyalogEditArrayTit Le the first argument
is the array to be edited, while the second argument is a place holder and should
always be 0

ForDyalogEditArrayTit le the 3rd argument is a character vector whose con-
tents are displayed in the caption of the array editor window.

The result is the newly altered array.

Examples

ONA'dlaedit.dll|DyalogEditArray <pp >pp' A 32-bit
ONA'dlaedit.dll|DyalogEditArrayTitle <pp >pp <0C2[]' ~n 32-bit
ONA'dlaedité4.dl L |DyalogEditArray <pp >pp' A 64-bit

ONA'dlaedité4.dl L |DyalogEditArrayTitle <pp >pp <0C2[]'m 64-bit

New«DyalogEditArray Old O
New«<DyalogEditArrayTitle Old 0O Name

INote that these are not standard [INA calls, but rather use an extension to [ONA, called Direct
Workspace Access. Dyalog does not intend to make this feature generally available at present: if
you are interested in this feature please contact sales@dyalog.com.
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SharpPlot Graphics Tools

Introduction

Included with Dyalog APL is the SharpPlot graphics library which is part of the
RainPro graphics package..

The Session includes a button which calls SharpPlot to generate graphical pictures of
the contents of the Current Object (identified by the name under or to the left of the
cursor).

For example, if you have a numerical matrix in a variable called MAT, you can plot it
by first positioning the cursor on the name MAT in the Session window, and then
clicking the SharpPlot button in the Session toolbar.

Data Structures

The charting function can plot variables with the following data structures:

a simple numeric vector

a vector of simple numeric vectors

a simple numeric matrix

a matrix whose first row contains simple character vectors and whose other
elements are simple numerics. In bar and line charts, the column headings in
row | are used as x-axis labels.

a matrix whose first column contains simple character vectors and whose
other elements are simple numerics. In bar and line charts, the row headings
in column 1 are used as legends to annotate the different series.

a matrix whose first row and first column both contain simple character vec-
tors and whose other elements are simple numerics. In bar and line charts,
the column headings in row 1 are used as x-axis labels, and the row head-
ings in column 1 are used as legends annotate the different series.
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Example: Bar Chart Lk
Wine_Prices
1961 1964 1966
Lafite 8800 1342 1210
Latour 15400 2357.5 4600
Margaux 5980 672.5 920
Mouton Rothschild 6710 713 2070
Haut-Brion 13225 1840 1323
o5 Causeway chart viewer g@
File Zoom
Wine Prices
L6000
14000
12000
10000
BO00
G000
4000
2000
0 -
1961 1964 1966
T T aour R hlargaux B Movion Rothschild [ Haui-Brion
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Example: Line Chart £

First_Growths
1961 1964 1966 1970 1975 1976 1978 ...
Lafite 8800 1342 1210 605 1380 2070 920 ...
Latour 15400 2357.5 4600 2760 1552 978 1058
Margaux 5980 672.5 920 632 900 800 1208

i Causeway chart viewer

File  Zoom

First Growths

18000
1 &0
14000
12000
OO
®000 4
HO00
4000

2000 1

D 1 I 1 1 1 ) 1 1 1 T
1964 1970 1976 1981 1983 1986 1989 1994 1996 2000

—— Lafite —— Latour —— Murgaux

Implementation

The SharpPlot Wizard is called by clicking on the SharpPlot button in the Session
toolbar. The button has a Select callback which runs the function
[JSE.Chart.DoChart. Thisruns [JSE.Chart.Do which constructs and then
runs a function named [JSE . Chart .MyChart.

[SE.Chart.MyChart usesan instance of the SharpPlot graphics class to produce
a chart of your data, which it saves as a temporary file. It then calls the SharpPlot
viewer to display the file on your screen. SharpPlot can also be started using the ]
chart user command.
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SharpPlot is a library of graphical subroutines, (originally written in APL and
machine-translated into C#) which is implemented as a NET Namespace named
Causeway and supplied in the sharpplot.dll inthe Dyalog program directory.

Notes

Although SE.Chart .MyChart is overwritten by successive uses of the graphical
button, it is deliberately not erased each time. This allows you to use MyChart asa
simple template to develop your own custom graphics function.

The image is stored in Microsoft Enhanced Metafile Format in a temporary file
whose name and location are generated automatically. The system does not delete
the temporary file after use. For further details, See Get TempFileName in the Win-
dows documentation..

The default program used to display the EMF file is SharpView.exe. You can opt
to use a different EMF viewer by setting the Charts\ViewCMDregistry key to
name another program, such as Windows Picture and Fax Viewer.

An attempt to plot the contents of a variable with an unsupported data structure (see
above) is handled entirely by error trapping and will result in an error message box
and perhaps messages in the Status window.

The Session GUI Hierarchy

As distributed, the Session object JSE contains two CoolBar objects. The first,
named [JSE . cbtop runs along the top of the Session window and contains the tool-
bars. The second, named [SE . cbbo't, runs along the bottom of the Session win-
dows and contains the statusbars.

The menubar is implemented by a MenuBar object named JSE . mb.

The toolbars in JSE . cbt op are implemented by four CoolBand objects, bandtb1,
bandtb2,bandtb3 and bandtbk4 each containing a ToolControl named tb.

The statusbars in [JSE . cbbo't, are implemented by two CoolBand objects,
bandtb1 and bandtb?2, each containing a StatusBar named sb.
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The Session MenuBar

The Session MenuBar (OSE . mb) contains a set of menus as follows.

The File Menu

The File menu (JSE .mb . fi le)provides a means to execute those APL System
Commands that are concerned with the active and saved workspaces. The contents of
a typical File menu and the operations they perform are illustrated below.

Mew
open...
Copy...

Save

Save As...
Export...

Export to Memory

Drop...

Prink Setup. ..

Cankinue
Exit

1 F:ihelpll OWAPLGRES. DS
2 CAProgram Files\Crwalod)Dyalog APL 11, 00ws\WDESIGH, DS
3 CAProgram FilesiCryvalod) Dyvalog APL 11, 00wesiatkil, DS
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Table 7: File Menu Operations

Item Action Description
New [WSClear] Prompts for confirmation, then clears
the workspace
Prompts for a workspace file name,
Open [WSLoad] then loads it
Prompts for a workspace file name,
Copy [WSCopy] then copies it
Save [WSSave] Saves the active workspace
Save As [WSSaveas] Prompts for. a workspace file name,
then saves it
Creates a bound executable, an OLE
Export [Makeexe] Server, an ActiveX Control, or a
NET Assembly
Export to [MakeMemory Creates an in-memory NET
Memory Assembly] Assembly
Close [CloseAppDomain] |Closes NET App Domain
AppDomain PP ' PP
Drop [WSDrop] Prompts for a workspace file name,
then erases it
. Pri - .
Print [PrintFnsInNS] rints functions and operators in
current namespace
Print Setup |[[PrintSetup] Invokes the print set-up dialog box
. . Saves the active workspace in
Continue | [Continue] CONTINUE.DWS and exits APL
Exit [Ooff] Exits APL
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Export

The Export... menu item allows you to create a bound executable, an OLE Server (in-
process or out-of-process), an ActiveX Control ora NET Assembly.

The dialog box used to create these various different files offers selective options
according to the type of file you are making. The system detects which of these types
is most appropriate from the objects in your workspace. For example, if your work-
space contains an ActiveXControl namespace, it will automatically select the

ActiveX Control option.
Create bound file
Savein |L§ w3 [v] a2 e E-
E’ gﬂcalc.exe
by Recent
Docurnents
Deskiop

o,

=

My Documents

59

tdy Cornputer

File name: | CALC exne [v]

Py Metwark, Save a3 lype: | Standalone Executable [includes interpreter e:-:t[vl [ Cancel ]

Buntime application [ ] Comsole application  [¥]EE nable Native Look and Feet

Command ling:
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The Create bound file dialog box contains the following fields. These will only be
present if applicable to the type of bound file you are making.

Item Description
Allows you to choose the name for your bound file The name
File name |defaults to the name of your workspace with the appropriate
extension.
f;g: as Allows you to choose the type of file you wish to create.
If this is checked, your application file will be bound with the
Runtime Run-Time DLL. If not, it will be bound with the Development
application | DLL. The latter should normally only be used to permit
debugging.
Console Check this box if you want your executable to run as a console
. application. This is appropriate only if the application has no
application } .
graphical user interface.
Enable
Native If checked, Native Look and Feel will be enabled for your bound
Look and |file.
Feel
Allows you to associate an icon with your executable. Type in
Icon file the pathname, or use the Browse button to navigate to an icon
file.
For an out-of-process COM Server, this allows you to specify the
Command |command line for the process. For a bound executable, this
line allows you to specify command-line parameters for the
corresponding Dyalog APL DLL.
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Pressing the Version button brings up the Version Information dialog box shown
below.

This dialog box allows you to specify versioning information that will be stored in
your bound file.

— ¥ersion Information
Indentifier | Yalue |

Comments | Your comments here

CompanyM ame Your Company Mame

FileDiescription Y'our File Description

Filew ersion 1.0.0.0

Productyerzion 1.0.0.0

Productt ame

InternalM ame our Interal Filename

LeqalCopyright Copyright [C] 2005

LeqalT rademarkz Y'our Legal Trademark.z

PrivateBuild

SpecialBuild

ok | ’ Lancel
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The Edit Menu

The Edit menu (OSE .mb . edi t) provides a means to recall previously entered input
lines for re-execution and for copying text to and from the clipboard.

Back. Zkrl+Shift+Bksp
Back. Forveard Chkrl+5hift+Enter
Farward

Clear Chrl+Delete
Zuk Copy Chrl+-Insert
Copy Paste Shift+Insert
Paste Paste Unicode
Find... Paste Non-Unicode
Replace. .. Eind. ..

Replace...

Unicode Edition Classic Edition

Table 8: Edit menu operations

Item Action Description

Displays the previous input line. Repeated
Back [Undo] use of this command cycles back through the
input history.

Displays the next input line. Repeated use of
Forward | [Redo] this command cycles forward through the
input history.

Clear [Delete] Clears the selected text

Copy [Copy] Copies the selection to the clipboard

Pastes the text contents of the clipboard into
the session log at the current location. The
new lines are marked and may be executed
by pressing Enter.

Paste [Paste]

Same as Paste, but gets the Unicode text from

Past .

aste [Pasteunicode] | the clipboard and converts to JAV. Classic
Unicode .

Edition only.

Paste Same as Paste, but gets the ANSI text from
Non- [PasteAnsi] the clipboard and converts to JAV. Classic
Unicode Edition only.
Find [Find] Displays the Find dialog box

Replace | [Replace] Displays the Find/Replace dialog box
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The View Menu

The View menu (OSE .mb . view) toggles the visibility of the Session Toolbar,
StatusBar, and Language Bar.

v Toolbar
v Skatusbar
v LanguageBar

Table 9: View menu operations

Item Action Description

Toolbar Shows/Hides Session toolbars

Statusbar Shows/Hides Session statusbars

LanguageBar Shows/Hides Language Bar
The Window Menu

This contains a single action (OSE .mb . windows) which is to close all of the Edit
and Trace windows and the Status window.

Close all windows

LanguageBar

Debugger
Editor k

Table 10: Window menu operations

Item Action Description

Close all Windows |[[CloseAll] |[Closes all Edit and Trace windows

Note that [CloseAl Ll ] removes all Trace windows but does not reset the State
Indicator.

In addition, the Window menu will contain options to switch the focus to any sub-
sidiary windows that are docked in the Session as illustrated above.
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The Session Menu

The Session menu (OSE .mb . session)provides access to the system operations
that allow you to load a session (JSE) from a session file and to save your current ses-
sion ((SE) to a session file. If you use these facilities rarely, you may wish to move
them to (say) the Options menu or even dispense with them entirely.

Open,..
Save
Save As...

Table 11: Session menu operations

Item | Action Description

Prompts for a session file name, then loads the session
from it, replacing the current one. Sets the File
property of JSE to the name of the file from which the
session was loaded.

Open | [SELoad]

Saves the current session (as defined by OSE) to the

S . . .
ave | [SESave] session file specified by the File property of JSE.

Prompts for a session file name, then saves the current
[SESaveAs] [session (as defined by [JSE) in it. Resets the File
property of OSE.

Save
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The Log Menu

The Log menu (OSE .mb

ulate Session log files.

e
open...

Save

Save As...

Print. ..

. Log) provides access to the system operations that manip-

Table 12: Log menu operations

Item | Action Description

New |[NewLog] Pron'1pts for confirmation, then empties the current
Session log.
Prompts for a Session log file, then loads it into

Open | [OpenLog] memory, replacing the current Session log

Save |[SaveLog] Saves .the .current .Session log in the current log file,
replacing its previous contents

Save Prompts for a file name, then saves the current

[SavelLogAs] . o
As Session log in it.
Print | [PrintLog] [Prints the contents of the Session log.
The Action Menu

The Action menu (OSE .mb . act ion)may be used to perform a variety of operations
on the current object or the current line. The current object is the object whose name
contains the cursor. The current line is that line that contains the cursor. The Edit,
Copy Object, Paste Object and Print Object items operate on the current object. For
example, if the name SALES appears in the session and the cursor is placed some-
where within it, SALES is the current object and will be copied to the clipboard by
selecting Copy object or opened up for editing by selecting Edit.
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Execute runs the current line; Trace traces it.

Edit. ..
Trace...
Execute

Copy Object
Paste Ohject

Clear Stops
Interrupk
Reset

Unicode Edition

Shift+Enter
Ckrl+Enter
Enter

Edit...
Trace...
Execute

Copy Object
Paste Object

Clear Stops
Interrupt
Reset

Classic Edition

Table 13: Action menu operations

Item Action Description
Edit [Edit] Edit the current object
Executes the current line under the control of the
Trace [Trace]
Tracer
Execute | [Execute] Executes the current line
Copy . Copies the contents of the current object to the
Object [ObjCopy] clipboard.
Pas.te [ObjPaste] Pastes the .contents 01'°the' clipbogrd into the
Object current object, replacing its previous value
Print [ObjPrint] |[Prints the current object
Object ] Ject.
1
Clear [ClearTSM] Clegrs all OSTOP, JMONITOR and [JTRACE
Stops settings
Interrupt | [Interrupt ] | Generates a weak interrupt
Reset [Reset] Performs )RESET
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The Options Menu

The Options menu (OSE .mb.options)provides configuration options.

Chject Synkax
Line Mumbers

Zonfigure. ..
Colours, .,

Table 14: Options menu operations

k| Expose GUI Properties
Expose Foot Properties
Expose Session Properties

Murn -

Item Action Description
Expose GUI Exposes the names of properties,
Properties [ExposeGUT] methods and events in GUI objects
Exposes the names of the properties,
E R
xposev oot [ExposeRoot] methods and events of the Root
Properties .
object
Expose .
. . Exposes the names of the properties,
Session [ExposeSession]
. methods and events of [JSE
Properties

Line Numbers

[LineNumbers]

Toggle the display of line numbers in
edit and trace windows on/off

Configure

[Configure]

Displays the Configuration dialog
box

Colours

[ChooseColors]

Displays the Colours Selection dialog
box

The values associated with the Expose GUI, Expose Root and Expose Session
options reflect the values of these settings in your current workspace and are saved in

it.

When you change these values through the Options menu, you are changing them in
the current workspace only.

The default values of these items are defined by the parameters default wx, Prop-
ertyExposeRoot and PropertyExposeSE which may be set using the Object Syntax
tab ofthe Configuration dialog.
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The Tools Menu

The Tools menu (OSE .mb . tools) provides access to various session tools and dia-

log boxes.

Explorer..

Search...
Skatus.,..

Aukoskatus
Event Yiewer

Table 15: Tools Menu Operations

Item Action Description

Explorer [Explorer] Displays the Workspace Explorer tool

Search [WSSearch] Displays the Workspace Search tool

Status [Status] Displays or hides the Status window
Toggle; if checked, causes the Status

AutoStatus | [AutoStatus] |window to be displayed when a new
message is generated for it

Event . . . .

. [EventViewer] |Displays or hides the Event Viewer
Viewer
Properties | [ObjProps] ODI;;S(l::lys a property sheet for the current
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The Threads Menu

The Threads menu (OSE .mb . threads) provides access to various session tools
and dialog boxes.

show Threads. ..
Shaw Skack., ..
Shows Token Pool...
Auto Refresh

v Pause on Error
Pause all Threads
Resume all Threads
Restart all Threads

Table 16: Threads Menu Operations

Item Action Description

Show )

Threads [Threads] Displays the Threads Tool
Show Stack |[Stack] Displays the S7 Stack window
Show Token Displays the Token Pool

[TokenPool]

Pool window

Refreshes the Threads Tool on

Auto Refresh | [ThreadsAutoRefresh] .
every thread switch

Pause on

[ThreadsPauseOnError] |Pauses all threads on error
Error

Pause all

[ThreadsPauseAll] Pauses all threads
Threads

Resume all

[ThreadsResumeAl l] Resumes all threads
Threads

Restart all

[ThreadsRestartAll] Restarts all threads
Threads
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The Help Menu

The Help menu (OSE .mb . he L p) provides access to the help system which is pack-
aged as a single Microsoft HTML Help compiled help file named

help\dyalog.chm.

Dacurentation Cenker
Latest Enhancements
Language Help

L Help

Drvalog Web Site
Email Cvyalog

About Crvalog APL

Table 17: Help menu operations

Label Action Description
Opens your web browser on
. help\index.html which displays
Documentation [DocCenter] an index to the on-line PDF
Center . .
documentation and selected internet
links.
Opens help\dyalog.chm, starting
Latest at the first topic in the Version 14.1
[RelNotes] Release Notes section. Note that
Enhancements .
previous Release Notes are also
included for your convenience.
Opens help\dyalog.chm, starting
Language Help |[LangHelp] at the first topic in the Language
Reference section.
Opens help\dyalog.chm, starting
Gui Help [GuiHelp] at the first topic in the Object
Reference section.

. hel log.chm, starti
Third Party . Opens he p\.dy.a ©g.chm, starting
. [LicenceHelp] |at the first topic in the Licences for

Licences .

third-party components.
Dyalog Web [DyalogWeb] Opens your web browser on the
Site Dyalog home page.
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Label Action Description

Opens your email client and creates a
new message to Dyalog Support, with
information about the Version of
Dyalog APL you are running.

Email Dyalog [DyalogEmail]

About Dyalog

APL [About] Displays an About dialog box




Chapter 1: The APL Environment 61

Session Pop-Up Menu

The Session popup menu (SE . popup) is displayed by clicking the right mouse but-
ton anywhere in the Session window.

Edit

Chart Wizard

Cut 5hift+Delete
Copy Control+C
Paste Shift+Insert

Paste Unicode
Paste Mon-Unicode
Copy Object

Paste Object

Line Mumbers Mum -

Align Comments

Explorer...
Search...
Event Viewer...
Threads...
Status...

Colours...

Interrupt

If the mouse pointer is over a visible object name, the popup menu allows you to
edit, print, delete it or view its properties. Note that the name of the pop-up menu is
specified by the Popup property of [JSE.
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Table 18: Session popup menu operations

Item Action Description
Edit [Edit] Edits the current object
hart hart Wi t
C ‘a Ose.Chart.DoChart OpensC art Wizard on curren
Wizard object
Print [ObjPrint] Prints the current object
Delete [ObjDelete] Erases the current object
. Displays the Object Properties
Properties | [GUIHelp] dialog box for the current object
Displays the help topic associated
Help [Help] with the current object or the APL
symbol under the cursor
Cut [Cut] Deletes selected text
Copies the selection to the
Copy [Copy] clipboard
Pastes the text contents of the
clipboard into the session log at the
Paste [Paste] current location. The new lines are
marked and may be executed by
pressing Enter.
Paste Same as Paste, but gets the Unicode
. [PasteUnicode] text from the clipboard and converts
Unicode
to AV
Paste Same as Paste, but gets the ANSI
Non- [PasteAnsi] text from the clipboard and converts
Unicode to AV
Line [LineNumbers] Toggles line numbers on/off
Numbers ! &8
Copy . Copies the contents of the current
Object [ObjCopy] object to the clipboard
Paste . Pastes the contents of the clipboard
Object [ObjPaste] into the current object
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Item Action Description
Align . .
[AlignComments] Aligns Comments to current column

Comments

Explorer [Explorer] Displays the Workspace Explorer

Search [WSSearch] Displays the Find Objects tool

Eyent [EventViewer] Displays the Event Viewer

Viewer

Threads [Threads] Displays the Threads Tool

Status [Status] Displays the Status window
Displ h j

Colours [ChooseColors ] '1sp ays the Colour Selection
dialog

Interrupt [Interrupt] Generates a weak interrupt

Open link | [OpenLink] Opens t.he URL or link using the
appropriate program.

Copy link . Copies the URL or link to the

to clipboard [CopyLink] Windows Clipboard.

For the last two items, see Installation & Configuration Guide: Configuration Dia-

log: General Tab)
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The Session Toolbars

The Session toolbars are contained by four separate CoolBand objects, allowing you
to configure their order in whichever way you choose.

wis DD E Y S
bt BB T V B a2 @ I
ool O G B A
: Edit B w2 cu
- Session (B |APL38S Unicode s || 1602

The Session tool bars

The bitmaps for the buttons displayed on the session tool bar are implemented by
three ImageList objects owned by the CoolBarJSE . cbtop. These represent the

ToolButton images in their normal, highlighted and inactive states and are named
iln,ilhand ili respectively.

These images derive from three bitmap resources contained in dyalog.exe named
tb_normal,tb_hot and tb_inactive. The statements that create these
ImageList object in function BUILD_SESSION in BUILDSE.DWS are as follows.

:With '[0SE.cbtop'’
"iln'0OWC'ImagelList'('MapCols' 0)('Masked' 1)
"iln.bm'OWC'Bitmap'('"' 'tb_normal')('MaskCol' (192 192
192))
"ilh'0OWC'ImagelList'('MapCols' 0)('Masked' 1)
"ilh.bm'0OWC'Bitmap'('" "tb_hot')('MaskCol'(192 192 19
2))
"ili'0WC'Imagelist'('MapCols' 0)('Masked' 1)
"ili.bm'OWC'Bitmap'('"' 'tb_inactive')('MaskCol'(192 19
2 192))
:EndWith
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[
Clear Workspace

-}

=
Load Workspace

¥
Copy Workspace

Save Workspace

Re-Export
Workspace

=

Print Workspace

Workspace (WS) Operations

Executes the system operation [WSClear ] which asks
for confirmation, then clears the workspace.

Executes the system operation [WSLoad] which
displays a file selection dialog box and loads the
selected workspace.

Executes the system operation [WSCopy ] which
displays a file selection dialog box and copies the
(entire) selected workspace

Executes the system operation [WSSaveas ] which
displays a file selection dialog box and saves the
workspace in the selected file.

Executes the system operation [ReExport] which re-
exports the workspace using the settings, parameters
and options that were previously selected using the
Create Bound File dialog.

Executes the system operation [PrintFnsInNS] that
prints all the functions and operators in the current
namespace.
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Object Operations
@J
Copy Object

@J
Paste Object

58
Print Object

W
Edit Object

Edit Array

Juk

Barchart

k2

Linechart

»

Piechart

Scatterplot

Executes the system operation [Ob jCopy ] which
copies the contents of the current object to the
clipboard.

Executes the system operation [Ob jPaste] which
copies the contents of the clipboard into the current
object, replacing its previous value.

Executes the system operation [Ob jPrint] that prints
the current object.

Executes the system operation [ Edit] which edits the
current object using the standard system editor.

Executes a defined function in [JSE that edits the
current object using the Array Editor (Unicode Edition)
or a spreadsheet-like interface based upon the Grid
object (Classic Edition). See Array Editor on page 39.

Executes a defined function in [JSE that displays the
value of the current object in a Barchart.

Executes a defined function in [JSE that that displays
the value of the current object in a Linechart.

Executes a defined function in [JSE that that displays
the value of the current object in a Piechart.

Executes a defined function in [JSE that that displays
the value of the current object in a Scatterplot.
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Tools

By

Explorer

Q

Search

-

Line Numbers

|

Clear all Stops

Edit Operations

Copy Selection

&

Paste Selection

K
Recall Last

4 Recall Next

Executes the system operation [Explorer] which
displays the Workspace Explorer tool.

Executes the system operation [WSSearch] which
displays the Workspace Search tool.

Executes the system operation [LineNumbers]
which toggles the display of line numbers in edit and
trace windows on and off.

Executes the system operation [ClearTSM] which
clears all JSTOP, (JMONITOR and (JTRACE settings

Executes the system operation [ Copy] which copies
the selected text to the clipboard.

Executes the system operation [Paste] which pastes
the text in the clipboard into the current window at the
insertion point.

Executes the system operation [Undo ] which recalls
the previous input line from the input history stack

Executes the system operation [Redo ] which recalls
the next input line from the input history stack.
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Session Operations

= Executes the system operation [ SELoad] which
Load Session displays a file selection dialog box and loads the

selected Session File.

APLIES Unicode + Selects the font to be used in the Session window.

Select Font

16 = Selects the size of the font to be used in the Session

Select Font Size window.
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The Session Status Bar

The session status bar is represented by two CoolBands each of which contains a
StatusBar object. There are a number of StatusFields as illustrated below. Y our own
status bar may be configured differently.

© Ready... Ins  Uni @ NUH

CurObj: Describe (Uariable) g:1 OoR:0  OTRAP  OSI:0 0OI0:1 0OHL:0O
Classic Edition

Ready... Ins = NUM

CurQbj: Describe (Yariablel &t apg: OTRAP  [OS1: O1o: ML =
Unicode Edition

The StatusField objects owned by the session StatusBar may have special values of
Style, which are used for operations relevant only to the Session. These styles are
summarised in the tables shown below.

Table 19: Session status fields : first row

StatusField | Style Description

Displays hints for the session objects, or "Ready..."

hint N . . .
mn one when APL is waiting for input

insrep InsRep Displays the mode of the Insert key (Ins or Rep)

Displays the keyboard mode. This is applicable only
to a multi-mode keyboard. The text displayed is
defined by the Mn= string in the Input Table.
Classic Edition Only.

mode KeyMode

Indicates the state of the Num Lock key. Displays

fum NumbLock |\ 0 v i Num Lock is on, blank if off.

Indicates the state of the Caps Lock key. Displays

caps CapsLock "Caps" if Caps Lock is on, blank if off.

Displays a flashing red "Pause" message when the

ause Pause . .
P Pause key is used to halt session output
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Table 20: Session status fields : second row

StatusField | Style Description
. . Displays th f th t object (th

curobj CurObj isplays the name of the curren object (the name
last under the input cursor)

e ThreadCount Dl'sp'lays thp number of threads currently running
(minimum is 1)

dqlen DQLen Displays the number of events in the APL event
queue

trap Trap Turns red if OTRAP is set

si SI Displays the length of JSI. Turns red if non-zero

. Displays the value of JI0. Tums red if JIO is

io 10 .
not equal to the value of the default_io parameter
Displays the value of OML. Tums red if OML is

ml ML not equal to the value of the default ml
parameter

Toggle Status Fields

In the default Session files distributed with this release, the Statusfields used to dis-
play the value of JI0, the state of the Insert key (Ins/Rep) and the current keyboard
mode (e.g. Apl/Uni) have callback functions attached to MouseDbIClick. This
means that you can toggle the state of these fields by double-clicking with the left

mouse button.

If you dislike this behaviour, you may set the Event property of the Statusfields to 0
and re-save the Session file. Alternatively, you may modify BUILDSE.DWS and
rebuild the Session from scratch.
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Status Window

The Status window is used to display system messages and supplementary inform-
ation. These include the operations that take place when you register an OLEServer
or ActiveXControl.

The Status window is also used to display supplementary information about errors.
For example, ifin a [JWC statement you misspell the type of an object, you will get a
suitable error message in the Status window, in addition to the DOMAIN ERROR mes-
sage in the Session.

Example

'"F'OWC'FROM' A Should be 'FORM'
DOMAIN ERROR
'"F'OWC'FROM'

A

15 Dyalog APLAY - Status mEx]

File Options

Inwalid ohject tupe: FROM

Cloze

The Status window can be explicitly displayed or hidden using the [Status ] sys-
tem operation which is associated with the Tools/Status menu item.

There is also an option to have the Status window appear automatically whenever a
new message is written to it. This option is selected using the [AutoStatus] sys-
tem operation which is associated with the Tools/AutoStatus menu item.

Note that when you close the Status window, all the system messages in it are
cleared.
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The Workspace Explorer Tool

The Explorer tool is a modeless dialog box that may be toggled on and off by the sys-
temaction [Explorer]. In a default Session, this is attached to a Menultem in the
Tools menu and a Button on the session toolbar.

The Explorer contains two sub-windows. The one on the left displays the namespace
structure of your workspace using a TreeView. The right-hand window is a ListView
that displays the contents of the namespace that is selected in the TreeView.

| Exploring C:\Program Files\Dyalog\Diyalog APL 13.... g@
Eile Edit ©Options Wiew Tools
ABEXAQHE of EEEERE 2 4lalfl
Workzpace Tree Contents of H.Whezign.PropFmt
=I5 # | Name |T',,-'|:|e |_A_
-] Whesign .@Animatian Function
&) [Fns/0ps] FIBTHS Yariable
+¥] [Vars] E|BTNSCONY Function
+-C] Bitmaps .@Eitmap Function
+-(Z7 BMED .@Bruuseﬂnx Function
4.0 Buttons ¥ CHOICES Variable
#-[3 ColourPick .@Ealendar Function
4[] Events .@Eheck Function
4. GridTitles .@Eircle Function
4[] BWiz .@Enmbu Function
. . @EDmeEx Function
.@Euulﬂar Function
+ ]
T .@Eursnr Function
2@ Zmliual .@DateTimeF‘... Function
#-(3 Sty '.ES | .@Edit Function _
" (3 TabMiz || |EEditBax Function )
.{. .}. .{. .>.
75 object(s), 60,38Mb Free, 233536 bytes used (0 bytes se

The Explorer is closely modelled on the Windows Explorer in Windows and the facil-
ities it provides are very similar. For Windows users, the operation of this tool is prob-
ably self-explanatory. However, other users may find the following discussion

useful.
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Exploring the Workspace

The TreeView displays the structure of your workspace. Initially it shows the root
and Session namespaces # and [JSE. The icon for # is open indicating that its con-
tents are those that appear in the ListView. You can expand or collapse the
TreeView of the workspace structure by clicking on the mini-buttons (labelled + and
-) or by double-clicking the icons. A single click on a closed namespace icon opens
it and causes its contents to be displayed in the ListView. Another way to open a
namespace is to double-click its icon in the ListView. Only one namespace can be
open at a time. The icons used in the display are described below.

Class
Namespace (closed)
GUI Namespace (closed)

Namespace (open)

geolE

GUI Namespace (open)

Function

Variable

Operator

Indicates an object that has been erased
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Viewing and Arranging Objects

The ListView displays the contents of a namespace in one of four different ways
namely Large Icon view, Small Icon view, List view or Details view. Y ou can switch
between views using the View menu or the tool buttons that are provided. In the first
three views, the system displays the name of the object together with an icon that
identifies its type. In Details view, the system displays several columns of additional
information. You may resize the column widths by dragging or double-clicking the
lines in the header. To hide a column, drag its width to the far left. The additional
columns are:

This is the namespace containing the object. By definition, this
Location is the same for all of the objects shown in the ListView and is
normally hidden

For a function or operator, this is the function header stripped of
localised names and comment. For a variable, the description
indicates its rank, shape and data type. For a namespace, the
description indicates the nature of the namespace; a plain
namespace is described as namespace, a GUI Form object is
described as Form, and so forth.

Description

Size The size of the object as reported by JSIZE.

Modified | For functions and operators, this is the timestamp when the
on object was last fixed. For other objects this field is empty.

Modified | For functions and operators, this is the name of the user who
by last fixed the object. For other objects this field is empty.

In any view, you may arrange the objects in ascending order of name, size, timestamp
or class by clicking the appropriate tool button. In Details view, you may sort in
ascending or descending order by clicking on the appropriate column heading. The
first click sorts in ascending order; the second in descending order.
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Moving and Copying Objects

You can move and copy objects from one namespace to another using drag-drop or
from the Edit menu.

To move one or more objects using drag-and-drop editing:

1. Select the objects you want to move in the ListView.

2. Point to one of the selected objects and then press and hold down the left
mouse button. When the drag-and-drop pointer appears, drag the object(s) to
another namespace in the TreeView. To indicate which of the namespaces is
the current target, its name will be highlighted as you drag the selected
object(s) over the TreeView.

3. Release the mouse button to drop the objects into place. The objects will
disappear from the ListView because they have been moved to another
namespace.

To copy one or more objects using drag-and-drop editing, the procedure is the same
except that you must press and hold the Ctrl key before you release the mouse but-
ton.

You may also move and copy objects using the Edit menu. To do so, select the
object(s) and then choose Move or Copy from the Edit menu. You will be prompted
for the name of the namespace into which the objects are to be moved or copied.
Enter the namespace and click OK.

Editing and Renaming Objects

You can open up an edit window for a function or variable by double-clicking its
icon, or by selecting it and choosing Edit from the Edit menu or from the popup
menu. You may rename an object by clicking its name (as opposed to its icon) and
then editing this text. You may also select the object and choose Rename from the
Edit menu or from the popup menu. Note that when you rename an object, the ori-
ginal name is discarded. Unlike changing a function name in the editor, this is not a
copy operation.
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Using the Explorer as an Editor

If you open the Fns/Ops item, the names of the functions and operators in the
namespace are displayed below it alphabetically in the left (tree view) pane. When
you select one of these names, the function itselfis opened in the right (list view)
pane.

=1 | Exploring C:\Program Files\D'yalog\Dyalog APL 13.0 Unicode\ws\wdesign E]@
Eile Edit Options Wew Tools

BB XQE of alglals

Workspace Tree

B 1nscoL A oA A X ~| 4B 40 | *m *F ®p
&) INSROW L OML

&) KEYPRESS ML<0

& LAST_ETH :1f 2=0ONC'DESCRIBE’

& LIST_0BI T tDESCRIBE

B LoCATE tEndIf

&) LOWER

E) MAKE

£ MAKE_BTN

& MAKE_EXEC

£ MAKE_FMT_FH

&) MAKE_FMT_PROP

&) MAKE_FN

E MAKE_FN_FORM

£ MAKE_FN_GRID [,
<] Lo (] [Function Dyadic: 25/06{199 Pos: 0/5, 1
413 object(s), 60.37Mb free. 1041076 bytes used (0 bytes selected)

Y ou may use this feature to quickly cycle through the functions (or variables) in a
namespace, pressing cursor up and cursor down in the left (tree view) pane to move
from one to another.

You may also edit the function directly in the right (list view) pane before moving
on to another.
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The File Menu

Prink...
Prinkt setup...

Delete
Rename
Properties

Close

Fz
alk Enker

The File menu, illustrated above, provides the following actions. All but Print setup
and Close act on the object or objects that are currently selected in the ListView.

Print Prints the object(s).

Print Displays the Print Configuration dialog box

setup play g g .

Delete Erases the object(s).

Rename Re.nam?s the object. This option only applies when a single
object is selected.

Properties [ Displays a property sheet; one for each object that is selected.

Close Closes the Explorer
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The Edit Menu

Edit  Enter
Copy (Chrl
Move

Select k Select Functions
Seleck variables

Select Mone
Select Al kel &
Invert Seleckion

The Edit menu, illustrated above, provides the following actions. The Edit, Copy and
Move operations act on the object or objects that are currently selected in the

ListView.
Edit Opens an edit window for each of the objects selected.
Copy Prompts for a namespace and copies the object(s) there.
Move Prompts for a namespace and moves the object(s) there.
Select . . e

. Selects all of the functions and operators in the ListView.

Functions
Sele.ct Selects all of the variables in the ListView.
Variables

Select None |Deselects all of the objects in the ListView.

Select All Selects all of the objects in the ListView.

Invert Deselects the selected objects and selects all those that were
Selection not selected.
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The Options Menu

v Toolbar

Toolbar Captions

v Status Bars

v Twpe Libraries

Expand All

Refresh Mo
v Auto Refresh

Fa

The Options menu, illustrated above, provides the following actions.

Toolbar |Displays or hides the Explorer toolbar.
Toolbar . . .
Captions Displays or hides the button captions on the Explorer toolbar.
StatusBar | Displays or hides the Explorer statusbar.
Type . . . .
Libraries Enables/disables the exploring of Type Libraries
Expand Expands all namespaces and sub-namespaces in the TreeView,
P providing a complete view of the workspace structure, including
All . . .
or excluding the Session object JSE.
Redisplays the TreeView and ListView with the current structure
Refresh . .
and contents of the workspace. Used if Auto Refresh is not
Now
enabled.
Auto Specifies whether or not the Explorer immediately reflects
Refresh |changes in the active workspace.

If Auto Refresh is checked the Explorer is updated every time APL returns to desk-cal-
culator mode. This means that it is always in step with the active workspace. If you
have a large number of objects displayed in the Explorer, the update may take a few
seconds and you may wish to prevent this by un-checking this menu item If'you do
so, the Explorer must be explicitly updated by selecting the Refresh Now action.
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The View Menu
Caolumns F  Mame
v Location
Large Icons
W Tvpe
amall Icons o
. v Descripkion
List Icons )
® Dekails v iz
v Modified an
Scope k| Modified by

arrange Icons
Line up Icons
W Aubo Arrange

4

The View menu, illustrated above, provides the following actions.

Columns [Allows you to select which columns you wish to display.
L . e

arge Selects Large Icon view in the ListView.
Icons
Small Selects Small Icon view in the ListView.
Icons
List Icons | Selects List view in the ListView.
Details Selects Details view in the ListView.
Scope Allows you to choose whether the Explorer displays objects in

P local scope or in global scope.
A . . N .
Icl(‘)l;lasnge Sorts the items in the ListView by name, type, size or date.
Line up . . .
Rearranges the icons into a regular grid.

Icons
Auto If checked, the icons are automatically re-arranged when
Arrange |appropriate
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The Tools Menu

Find...
Go ko,

F3
Ctrl 3

(30 ko Session Space

Set Session space

The Tools menu, illustrated above, provides the following actions.

Find Displays the Find Objects Tool
Prompts for a namespace and then opens that namespace in the
Go to . . L . g
TreeView, displaying its contents in the ListView
Go to . . .
Session Opens the namespace in the TreeView control corresponding to
the current space in the Session.
Space
Set Session | Sets the current space in the Session to be the namespace that is
Space currently open in the TreeView.
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Browsing Classes

Classes are represented by icons. The picture below shows 3 classes: Bird,

Parrot and DomesticParrot.

| Exploring C:\Help13.0%ws\PARROTS [#]

BEX

Eile Edit ©ptions Wew Tools

BB XQE | of

alglol ol

Workspace Tree

Contents of # (Global Scopel

+ﬂ
+- (&9 OSE

3 objeck(s). 61.57Mb free,

Bird

Farrot

38544 bytes used (20136 bytes selected)

If you open the # node in the left-hand pane, you see the contents of # as a tree.

.ﬂ Exploring C:\Help13.0%ws\PARROTS [#]

M=

File Edit ©Options Yew Tools

BBRXQE o

algl ol &l

Workspace Tree

Contents of # [

Elobal Scape)

- ﬁ
+-[E0 Bird
+[E0 DomesticPar
+[ED Parrot

+- (7] OSE

(] i | [)]

3 object(s), 61.57Mb free,

Bird

38548 bytes used (20136 byvtes selected)

Farrot
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Browsing Class Scripts

Selecting DomesticParrot in the left-hand pane brings up its Class Script in the
right-hand pane.

J Exploring C:\Help13.0\ws\PARROTS [# DomesticParrot] =JoEs
File Edit ©Options VYiew Tools

BEBEXQHE o alal ol &l

Workspace Tree Contents of #.0omesticParrot
-t oA A X ~| 0B A m*F %P
« [ Bird tClass DomesticParrot: Parrot
+. B0 & tField Public Name
+ [0 Parrot
+-[g) OSE [0] = 7 egglname species]
[1] tAccess Public
[2] tImplements Constructor :Base species
[3] O0F Hame<name
[L4] L 7
[0l = 7 eggl
[1] tAccess Public
[2] :Implements Constructor :Base 'Generic’
[3] ODF Hame+'Polly'
[L4] L 7
[0l = 7 R+Speak
[1] tAccess Public
[2] R+0BASE. Speak, ' Who's & pretty boy,thent’
[3] 7

tEndClass A DomesticParraot

< I | [»][class Pos: 0/21,0
3 objectis), 61.57Mb free, 38548 bytes used (20136 bytes selected)
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... and selecting Parrot in the left-hand pane brings up the Class Script for

Parrot.

1) Exploring C:\Help13.0%s\PARROTS [#.Parrot]

=/

File Edit Options ‘iew Tools

(BB XQAE | of mEEAda s

Workspace Tree

_n
+-[E Bird

+ [0 DomesticPar
4+ [0

+-() OSE

|Contents of #.Parrot

MR A X

~| 46 & | *m *F *p
[

[0]
[1]
[2]
[21

[0]
[1]
[2]
[21]
[0]
[1]
[2]
[3]

=

iClass Farrot: Bird

¥ egg zpecies
tAccess Public Instance

Implements Constructor
7
7 R+Speak
tAccess Public
R+'Squarkt’
7
7 kill
tImplements Destructaor
'Thiz Parrot is dead’
v

C:iEmdClass m Parrot

iBase

"Farrot:

'yspecies

Y untiled - Paint
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... and finally, selecting B i rd in the left-hand pane brings up the Class Script for

Bird.
] Exploring C:\Help13.0\ws\PARROTS [#.Bird] =Jo&d
File Edit Options Yiew Tools
EBRXQE | cf mEEE 408
Workspace Tree |C0ntents of #.Bird
@b B A A X ~| a8 4% | *m °F *p
+EBind tClass Bird
+[E0 DomesticPar & :Field Public Species
+ [ Parrot
+ (g7 OSE (o] = 7 eqg spec
[1] tAcceszs Public Insztance
[2] tImplements Canstructor
[3] Speciestszpec
[u] L v
(o] = 7 R<Speak
[1] tAccess Public
[z2] fe'Tweet, tweett'
[31] L 7
tEndClass A Bird
<] I | [i”class | |Pos: 0f15,0
3 objectis), 61,57Mb free, |38548 bytes used (20136 bytes selected) A
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Ifyou open a Class node, a tree appears to help you to navigate within the Class
script. In the picture below, the user has opened the [Methods ] node and then
clicked on Speak. The system has responded by scrolling to (if necessary) and high-
lighting the appropriate section of the script.

_‘;l Exploring C:\Help13.00ws\PARROTS [#.DomesticParrot]

9= %]

File Edit Options Yiew Toals

Workspace Tree

BB XQE| o

2lolal sl

Contents of #.DomesticParrot

= #

w0 Bird

5 [ED bamesticParrat
4% [Constructars]
+ ﬁil [DFHS]
w4 [Fields]
—.3%1 [Methods]

B

F| [Nested. Clazses]

w48 [Properties]
+-%7 [Sections]
4 [ED Parrot

+- (291 OSE

L4 ] 1
3 object{s), 61.57Mhb free,

A& X

| a8 g0

(ol
[11
(21
[al
(4]

w4 [Nested Namespaces] [o]

(1]
(21
[z21]
(4]

[ol
[11
[z1]
(21

<
[ %] [Class

&
=

tGlass DomesticParrot: Parrot
tField Public Hame

7

?

egglname species]

tAccess Public

tImplements Constructor :Bawe
O0F Mame<rname

eggl

tAccess Fublic

tImplements Constructor :Bawk
ODF Mame<'FPolly’

R+Speak
tAccess Public
R<OBASE. Speak, ' Who's a prew

iEndClass A DomezticParrot

I | (]

Pos: 15/21,0

38548 bytes used (20136 bytes selected)
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Browsing Type Libraries

When the View/Type Libraries option is enabled, the Workspace Explorer allows
you to:

e Browse the Type Libraries for all the COM server objects that are installed
on your computer, whether or not they are loaded in your workspace.

e Load Type Libraries for COM objects

e Browse the Type Library associated with an OLEClient object that is
already instantiated in the workspace.

If the Microsoft NET Framework is installed, you may in addition:

e Load Metadata for specific NET classes
e Browse the loaded Metadata, viewing information about classes, methods,
properties and so forth.

Ifthe Type Libraries option is enabled, the Workspace Explorer displays a folder
labelled TypeLibs which, when opened, displays two others labelled Loaded
Libraries and Registered Libraries as shown below.

..'IJ Exploring CLEAR WS [#] g@ﬂ

File Edit Wiew Columns Tools

$RXQeE | EEEE M8

Workspace Tree Contents of #
- # Name Type
+ OsE

+-Jit MetaData
#1 Typelibs

%' Loaded Libraries
530 Registered Libraries

<] B
0 ohjectis), 61, 7Mb (64700600 bytes) free, 0 bykes used (0 bytes selected) in Lo
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Browsing Registered Libraries

If you open the Registered Libraries folder, the Workspace Explorer will display in
the tree view pane the names of all the Type Libraries associated with the COM
Server objects that are installed on your computer.

Ifyou select one of these Library names, some summary information is displayed in
the list view pane.

For example, the result of selecting the Microsoft Excel 9.0 Object Library is illus-
trated below.

2| Exploring CLEAR WS [#] E]@

File Edit View Columns Tools

TR XQE r DEGEE |60

Workspace Tree Contents of Typelibs\Reqgistered LibrariesiMicrosoft Excel 9.0 Ob
#I Microsaft DTSF‘ackag_*j Attribute Value
ﬂil Microzoft Excel 5.C CLSID {0002081 3-0000-0000-C000-00000000004
£ Microsoft Excel 9.0 Object Library. ('u'er'sion:1.3,Ll:uc:ahe:(?l)F"E><

] " T TR DR L= L= LI L ] L= T OSOTT TTTCE TTTC

3{;' Microsoft FlexGrid HelEFiIe C:':Pm;ram Files':Microsoft OFFice'ltOFFice'l,VB
#idMicrosoft FlexBGrid HelpID Dx0000FFFF
#IMicrosoft Forms 2.0 Yersion 1.3

< [ 2] |l 2]

0 object(s), 61.7Mb (64700600 bytes) Free,

Ifinstead, you select the Registered Libraries folder itself, the list of Registered Type
Libraries is displayed in the list view pane

s 1| Exploring CLEAR WS [#] [Z]@

File Edit View Columns Tools

YR XQE r DEGEE |60

Workspace Tree Contents of Tvpelibs\Reqistered Libraries
- B A Mame Loaded | CLSID A
+ OsE ~ || Microsaoft Directs Transforms Image T... {SEFTEE
4.t MetaData Microsoft Disk Quota 1.0 {798865
a \ Microsoft Excel 5.0 Object Library {000z208
= Typelibs . Microsoft Excel 8,0 Object Library | {000208
# Loaded Libraries Microsaft: Flexiarid Control 6.0 {9CF7aAll
547 Re gistered Libraries Microsoft Flexarid Contral 6.0 (SP3) {SESE7E
] Microsoft Farms 2.0 Object Library {0D452E
IAS Hel CoM C©
>y L """ | Microsoft Forms 2.0 Object Library [E7DELC
#9 IAS RADIUS Protocc || microsoft Forms 2.0 Object Library {67DSFO
. (Version:l1.0,Loce Microsoft Farms 2.0 Object Library {BEEAT]
¥l :-) WideoSoft weFle | Microsaft Forms 2.0 Object Library faC115z2
) @ w o ee e M| Microsoft Forms 2.0 Obiect Library {9C1152 %

0 object(s), 61.7Mb (64700600 bytes) Free, 0 bytes used (0 bytes selected) in Local Scope
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Loading a Type Library
You can load a library shown in the list view pane by double-clicking its name.

Alternatively, you can load a library shown in the tree view pane by selecting Load
from its context menu.

In either case, a message box will appear asking you to confirm. The operation to
load a Type Library may take a few moments to complete.

Notice that if the selected Library references any other libraries, they too will be
loaded. For example, loading the Microsoft Excel 9.0 Object Library brings in the
Microsoft Office 9.0 Object Library and the Microsoft Visual Basic for Applications
Extensibility 5.3 Library too. It also contains references to a general library called the
OLE Automation Type Library, so this is also loaded.

When you ) SAVE your workspace, all of the Type Libraries that you have loaded
will be saved with it. Note that type library information can take up a considerable
amount of workspace.
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Browsing Loaded Libraries

If you have already loaded any Type Libraries into the workspace, using the Work-
space Explorer or as a result of creating one or more OLEClient objects, you can

select and open the Loaded Libraries folder.

The picture below illustrates the effect of having loaded the Microsoft Excel 9.0

Object Library.

4] Exploring CLEAR WS [#]

M=%

File Edit YWiew Columns Tools

YR XQE| | EEEE (3 sl

Workspace Tree Contents of TypelibsiLoaded Libraries
oy B Mamme
+ OsEk DLE Automation
+-J&t MetaData Unknowin Types o
-y Typelibs Microsoft Office 9.0 Object Library

= ﬂgL':'adEd Libraries: Microsoft Excel 2.0 Objeck Library
w4 Microsoft Excel 9.0 O
+ Microsoft Office 9.0
w4 Microsoft Yisual Baszi
+ 451 OLE Autamatiaon
S| Regiztered Libraries

<] (2]

Microsoft Visual Easic For Applications. .,

Loaded | CLSID

Yes
Yes
Yes
Yes
Yes

{00020430-1
{2FCE3BCE-
{2DFa004C-
{000ZE157-1
{000208134

0 object(s), 61.7Mb (64700600 bytes) free,

Notice that any external references to other libraries causes these to be brought in

too.

Ifyou select a loaded Type Library, summary information is displayed in the list

view pane.

If you open a loaded Type Library, four sub-folders appear named Object CoClasses,

Objects, Enums and Event Sets respectively.
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Object CoClasses

A Type Library describes a number of objects. Typically, all of the objects have prop-
erties and methods, but only some of them, perhaps just a few, generate events.
Objects which generate events are represented by CoClasses, each of which has a
pointer to the object itself and a pointer to an event set.

For example, the Microsoft Excel 9.0 Object Library contains seven CoClasses
named Application, Chart, Global etc as shown below.

) Exploring CLEAR WS [#] =<

File Edit ‘Wew Columns Tools

P RXQE | » @0 EE(560 e

‘Workspace Tree Contents of TypelibsiLoaded Libraries\Microsoft Ex
= || Mame CLSID
OSE Application 4000245
Wt MetaDat a Chart 1000208

T Lib Global 4000203

= Typelibs - . - || oLECbject 4000205
=4 Loaded Libraries QuetyTable {59191C
Z# I Microsoft Excel 9.0 Object Warkbook {00203
‘Waorksheet {000208

ﬂilEObj ect CoClasses !
a1 Objects

%1 Enums

#'l Event Sets

<] —m e R Yl = B

0 ohject(s), 61.7Mb (64700600 bytes) free,
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Opening the Application folder you can see that the Application CoClass comprises
the Application object coupled with the AppEvents event set as shown below.

4] Exploring CLEAR WS [#]

l=Jo/Ed

File Edit YWiew Columns Tools

PmXQE| > &5 @E 2 e
Workspace Tree Contents of TypelibsiLoaded LibrariesiMicrosoft Ex

aﬂl Loaded Libraries

&)
=4I Microsoft Excel 9.0 Object hame Application
Sl Object CoClasses CLSID {00024500-0000-0000-C000-
HelpString
||| HelpFile C:\Program Files\Microsoft, Of
=4 Event 3Sets = ||| HelpID 000020001
SﬂlAppEvents
aaﬂl Interfaces
=% _Application
afilMethnds
| Froperties
#9 Chart
w85 Global ()
[{ ] i | [)] [( ] i [}]

0 object(s), 61.7Mb (64700600 bytes) Free,

The specific methods, properties and events supported by the CoClass object can be
examined by opening the appropriate sub-folder. The same information for these and
other objects is also accessible from the Objects and Event Sets folders as discussed

below.
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Objects

The Objects folder contains several sub-folders each of which represents a named
object defined in the library.

Each object folder contains two sub-folders named Methods and Properties. Select-
ing one of these causes the list of Methods or Properties to be displayed in the list
view pane. The picture below shows the Methods exposed by the Microsoft Excel
9.0 Range object.

) Exploring CLEAR WS [#] =<

File Edit “ew Columns Tools

TR XQE | @EEE 360l

‘Warkspace Tree Contents of TypelibsiLoaded LibrariesiMicrosoft Excel 9.0 Obijg
w85 Points || Mame Result adl
w4 Publi shObject Activate WT_VARIANT
w45 PublishObiects AddComment Comment,

9 AdvancedFilker WT_VARIANT
4o QueryTables ApplyMames WT_MARIANT
=81 Range ApplyQutlinestyles WT_VARIANT

AutoComplete WT_BSTR
2 . AutoFil WT_VARIANT

#4) Froperties AutaFiker YT_VARIANT
+-31 RecentFile | AutaFi WT_VARIANT
w41 RecentFiles AukoFormat WT_VARIANT
534 Rectangle AutoOutline WT_WARIANT

o || Bordersround WT_VARIANT

- #8 Rectangles v g YT YARIANT %)

< B3 S Ed

0 objeckis), 61, 7Mb (64700800 bytes) free,
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If you open the Methods or Properties subfolder, you can display more detailed
information about individual Methods and Properties. For example, the following
picture shows information about the SaveAs method exposed by the Microsoft Excel
9.0 Worksheet object.

4] Exploring CLEAR WS [#] =JEEs

File Edit Wiew Columns  Tools

B XQE  EEEE 2o el

Workspace Tree Contents of TypeLibsiLoaded Libraries\Micrasoft Excel 9.0 Object Library
@'l PivotTables A ~
@I PivotTableWizard | Mame Savehs b
£ PrintOut Help String
ﬂ PrintPrevieu HelpID O0001011c
%I Protect Fesult WT_WOID

41 Rectangles

] Argurnents:
ﬂ:l ResetAl1PageBreaks Fllename VT BSTR [ir]
i1 Savens FileFormat YT_VARIAMT  [Optionall,[in]
#%1 Scenarios Password YT_YARIAWT  [Optional],[in]
# Scrol1Bars WriteResPasswaord YT_VARIANT  [Optional],[in]
o ReadCnlvRecommended YT_VARIANT  [Optional],[in]
i Select CreateBackup YT_YARIANT  [Optional],[in]
41 SetBackgroundPicture AddTomMru YT_VARIANT  [Optionall,[in]
% ShowAllData || TextCodepage YT_YARIAMT  [Optional],[in] |
T S ™| TextvisualLayout YT YARIAMT  [Optionallfin] ™)
< ¥ < >

0 object(s), 61.7Mb (64700600 bytes) Free,

This tells you that the SaveAs method takes up to 9 parameters of which the first, File-
name, is mandatory and is of data type VT _BSTR (a character string). Note that [in]
indicates that the parameter is an input parameter.
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Incidentally, the optional Fileformat parameter is an example of a parameter whose
value must be one of a list of Enumerated Constants. Even without looking at the
documentation, the possible values can be deduced by browsing the Enums folder,
with the results shown below.

] Exploring CLEAR WS [#] Mi[=)[<
File Edit Mew Columns Tools
EERXQHE o EEER 21dlol6l
Workspace Tree Contents of TvpelibsiLoaded Libraries\Microsoft Exce
X1EditionOptiora|| MName |\p'alue Fadl
X1EditionType +laddIn 18
¥1EnableCancelk | XC3Y 6
#CS¥Mac zZ
¥1Enablelelect] wlCSYMSDnS o4
¥1EndStyleCap *ICSWindows 23
¥1ErrorBarDirec x:gg’tg ;
%
X¥1ErrorBarInclu «IDEF4 11
¥1ErrorBarType %IDIF 9
#1FileAccess lExcelz 16
W E T e mmmt #|ExcelZFarEast Z7
R1Fi1TWith #|Exceld 33
K¥1FilterAction xlExcels 39
: 1 | ®lExcel? 39 .
) - AlFindLaookIn 1™ dFyrelaras 47 ¥
£ | > £ | >
0 object(s), 61.49Mb (64474120 bytes) free,

You can therefore deduce that the following expression, executed in the namespace
associated with the currently active worksheet, will save the sheet in comma-sep-
arated format (CSV) in a file called mysheet.csv:

SaveAs 'MYSHEET.CSV' xlCSV
or

SaveAs 'MYSHEET.CSV' 6
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Event Sets

The Event Sets folder contains several sub-folders each of which represents a named
set of events generated by the objects defined in the library.

If you open one of these event sets, the names of the events it contains are displayed
in the tree view pane. If you then select one of the events, its details are displayed in
the list view pane as shown below.

r."ﬂ Exploring CLEAR WS [#] E]@w

File Edit WYiew Columns Tools

2BXxQ@ ~|([RRma|[6elal

Workspace Tree Contents of TypelibsiLoaded Libraries\Microsof
=% ~
OsE Marme Sheetictivate
Figt MetaData | Help String
9 Typel ibs = || HelpIn 000010615
24" Loaded Libraries Result WT_WOID
EﬂilMicrnsnFt Excel 9.0 Objec
# Ohbhject CoClaszszes ggguments: YT DISPATCH

o bhjects
#%1 Enums
= #%1 Event Sets
=25 AppEvents
= 'l Events
i1 Newkarkbook
0 ] (21 2 — B

0 object(s). 60.34Mb (63266256 bytes) free.

This example shows that when it fires, the SheetActivate event invokes your call-
back function with a single argument named S% whose datatype is VT_DISPATCH
(in practice, a Worksheet object).
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Enums

The Enums folder will typically contain several sub-folders each of which represents
anamed set of enumerated constants.

Ifyou select one of these sets, the names and values of the constants it contains are
displayed in the list view pane as shown below.

4 Exploring CLEAR WS [#]

=%

File Edit Mew Columns  Tools
BB XQE cf alglal o

Workspace Tree

Contents of Tvpelibsiloaded Librariesik

F

+

+

2
0 object(s), 61.49Mb (64474120 bytes) Free.

= ]
e OSE
It MetaData
& Typelibs
%1 Loaded Libraries
gl Microzaft Excel 9.0 Object Librez
+ S{iIObject CoClaszes
1451 Objects
—.%%1 Enumsz
#’l Constants
#h XlApplicationlnternational
o1 XlApplyNamesOrder
| XlArrangestyle |
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w2 4Hour Clock, 33
wl4Digitears 43
wlalternatedrraySeparator 16
wlZolumn3epar akor 14
*lZountryCode 1
*lZountrySetting 2
wlZurrencyBefore 37
wlZurrencyCode 25
wlZurrencyDigits 27
wlZurrencyleadingZeros 40
wlZurrencyMinusSign 38
wlZurrencyMegative 28
wlZurrencySpaceBefore 36
wlZurrency TrailingZeros 39
#IDatedrder 32 1
¥INateSenarator 17 |¥
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Browsing .NET Classes

Microsoft supplies a tool for browsing .NET Class libraries called TLDASM. EXEL

As a convenience, the Dyalog APL Workspace Explorer has been extended to per-
form a similar task as TLDASM so that you can gain access to the information within
the context of the APL environment.

The information that describes NET classes, which is known as its Metadata, is part
of'the definition of the class and is stored with it. This Metadata corresponds to Type
Information in COM, which is typically stored in a separate Type Library.

I TLDASM.EXE can be found in the NET SDK and is distributed with Visual Studio
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To gain information about one or more .NET Classes, open the Workspace Explorer,
right click the Metadata folder, and choose Load.

rm Exploring CLEAR WS [#] I'_Hglﬁ1

File Edit Wiew Columns Tools
PEBXQE  |DEEE 46 el
Workspace Tree Contents of MetaData

ERL.
=) OSE

Bt MetaData
&Y Typelibs

This brings up the Browse .NET Assembly dialog box as shown below. Navigate to
the .NET assembly of your choice, and click Open.

~
@ Browse .NET Assembly M
@'\_J'| || « MicrosoftNET » Framework6d » v20.50727 » ~ | 42 || search v20.50727 o]
Organize MNew folder === Sl @
.. Program Files = MName Date modified Type i
i P Fil = e
S (%) Microsoft.Vsa.dll 21/03/2014 00:50 Application extens...
WP Dat = - P
rogramliata %] MmcAspEst.dll 04,/03/2014 07:58 Application extens...
|/ RaspberryPi = T
eI %] mscordacwhs.dll 09/07/2014 01:21 Application extens...
i Recovery %] mscordbe.dil 21/03/201400:50  Application extens...
W SWSETUP = . P
%) mscordbi.dll Application extens...
J SR ] mscorie.dll 19/06/201401:23  Application extens... | |
L. SYSTEM.SAY s " — E
U (%) mscorjit.dll 05/10/2012 13:52 Application extens... |7
o Lsers ] mscorld.dil 21/03/2014 00:50 Application extens... —
N b = - P
WEDCam |.ﬁ. mscorlib.dll 09,/07/2014 01:21 Application extens...
., Wind
j o 2o 1 %] mscorpedll 2171172010 05:23 Application extens...
HP_RECOVERY (L
= ( (%) mscorpjt.dIl 21/03/2014 00:50 Application extens...
Mi ft Offi
& Microsolt Uifiee %) mscorre.dil 21/03/201400:50  Application extens...
G 3 %] mscorsec.dll 21/03/2014 00:50 Application extens...
MNetwork
“i o @] mscorsn.di 21/03/201400:50  Application extens...
1M DG4 CC4000000
Lo %) mscorsve.dll 21/03/2014 00:50 Application extens... -
M Hp [ e 1 | %
File name: mscorlib.dll v | .NET Assemblies (*.dil) -
[ Open |v] ’ Cancel ]
L
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Note that the NET Classes provided with the .NET Framework are typically located
in C: \WINDOWS\Microsoft.NET\Framework\v2.0.50215. The last
named folder is the Version number.

The most commonly used classes of the NET Namespace System are stored in this
directory in an Assembly named mscorlib.dl1, along with a number of other fun-
damental .NET Namespaces.

The result of opening this Assembly is illustrated in the following screen shot. The
somewhat complex tree structure that is shown in the Workspace Explorer merely
reflects the structure of the Metadata itself.

1| Exploring CLEAR WS [#] g@

File Edit Wiew Columns Tools

rEXQE o |E0ma (3 e
wWorkspace Tree
=Mt mscorlib A
—-Jét Modules
o Bt L AWINDOWSAMicrosoft . HETAFrameworkhy2, 0.50215mscorlib.dl| |
--fEt Namespaces

+-det [Unnamed]
+-JEt Microsoft.Win32
-0t Microsoft.Win32.5afeHandles
+ fEt System
+-JE System.Collections

+-fift System.Collections.Beneric

- fift System.Collections.0bjectMadel

+ fft System.Configuration.Assemblies

+-fE System.Deployment. Internal

+-fEt System.Deployment. Internal.lsolation

+-fift System.Diagnostics

+ fift System.Diagnostics.CodeAnalysis

+-fE System.Diagnostics.SymbolStare

+-fift System.Globalizatian

+-f#t System. [0 v




Chapter 1: The APL Environment 101

Opening the System/ Classes sub-folder causes the Explorer to display the list of
classes contained in the NET Namespace System as shown in the picture below.

' | Exploring CLEAR WS [#] g@]“

File Edit wiew Columns Tools

PBRXQE (@0 mEE (56 el

Warkspace Tree
ot System [A]
E]ﬁrﬂlasses =
Tigt Sy=tem. _AppDomain
Tt System.AccessViolationException
fift System.Action’t
it System.ActivationContext
Tt System.Activator
Tt System.AppDomain
fift System.AppDomain+EvidenceCollectiaon
it System.Applomainlnitializer
Tt System.AppDomainlnitializerInfo+ltemInfo
Tt System.AppDomainManager
Bt System.ApplomainSetup [V]
(<] | i (#]
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The Constructors folder shows you the list of all of the valid constructors and their
parameter sets with which you may create a new instance of the Class by calling
New. The constructors are those named .cfor; you may ignore the one named .cctor,
(the class constructor) and any labelled as Private.

For example, you can deduce that DateTime . New may be called with three
numeric (Int32) parameters, or six numeric (Int32) parameters, and so forth. There
are in fact seven different ways that you can create an instance ofa DateTime.

4 Exploring CLEAR WS [#] -Joks

File Edit Yiew Columns Tools

$ R XQE o |E0mE [38so

‘Workspace Tree Conkenty
—-Jét System.DateTime ‘\
+ JEt Baze Class
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gt (PrivatelVoid .cctor()
et (Private)VWoid .ctor(Int6l, System.DateTimeKind, Baaolean)
gt (PrivatelVoid .ctor(System.Runtime.Serialization.Serializatior
et (PrivatelWoid .ctor(UIntel)
Jét Void .ector(Int32, Int32, Int32)
5t Void .etar(Int32, Int32, Int32, Int32, Int32, Int32)
et Void Lctar(Int32, Int3Z2, Int32, Int32, Int32, Int32, Int3Z]
&t Yoid .ctor(Int32, Int32, Int32, Int32, Int32, Int32, Int32, Sy
Mgt Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32, Int32, S5
Mgt Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32, Int32, S5,
et Yoid .ctor(Int32, Int32, Int32, Int32, Int32, Int32, System.D:
gt Moid Letar(Int32, Int32, Int32, Int32, Int32, Int32, System.Gl
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+- Mgt Methods |
+ . J#t Properties id
4 >

For example, the following statement may be used to create a new instance of
DateTime (09:30 in the morning on 30t April 2001):

mydt<[INEW DateTime (2001 4 30 9 30 0)

mydt
30/04/2001 09:30:00
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The Properties folder provides a list of the properties supported by the Class. It
shows the name of the property followed by its data type. For example, the
DayOfYear property is defined to be of type Int32.

réﬂ Exploring CLEAR WS [#] g@1

File Edit Yew Columns Toals
P RXQE| ~|[EEEE |56 el o

\workspace Tree

=Bt System.DateTime [h]
]ﬁ'Base Class
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w0t Fields
]ﬁ‘?’rMethDds
=-ft Properties
f&t (Private)Internalkind @ System.UIntgl
fét (Private)lInternalTicks @ System.Intil=
%t Date : System.DateTime
%t Day : System.Int32
]ﬁtDayOFHeek !oSystem. DayQfWeek
%t DayOffear @ System.Int32
Bt Hour @ System. Int32
Bt Kind : System.DateTimeKind
Tt Millisecond & System.Int32
Ht Minute : System. Int32
%t Month @ System.Int32
Tt Mow : System.DateTime
%t Second : System.Int32
Tt Ticks @ System.Intél
Bt TimeOfDay : System.TimeSpan
%t Today @ System.DateTime
Tt UtcHow : System.DateTime
%t Year @ System.Int3Z [v]

(<] | i | (2]

You can query a property by direct reference:

mydt.DayOfWeek
Monday
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Notice too that the data types of some properties are not simple data types, but

Classes in their own right. For example, the data type of the Now property is itself
System.DateTime. This means that when you reference the Now property, you
get back an object that represents an instance of the System. DateTime object:

mydt.Now
07/11/2001 11:30:48
aTs
2001 11 7 11 30 48 O

The Methods folder lists the methods supported by the Class. The Explorer shows the
data type of the result of the method, followed by the name of the method and the
types of its arguments. For example, the IsLeapYear method takes an Int32 para-
meter (year) and returns a Boolean result.

mydt.IsLeapYear 2000

1] Exploring CLEAR WS [#] M=%
File Edit “iew Columns Tools
18X Q| | [E0mE [ sl ol
Workspace Tree
gt (PrivatelVoid Finalizel() Ai

Fet (PrivatelYoid System.Runtime.Serialization.ISerializa
fet Boolean Equals(System.DateTime)

fiet Boolean Equals(System.DateTime, System.DateTime)

fet Boolean Equals(System.Object)

figt Boolean IsDaylightSawingTimel)

TietiBoolean IsLeapYear(Int32) !

fiet Boolean op_Equality(System.DateTime, System.DateTime]
figt Boolean op_GreaterThan(System.DateTime, System.DateTi
figt Boolean op_GreaterThanOrEqual (System.DateTime, System
figt Boolean op_Inequality(System.DateTime, System.DateTim
fiet Boolean op_LessThan(System.DateTime, System.DateTime]
figt Boolean op_LessThanOrEqual (System.DateTime, System.Da
figt Boolean TryParsel(System.String, System.DateTime ByRef
figt Boolean TryParse(System.String, System.IFormatProvide

figt Boolean TryParseExact(System.String, System.5tring, S
figt Boolean TryParseExact(System.String, System.Stringl],

 digt Double ToOQADate() ,V:
< >
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Many of the reported objects are listed as Private, which means they are inaccessible
to users of the class — you are not able to call them or inspect their value. For more
information about classes, see the chapter on Object Oriented Programming in the
Dyalog APL Language Reference Manual.

B Exploring CLEAR WS [#] M=E3
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f&t Bonlean op_GreaterThanCSystem.DateTime, Sustem.De
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< >

1 objeckis). 53.9Mb (56518472 bytes) free,
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Find Objects Tool

The Find Objects tool is a modeless dialog box that may be toggled on and off by
the system action [WSSearch]. In a default Session, this is attached to a Menultem
in the Tools menu and a Button on the session toolbar. This tool allows you to search
the active workspace for objects that satisfy various criteria.

The first page allows you to specify the name of the object which you wish to find
and the namespace(s) in the workspace that are to be searched for it.

£ Find Objects

File Edit Wiew Columns 3Search

b O I I A I = O O At |

gDeIete Props Large | Small  List Details | Mame | Size Date Tvpe

Name/Location | Madiied | Advanced

MNamed:

ariables Functions Operators Mamezpaces
Loak i
Include sub-nameszpaces Include Sezzion namespace

You type the name of the object you wish to find into the field labelled Named. To
locate all objects beginning with a particular string, enter the string followed by a 'x'
character. For example, if you enter the string FOOx*, the system will locate all
objects whose name begins with FOO.

Four check boxes are provided for you to specify the types of objects you wish to loc-
ate. For example, if you clear Variables, Operators and Namespaces, the system will
only search for functions.
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You can restrict the search to a particular namespace by typing its name into the field
labelled Look in. Y ou can also restrict the search by clearing the Include sub-
namespaces and Include Session namespace check boxes. Clearing the former
restricts the search to the root namespace or to the namespace that you have specified
in Look in, and does not search within any sub-namespaces contained therein. Clear-
ing the latter causes the system to ignore [JSE in its search.

The second page, labelled Modified, allows you to search for objects that have been
modified by a particular user or at a certain time

£ Find Objects

File Edit Wew Columns Search

* B BB @B E | #4|od = o8l

;Delete Props Large | Small  List  Details | Mame | Size  Date  Type

Mame/Location | Modified | 4dvanced

Modified Dbjects

Modified by:

) Any date

@ civean | 07M12/2007
and 06/01/2008

O during the presious mianth(z]

) during the previous day(s]

To make the search dependent upon modification, you must check the Modified
Objects check box.

To locate objects modified by a particular user, enter the user name in the field
labelled Modified by. Otherwise leave this blank.

To find objects which have been modified at a certain time or within a specified
period of time, check the appropriate radio button and enter the appropriate dates or
time spans.
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The third page, labelled Advanced, allows you to search for objects that contain a par-
ticular text string.

£ Find Objects

File Edt Wiew Columns  3Search

X E H B8 B B | #4|o sl ol

gDeIete Props Large | Small  List  Details | Mame | Size Date Tvpe

Mame/Location | Modified | Advanced

Containing T ext: ]

Match Caze tdatch whole Ward
Ilse Fegular Expressions [ | As Symbol Reference

[]5ize between

If you wish to search for objects containing a particular character string, type the
string into the field labelled Containing Text.

Match Case specifies whether or not the text search is case sensitive.

Use Regular Expressions specifies whether or not regular expressions are applicable.
For example, if you enter FOO* into the field labelled Containing Text and check
this box, the system will find objects that contain any text string starting with the 3
characters FOO. If this box is not checked, the system will find objects that contain
the 4 characters FOO*.

Match Whole Word specifies whether or not the search is restricted to entire words.

As Symbol Reference specifies whether or not the search is restricted to APL symbols.
If so, matching text in comments and other strings is ignored.

If you wish to restrict the search to find only objects whose size is within a given
range, check the box labelled Size is between and enter values into the fields
provided.
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When you press the Find Now button, the system searches for objects that satisfy all
of the criteria that you have specified on all 3 pages of the dialog box and displays
themin a ListView. The example below illustrates the result of searching the work-
space for all functions containing references to the symbol CURSOR.

-,

&1 Find Objects

File Edit Wwiew Columns Search

X B OB EH EBE B 2l o 9 &l

Delete Props Large Small  List Details || Mame Size  Date  Type

Mame/Location | Modiied Advanced l
Containing Text: | CURZOR j

v tatch Caze vk atch whale Word Mew Search
v UszeBegular Exgpressions | Az Symbol Beference Cloze

[ Size between |

Mame Location ||
.@BED_EOPYMENUS #.Whesign.BMED
.@EHﬁ.HGEPHﬁ.L #.Whesign '
Firipenr p1rienl # LiNasinm RMWER bl
4 »

6 object{s) Found in Global Scope

You may change the way in which the objects are displayed in the ListView using
the View menu or the tool buttons, in the same manner as for objects displayed in the
Workspace Explorer. You may also edit, delete and rename objects in the same way.
Furthermore, objects can be copied or moved by dragging from the ListView in the
Search tool to the TreeView in the Explorer.

If you wish to specify a completely new set of criteria, press the New Search button.
This will reset all of the various controls on the 3 pages of the dialog box to their
default values.
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Object Properties Dialog Box

The Object Properties dialog box displays detailed information for an APL object. It
is displayed by executing the system action [Ob jProps]. In a default Session, this
is provided in the 7ools menu, the Session popup menu and from the Explorer. An

example (for a function) is shown below.

Properties Tab

The Properties tab displays general information about the object. For a function, this
includes an extract from its header line, when it was last modified, and by whom.

¥l #.CENTRE - Properties

=,

{ Properties || value | Monitor

CENTRE

Type Function
Dezcription
Location  #

Size 3926 [392 bytes]

By Diyadic

Modified 04 Movember 1998 12:35

1]9

I

Cancel
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Value Tab

For a variable, the Values tab displays the value of the variable. For a function, it dis-
plays its canonical representation.

Y] #.CENTRE - Properties

-,

[11]
[2]
(2]
(L]
(5]

Froperties || ¥alue | kanitor

¥ TEXT+<W CENTRE TEXT:SPC5:FORE;BACK
TEXT=( (" 1LpTEXT), WITTEXT
SPCE<TEXT=" '
FORE++/~%5PCS
BACK<+/~%$EPCE
TEXT=([0.5=<FORE-BACK) $TEXT

Centre TE.
Stretch t
Identify :
Humber of

D DD D 323D

Rotate ea:

(] l[ Cance
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Monitor Tab

The Monitor tab applies only to a function and displays the result of JMONITOR.
The Reset button resets JMONITOR for the lines on which it is currently set. The Set
All Lines button sets JMONITOR to monitor all the lines in the function. The Clear
All Lines switches JMONITOR off.

[ 1
¥] #.CENTRE - Properties

Properties | Yalue | Manitor

Line Murmber Counk CPU kime {ms) | Elapsed time (ms)

o 4006 551 550

1 4006 140 150

2 4006 F0 70

3 4006 30 40

4 4006 &0 &0

5 4006 130 130

Reset | | SetéllLines | | ClearallLines |
[ (] H Cancel
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COM Properties Tab

The COM Properties tab applies only to a function in an OLEServer or Act-
iveXControl namespace. The tab is used to define arguments and data types for an
exported Method or Property. For further information, see Interface Guide.

Y] #.Loan.CalcPayments - Properties
Properties | Walue | Monitor| COM Properties
Param Name| Type | b odifier | Optional |
Result | WT_R& | WT_ARRAY|w
Laandmt WT_l4 4 E4 ]
LerMax  VT_I4 v ~ O
LerMin  WT_I4 v ~ O
Itz VT4 v ~ O
niMin VT_I4 v ~ O
Help 1D

{(®) Method () Prop Get ) Prop Set

Exported

(] l [ Cancel
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Net Properties Tab

The Net Properties tab applies only to a function in a NetType namespace. The tab is
used to define arguments and data types for an exported Method or Property. For fur-

ther information, see Dyalog .NET Interface Guide.

e -
#] #.APLClasses.Primitives. IndexGen - Properties E]
F"ru:uperties] Yalue ] b cnitar
Param Name| Type | b ddifier | O ptional |
Resut  |Int32) | -
Murnber Int32 - ﬂ n
Help o] |

0+ Method " wieb Method  © Prop Get ¢ Prop Set |

[+ Public [ Static [ Wirtual [ Construchar
[ Protected

k. | Cancel
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The Editor
Invoking the Editor

The editor may be invoked in several ways. From the session, you can use the system
command ) ED or the system function [JED, specifying the names(s) of the object(s) to
be edited. You can also type the name of the object and then press Shift+Enter (ED),
click the Edit tool on the tool bar, or select Edit from the Action menu. If you invoke
the editor when the cursor is positioned on the empty input line, with a suspended
function in the State Indicator, the editor is invoked on the suspended function and
the cursor is positioned on the line at which it is suspended. This is termed naked
edit. These ways of invoking the editor apply only in the session window

£ Editor - [BUILD_SESSION] =)o
[ file Edit Refactor window iiew - & =
1A A X v 0B 4 m*F P

[0] {FILE}EBUILD_SESSION LANG: OBT; MSG: OI0:OML; OLD; NEW; MOTIF 2 w|a
[1] A Build the zesszion object and szave if desired

[2] :If 0=0ONC'MoPrompt' < MoPrompt+0 <@ :EndIf

[3] :If O=0ONC'FILE' = FILE+'' % :EndIf

[L]

[5] OWs+0SE.OWs+1 < OML OI0«1 < OPATH+'#.Trans'

[6] OPW+=122 A allows room for Status Bar

[7] MOTIF+='M'=32t«"_ 'OWE"'APLYerszion'

[a] Y12+122230VFT{ (7 1oy’ Dt} 2ot

[2] LANG+upCase, LANG A translation assumes uppercase

[10] UNICODE+80=00R" '

[11] ‘“Unknown language 'O5IGHNAL(Trans.CODESe™~cLANG) 411 ¥
< 2
Function Last saved by Pete: 14 August 2009 0951 Pos: 0f207,1

In addition, there is a general point-and-edit facility which works in edit and trace
windows too. Simply position the input cursor over a name and double-click the left
mouse button. Alternatively, you can press Shift+Enter or select Edit from the File
menu. The name can appear in the Session, in an Edit window, or in a Trace window;
the effect is the same. Note that, in the Session, typing a name and pressing
Shift+Enter is actually a special case of point-and-edit. Note also that a naked edit
can be invoked by double-clicking the left mouse button in the empty input line.

The type of a new object defaults to function/operator unless the object is shadowed,
in which case it defaults to a variable (vector of character vectors). You can however
specify the type of a new object explicitly using ) ED or JED . For example, typing
")ED €LIST -MAT"ina CLEAR WS would create Edit windows for a vector of
character vectors named LIST and a character matrix called MAT. See ) ED or[JED for
details.
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Ifthe name is not already being edited, it is assigned a new edit window. If you edit a
name which is already being edited, the system focuses on the existing edit window
rather than opening a new one. Edit windows are displayed using the colour com-
bination associated with the type of the object being edited.

Window Management (Standard)

Unless Classic Dyalog mode is selected (Options/Configure/Trace/Edit), the Editor
is a Multiple Document Interface (MDI) window that may be a stand-alone window,
or be docked in the Session window. Each of the objects being edited is displayed in
a separate sub-window. Individual edit windows are managed using standard MDI
facilities.

Editor - |8
[ BEX

File Edit Refactor ‘Window View

JP BUILD_SESSION =

A A X | lv|4b 4% m *°F °p
[0l {FILE}BUILD_SESSION LANG;OBJ;MSG;DIO;I:IML;CILD;NEN;MOTIF;CI@
[1] A Build the session object and save if desired
[21 - : : —

(2] |B»BUILD_MB_FILE =<

[u]
ey [F1 R A X v|d8 40 m *F %P

[&] [o] MEB BUILD_MB_FILE LANG

[7] [1] Ocs Me

[8] [2]

[9] [3] "file'OWE 'Menu' [LANG TranslateString &File’]
ERPE| I

[ﬂ— [5] 'file.clear 'OWC'Menultem' (LANG TranslateStringm
Functiortli [ ¢ ] "file.clear 'OWS 'Event' 'Select’ '[wsclear]’

[7] "file.clear 'OWS'Hint ' (LANG TranslateString ' Clew

[&]
il | (]

Function johnd: 10/04/2006 Pos: 0/67,1

The first edit sub-window window is created at the position specified by the edit_
first_y and edit_first x parameters which are specified in terms of the size of a char-
acter in the current font relative to the top-left comer of the main Editor window. Sub-
sequent ones are staggered according to the values of the edit_offset_y and edit_
offset_x parameters.

The initial size of an edit window is specified by the edit rows and edit_cols para-
meters.
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By default, the Session has the Editor docked along the right edge of the Session win-
dow. When you edit a function, the Editor window automatically springs into view
as illustrated below.

5 C:\Program Files\Dyalog\Dyalog APL 12.1 Uni BUILDSE - Dyalog APL/W Jo&d
Fle Edit View Windows Session Log Action Options Tools Threads Help
wi DS E & ot BB SV b b7 @ br iteo £ G B M i BB B o o Session | APL385Unicods . 1672
Language Bar Zlelx| ill
FEEEEERLT] (L] FEREEFER [([=EOBH []]snEH [Fle[s[ls] [T ] [oO«[+] [ole]e] & | &
[Unicode Edition ]
Fri Aug 14 09:59:28 2009
clear ws
Jload BUILDSE
C:Program Files\DyalogiDyalog APL 12.1 Unicode‘ws\BUILDSE saved Tue Jul 28 12:11:18 2009
This workspace is used to reset the session according to some
international formats 1ike german, french or english.
For example, to redefine the italian look try
BUILD_SESSION 'IT'
You can alse reset the SALT utility pragrams here by daing
BUILD_DVALOGSPACE
In any case, to make sure the changes are effective, you should
save your session via the menu item Session/Save or Save as...
Dyalag 2008
Yersion 2.31
Jfns
BUILD_DYALOBSPACE BUILD_MB_ACTION BUILD_MB_EDIT BUILD_MB_FILE BUILD_MB_HELP BUILD_MB_LOG
BUILD_MB_OPTIONS BUILD_MB_SESSION BUILD_ME_THREADS BUILD_MB_TOOLS BUILD_MB_VIEW
BUILD_MB_YIEW_COOL BUILD_MB_WINDOWS BUILD_POPUP BUILD_SB BUILD_SESSION BUILD_TE
BUILD_TC BootlLib BootLocation BootSALT BuildSessionMenu DI T¥ersion GetUTFBFile
I0_TOGGLE KEY_TOGGLE POSITION_SESSION TB_POPUP TOGELE  UCMD Wilonaded lowCase
upCase wsdiff
5
k=]
Debugger w
Ready. .. Ins  HUM
CurQbj: &1 Opg:=0  OTRAP  OSI:0 OI0:1  [OML:O
B C:\Program Files\Dyalog\Dyalog APL 12.1 Unicodews\BUILDSE - Dyalog APLAW ok

Fle Edit Refactor Window View

v D EOEE Y o BBV E b @k o Q@ H M e B o o s i ek (V][ T
Language Bar Zlaix ﬁ

[ELEEREENT) [ITIET EFERFERR
Fri Aug 14 09:59:28 2009
clear ws
Jload BUILDSE
C:%Program Files\DyalogiDyalog APL 12.1 Unico

3

BlA A X | v|ab & m°F P

[o] {FILE}BUILD_SESSION LANG:OBI;MSG:OI0:0ML: OLD: NEWsMOTIF; COC
[11 A Build the session object and save if desired

[2] :1f 0=0ONC'MoPrompt’ ¢ MoPrompt<0 ¢ :EndIf

[3] :1f O=0OMC'FILE' & FILE+'' ¢ :EndIf

[4]

[s1 OWX«OSE.OWX+1 < OML OI0+1 ¢ OPATH+'#.Trans'

[6] 0Pk
[7] woT{ § BUILD_MB_FILE
[81l W124| L e
(o M A oA X | v|oe gn m *F %P
[10] untdftel MB BUILD_MB_FILE LAMG

[111 Tundl L] ocs e

121 [2]

[13] n Expf[3] |'file'OWE Menu' (LANG TranslateString'&File’)
[l A ang|l4]

This workspace is used to reset the session a
international formats 1ike german, french or

For example, to redefine the italian look try

BUILD_SESSION 'IT'

You can also reset the SALT utility programs
BUILD_DVALOGSPAGE

In any case, to mske sure the changes are eff
save your session via the menu item SessiondS

Dyalog 2008 151 op|l5] "File.clear 'OWC 'Menultem' (LANG TranszlateStrin
Version 2.31 [16] og 8] ‘file.clear'OWs 'Event’ 'Select’ '[usclear]’
Jfns 1171 op)|[7] ‘file.clear'OWS'Hint' (LANG TranslateString'Cl
BUILD_DYALOBSPACE BUILD_MB_AGTION BUILD Lol nrug|[8]
BUILD_ME_OPTIONS BUILD_MB_SESSION <] [31 ‘file.load 'OWC 'Menultem' (LANG TranslateString
BUILD_ME_WIEW_COOL EUILD_ME_WINDOWS Function [10] ‘file.load 'OWS'Event’ "Select’ '[wsload]’
BUILD_TC " BootLib BootlLocation Boots 111 "File.load 'OWS'Hint'(LANG TranslateString'Loa
[0_TOBGLE KEY_TOBGLE POSITION_SES f1z]

[13] “file.copy OWE'Menultem' (LANG TranslateString
[14] “file.copy 'OWS'Event' 'Select' '[wscopyl’ L

rie1 triaa LIS Ut ek PO AN T

<]

uplase wsdiff

PR [

M ] >
3 —— ) Funiction Last saved by: johnd: 10 April 2006 11:37  Pos: 3/67,1 [ﬂ
Debugger Blalx| m | 2]
Ready. .. Ins  HUM

Editor

CurObj: MB (Undefined) &:l Oba:o  OTRAP OSI:0  Q0OI0:1  [OML:0
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You can resize the Editor pane to view more or less of the Session itself, by dragging

its title bar.

Using the buttons in the title bar, you can instantly maximise the Editor pane to
allow you to concentrate on editing, or minimise it to reveal the entire Session. In
either case, the restore button quickly restores the 2-pane layout.

The picture below shows the effect of maximising the Editor. The BUILD_SESSION
edit window is itself maximised within the Editor too.

£ C:\Program Files\Dyalog\Dyalog APL 12.1 Unicode\ws\BUILDSE - Dyalog APLAY - [BUILD_SESSION] |==|
Jp Fle Edt Refactor Window Yiew -8 x
ws DM E Y o BB S5 v b B2 @b oo O G H e ¥ 4 G Session (B APL3BSUnicede (v || 162
aunﬁx ~ b dh *m *F %P
| [o] {FILE}BUILD_SESSION LANG; 0BT MSG; OI0; OML; OLD; NEWsMOTIF; COOL; MB; SB1; SB2; TB; SBs SEBH  toolsidyalogikini ok OPATH » &
[1] A Build the sezsion object and save if desired
[2] t1fF 0=0NC'NoFrompt' © NoPrompt+d & :EndIf
[31 :If 0=0ONC'FILE' © FILE+'' ¢ :EndIf
[u]
[5] OWX+0SE.OWX+1 < OML OI0<1 ¢ OPATH+'#.Trans’
le] OPWe122 7 allows roam for Status Bar
[71 MOTIF+'M'=32t«". 'OWG " 'APLYersion’
[al Y12¢1222900F 1L (" 1+en . ') tw} 2ot
[3] LANG+upCase, LANG @ translation assumes uppercase
[101 UNIGCODE<B0O=0DR' '
[111 "Unkonwn lTanguage '0SIGNALLTrans.CODES=XcLANGI+11
[12]
[13] A Expunge MenuBar(s), StatusBar(s), ToolBar(s) and TipField(s)
[l A and expunge OSE.WSDoc and OSE.HumEd
[15] OBJ+«0OWN 'OSE "
[16] OBI+( (0BT [OWE"c'Type')e'MenuBar’ 'StatusBar' 'ToolBar' 'TipField' 'Menu' 'CoalBar')/0BI
[1vl OBJ,+'0SE.WSDoc' 'OSE.MNumEd'
[18] DEX 0BT
[19] 'OSE‘OWS 'Event' 0 0
[20]
[211 :If 0=2p0BJ«0SE.ONL 2 2 4 9
[22] 0BJe~o ' 'TLIOBT
[23] TEXT=(='Da yau want to delete all the following Session objects 7°),087
[2uv1 'MSE'OWC 'MsgBox ' 'BUILD_SESSION'TEXT('Style' 'Query')('Event' "All' 1)
[25] $IF NoPrompt
[26] 10r1f 'MsgBtnl '=25000Q'MSG'
[271 [+ Removing ', (7242,/0B7,7c', '),’
[281 OSE.OEXT0BT
‘5 [29] ‘... Done’ v
£l 2]
W Function Last saved by: Danb: 19 May 2009 11:42 Pos: 0j207,1
Ready. .. Ins  NUM
Curdbj: MB (Undefined) &:1 Opg:0o  QOTRAP  OSI:o  OI0:1 OML: 0

Note that when the Editor has the focus, the Editor menubar is displayed in place of

the Session menubar.
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Window Management (Classic Dyalog mode)

If Classic Dyalog mode is selected (Options/Configure/Trace/Edit) each Edit win-
dow is a top-level window created as a child of the Session window. This means that
normally Edit windows appear on top of the Session. However, if the SessionOnTop
parameter is set, the Session window, when given the focus, will appear on top of

Edit windows.

When the first Edit window is opened, its position is determined as follows:

o Ifthe ClassicModeSavePosition parameter is set, the first Edit window is
displayed at the position that was previously occupied by the most recently
saved Edit window.

e Ifnot, the first edit window is created at the position specified by the edit_
first_y and edit_first x parameters which are specified in terms of the size
of a character in the current font relative to the top-left comer of the screen.

The initial size of an edit window is specified by the edit_rows and edit_cols para-

meters.

S BUILD_SESSION M=
File Edit Refactor Wiew

1 A A X v| a6 4 *m *F
[0] I{FILE}EUILD_SESSION LANG:QBT:MEG:0OI0: |
[1] f Build the zession object and save if®!
[2] :If 0=0ONC'NaPrompt' < NoPFrompt<0 < :Em
[31] :1f O=0ONC'FILE' ¢ FILE+'' ¢ :EndIf

(L]

[5] OW¥+0SE.OWE+1 < OML OI0+1 < OPATH+'#.»
(6] OPW+122 A allows room for Status Bar (¥
.<. .}.
Funckion Danb: 19/05)2009 | Pos; 0f207,1

Subsequent ones are staggered according to the values of the edit_offset y and edit_

offset_x parameters.
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o] F,ﬁ BUILD_TC mE<|

o File Edit Refactor  Wiew

(11 |1 A A X v| b 4% m®

(21 (o] BUILD_TC LAMNG;X;IL:;TE;S ~

(31 |§[11] IL<(='0%E.chtop.'), " "iln' "ilh' "ili wl

(L1 2] TB+'Ose.chtop.bandthl.th’

(51 |J[2] TE OWC'Toolcantrol '('Divider' O0J('Sh »

[6] I[L] tWith TE

<1 ll[s] OWS ' Imagelist'IL

Functil| [6 ] :If ~#$.MOTIF A pop-up menu probl
[7] OWs( 'Event' 'MouseDown' '0OSE *
[a] tEndIf —
i ) V
Funckion johnd: 08/01/2008 Pos: 0f182,1

Moving around an edit window

You can move around in the edit window using the scrollbar, the cursor keys, and

the PgUp and PgDn keys. In addition, Ctrl+Home (UL) moves the cursor to the begin-
ning of the top-line in the object and Ctrl+End moves the cursor to the end of the last
line in the object. Home (LL) and End (RL) move the cursor to the beginning and

end respectively of the line containing the cursor.

Closing an edit window

Closing an edit window from its System Menu has the same effect as choosing Exit
from the File Menu; namely that it fixes the object in the workspace and then closes
the edit window.

Minimising an edit window

Minimising an edit window causes it to be displayed as a Dyalog APL Edit icon,
with the name of the object underneath. The edit window can be restored in the nor-
mal way, or by an attempt to re-edit the same name.
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Editor ToolBar
A A X

| o8 4 B aA | M *F %P

Toggle line numbers

A

Comment selected text

A

Uncomment selected text

X

Save changes and return

Search Box

{H
Search for Next Match

%

Search for Previous Match

Search hidden text

ah
Match case

m

Refactor text as method

*F
Refactor text as field

*P
Refactor text as property

Toggles Line numbers on/off.
Adds a comment to the beginning of
the current line or all selected lines.

Removes a comment (if present) from
the current line or all selected lines.

Saves changes and closes the current
edit window.

Enter search text and click one of the
following two buttons.

Locates the next occurrence of the
search text

Locates the previous occurrence of
the search.

Determines whether or not the search
examines collapsed blocks.

Specifies whether or not the search is
case-sensitive.

Inserts a Method template for the
selected name.

Inserts a Field template for the
selected name.

Inserts a Property template for the
selected name.
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The File Menu

Fix

Print...
Print Setup...

Properties

Exit {and Fix) Esc

Exit and discard changes Shift+Esc

The File menu illustrated above is displayed when editing a simple object and
provides the following options.

Fixes the object in the workspace, but leaves the edit
window open. Edit history is also preserved. If the data

Fi .
X has changed and the confirm_fix parameter is set, you

will be prompted to confirm.

Fix Script (Disabled unless editing a script)

. Opens an Edit window on the name under the mouse

Edit . .
pointer. (Disabled when not).

Print Prints the current contents of the edit window.

Print Setup

Displays the Print Configuration dialog box.

Properties

Displays the Object Properties dialog box for the
current object.

Exit (and Fix)

Fixes the object in the workspace and closes the edit
window. If the data has changed and the confirm_exit
parameter is set, you will be prompted to confirm.

Exit (and fix
script)

(Disabled unless editing a script)

changes

Exit and discard

Closes the edit window, but does not fix the object in
the workspace. If the data has changed and the
confirm_abort parameter is set, you will be prompted
to confirm.
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The File Menu (editing a script)

Fixx whole script
Fixx only Funckions

Print...
Print Setup...

Properties

Exit and fix whole script Esc
Exit and fix only Functions
Exit and discard changes  Shift+Esc

The File menu illustrated above is displayed when editing a script and provides the
following different options from those shown on the preceding page.

Fix whole script Fixes the entire script

Fix only functions | Fixes only the functions in the script.

Exit and fix whole

. Fixes the entire script, and exits the Editor.
script

Exit and fix only | Fixes only the functions in the script and exits the
functions Editor.

Editing Scripts

Suppose that you have a Class that manages a list of items in a shared Field, so some-
where in the script would appear a line such as:-

:Field shared public List«&

You run your application for a bit, and L i s t, which was initially empty, gets
updated as new instances of the Class are created. You then edit the Class to add a
new function, or fix a bug. In this instance, when you exit the editor you may not
want List to be reset back to the empty vector although you do want the new ver-
sion of the function(s) in the Class to be fixed.

Nevertheless whenever you edit the Class when it is not suspended, you probably
always want the entire script to be re-fixed, and L i st re-initialised.

The options in the File menu shown above provide for these alternatives.

In addition, the Configuration Dialog (see Installation & Configuration Guide: Con-
figuration Dialog: Trace/Edit Tab) allows you to define the behaviour of the key-
strokes <EP> and <S1> for both the suspended case and the non-suspended case.
This association will be displayed against the appropriate action according to the
state of the script you are editing.
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The Edit Menu

The Edit menu provides a means to execute those commands that are concerned with
editing text. The Edit menu and the actions it provides are described below.

Reformat kKeypad-slash
Zut Shift+Delete
Copy Ckrl+Insert
Paste Shift+Insert

Paste Unicode
Paste Mon-Unicode

lear Delete

open Line Ckrl+35hift+Insert
Delete Line Ckrl+Delete

Gota Line

Eird. ..

Replace...

Comment Selected Lines  Chrl+alk+,
Uncomment Selected Lines  Chrl+alk+,

Toggle Local Mame Ckrl+HUp
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Reformats the function body in the edit window, indenting

Reformat .
control structures as appropriate.
Undoes the last change made to the object. Repeated use of
Undo this command sequentially undoes each change made since
the edit window was opened.
Redo Re-applies the previous undone change. Repeated use of
this command sequentially restores every undone change.
Copies the selected text to the clipboard and removes it
Cut .
from the object.
Copy Copies the selected text to the clipboard.
Paste Copies the text in the clipboard into the object at the

current location of the input cursor.

Paste Unicode

Same as Paste, but gets the Unicode text from the clipboard
and converts to JAV

Paste Non- Same as Paste, but gets the ANSI text from the clipboard
Unicode and converts to [JAV.

Deletes the selection or the character under the cursor. Has
Clear .

no effect on the clipboard
Open Line Inserts a blank line immediately below the current one.

Delete Line

Deletes the current line.

Prompts for a line number, then positions the cursor on that

Goto Line line.

Find Displays the Find dialog box.

Replace Displays the Replace dialog box.

Comment Adds a comment symbol to the beginning of all selected

selected lines

lines.

UnComment
selected lines

Removes a comment symbol from the beginning of all
selected lines.

Toggle Local
name

Adds or removes the name under the cursor to/from the
function header line.

The Find and Replace items are used to display the Find dialog box and the
Find/Replace dialog box respectively. These boxes are used to perform search and
replace operations and are described later in this Chapter.
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Once displayed, each of the two dialog boxes remains on the screen until it is either
closed or replaced by the other. This is convenient if the same operations are to be
performed over and over again, and/or in several windows. Find and Find/Replace
operations are effective in the window that previously had the focus.

The Refactor Menu

Add text as Field
Add text as Properky
Add kext as Method

The Refactor menu illustrated above applies only when editing a Class and provides
the following options. In each case, the user must highlight a name in the Edit win-
dow, and then select one of these options to insert the appropriate template for that
name into the body of the Class.

Add text as Field Inserts a Field template for the selected name.

Add text as Property |Inserts a Property template for the selected name.

Add text as Method |Inserts a Method template for the selected text name.

The View Menu

Trace
W Stop
Monitor

Line Mumbers Mum -
v Funckion Line kMumbers

W Tree Yiew

v Ouklining
Expand all Cutlines
Zollapse All Dutlines
Expand all Dutlines below here
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The View menu, illustrated above, provides the following actions.

Displays a column to the left of the function that displays
Trace .
OTRACE settings
Displays a column to the left of the function that displays
Stop .
OSTOP settings
. Displays a column to the left of the function that displays
Monit .
onttor [OMONITOR settings
Line Toggles the display of line numbers on/off.
Numbers £g play ’
Function Toggles the display of line numbers on individual functions
Line on/off. This option is only enabled when editing a Class,
Numbers Namespace script or Interface.
Tree View |Toggles the display of the treeview in the left-hand pane.
Outlining Turns outlining on and off.
Expand All .
Outlines Expands all outlines.
1l All .
Co flpse Collapses all outlines
Outlines
Expand all
Outlines Expands all outlines below the level of the current line.
below here

Function Line Numbers

The Function Line Numbers option in the Editor menu provides an additional level
of line-numbering. If selected, line numbers are displayed independently on each indi-
vidual function (or operator) in the Class. This option is only enabled when you are
editing a Class, Namespace script or Interface, and is disabled for all other types of

object.

Note that function line-numbering and general line-numbering are independent
options and it is possible to have the entire Class numbered (from [0] to the number
oflines in the Class) in addition to having line-numbering on each individual func-

tion.
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The Window Menu

The Window menu provides a means to control the display of the various edit win-
dows. The Window menu and the actions it provides are described below.

Close Al Windows

Cascade
Tile

Arrange Icons

Editar
Debugger

Close All
Windows

Closes all the edit windows. If Confirm on Edit Window Closed is
checked, you will be prompted to confirm for any objects that you
have changed.

Cascade

Arranges the edit windows in overlapping fashion.

Tile

Arranges the edit windows in a tiling fashion.

Arrange
Icons

Arranges any minimised edit windows.

Editor

Allows you to Select the edit window corresponding to the
named object.
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Using the Editor

Creating a New Function

Type the name of your function and invoke the editor. To do this you may press
Shift+Enter, or select Edit from the Action menu, or double-click the left button on
your mouse, or click the Edit tool in the tool bar. A new window will appear on the
screen with the name you have chosen displayed in the top border. The name is also
inserted in the function header and the cursor positioned to the right. The new win-
dow is automatically given the input focus.

Line-Numbers onloff

Try changing the line numbers setting by clicking on the Line Numbers option in the
Options menu. Note that line-numbering on/off is effective for all edit windows.

Adding Lines

Ifthe keyboard is in Insert mode, pressing Enter at the end of a line opens you a new
blank line under the current one and positions the cursor there ready for input. You
can also open a new blank line by pressing Ctrl+Shift+Insert (OP).

Ifthe cursor is at the end of the last line in the function, pressing Enter adds another
line even if the keyboard is in Replace mode.

Indenting Text

Dyalog APL allows you to insert leading spaces in lines of a function and (unless the
AutoFormat parameter is set) preserves these spaces between editing sessions.
Embedded spaces are however discarded. You can enter spaces using the space bar or
the Tab key. Pressing Tab inserts spaces up to the next tab stop corresponding to the
value of the TabStops parameter. If the AutoIndent parameter is set, new lines are
automatically indented the same amount as the preceding line.

Reformatting

The RD command (which by default is mapped to Keypad-Slash) reformats a func-
tion according to your AutoFormat and TabStops settings. See Installation & Con-
figuration Guide: Configuration Dialog: Trace/Edit Tab.

Deleting Lines

To delete a block of lines, select them by dragging the mouse or using the keyboard
and then press Delete or select Clear from the Edit menu. A quick way to delete the
current line without selecting it first is to press Ctrl+Delete (DK) or select Delete
Line from the Edit menu.
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Copying Lines

Select the lines you wish to copy by dragging the mouse or using the keyboard. Then
press Ctrl+Insert or select Copy from the Edit menu. This action copies the selection
to the clipboard. Now position the input cursor where you wish to make the copy
and press Shift+Insert, or select Paste from the Edit menu. You can also use this
method to duplicate a ragged block of text.

To copy text using drag-and-drop editing:

1. Select the text you want to move.

2. Hold down the Ctrl key, point to the selected text and then press and hold
down the left mouse button. When the drag-and-drop pointer appears, drag
the cursor to a new location.

3. Release the mouse button to drop the text into place.

Moving Lines

Select the lines you wish to copy by dragging the mouse or using the keyboard. Then
press Shift+Delete or select Cut from the Edit menu. This action copies the selection
to the clipboard and removes it. Now position the input cursor at the new location
and press Shift+Insert, or select Paste from the Edit menu. You can also use this
method to move a ragged block of text.

To move text using drag-and-drop editing:

1. Select the text you want to move.

2. Point to the selected text and then press and hold down the left mouse but-
ton. When the drag-and-drop pointer appears, drag the cursor to a new loc-
ation.

3. Release the mouse button to drop the text into place.

Joining and Splitting Lines
To join a line to the previous one: select Insert mode; position the cursor on the first

character in the line; press Bksp.

To split a line: select Insert mode; position the cursor at the place you want it split;
press Return.

Toggling Localisation

The TL command (which by default is mapped to Ctrl+Up) toggles the localisation
of the name under the cursor. If the name is currently global, pressing Ctrl+Up causes
the name to be added to the list of locals in the function header. If the name is already
localised, pressing Ctrl+Alt+] removes it from the header.
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Aligning Comments

When you press the <AC> key, or select Align Comments in the Editor's context
menu, the alignment of the comments in every line in the function will be changed
so that the left-most comment (Lamp) symbol is in the same column as the cursor,
except that:

o Comment symbols that lie between the first column and the first tab stop
will remain in or be moved to the first column. For information on setting
tab stops, see Installation & Configuration Guide: Configuration Dialog
(Edit/Trace Tab).

e Comment symbols will not move further left than the end of the statement.

When a comment is re-aligned, text to the right of the left-most comment symbol
(including spaces and other comment symbols) will remain fixed in relation to that
symbol.

Note that there is no keystroke associated with this command by default; the user
must define one. See Installation & Configuration Guide: Configuration Dialog
(Keyboard Shortcuts Tab).

White Space in Source Code

Settings that impact the automatic reformatting of code can cause changes to
whitespace — this can be interpreted as changes to the source code. This means that:

e opening a scripted object in the Edit window can cause the source of that
object to change (when closing an Edit window, you might be prompted to
save a function even though you have not made any changes to it).

e viewing an object can change its file timestamp; source code management
systems can subsequently report changes due to the changed file timestamp.

e source code changes resulting from reformatting will be evident in the res-
ults of system functions such as JAT, OSRC, [OCR, VR and [INR.
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Outlining

When you are editing a function, outlining identifies the blocks of code within con-
trol structures, and allows you to collapse and expand these blocks so that you can
focus your attention on particular parts of the code

The picture below shows the result of opening the function JSE.cbtop.TB_
POPUP.

)ed OSE.cbtop.TB_POPUP

§ Editor - [2SE.cbtop.TB_POPUP] =JoEs
[ Ble Edit Refactor Window View -8 x
A A X v b & *m *F P

[0] I{FLAG}TB_POPUP M5G; TG

[1] fi Papup menu an Sessian ToolContral

[2] E :If 0=[0NC'FLAG'

[3] H :If (2=52MSG) m Right mouse button 7

(L] "popup.captions 'OWS'Checked' ShowCaptions

[5] "popup.list 'OWS'Checked' ('FlatList '=Stylel

(6] "popup.multiline OWS'Checked 'Multiline

[7] Opa ' popup’

al L *End

(9] iElse

[10] TC+'bandtbl.tb' 'bandtb2.tb' 'bandtb3.tb' 'bandtbl.th’
(1] & 1Select FLAG

(121 tCase 1

[13] ShowCaptions+~ShowCaptions

[14] TC OWS"='ShowGaptions'ShowCaptions

[15] iCase 2

[16] Stylec(1+'FlatList '=Stylel2'Flatlist' 'FlatButtans'
[171] TC OWS™='Style'Style

(18] tCasze 3

[19] Multiline+~Multiline

[20] TC OWS™='Multiline ' Multiline

[21]

[2z1 | tEnd

[23] | :End

Funiction Last saved by: Dyadic: 29 October 1998 17:15 Pios: 0f24,1

Notice that the various control structure blocks are delineated by a treeview diagram.
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e When you hover the mouse pointer over one of the boxes that mark the
start of a block, the line marking the extent of that block becomes high-
lighted, as shown above.

e Ifyou click on a [l box, the corresponding section collapses, so that only
the first line of the block is displayed, as shown below.

e Ifyou click on a l*! box, the corresponding section is expanded.

S Editor - [oSE.cbtop. TB_POPUP] =Jotd
BbAile Edit Refactor Window Yiew -8 x
1A A X v |6 84 *m *F *p

[o] I{FLAG}TB_POPUP MSGE:TE

[1] fi Popup menu on Session ToolControl

[2] [ :If 0=0ONC'FLAB'

[3] @] tIf [2=52M5G) A Right mouze button 7]

[91] tElsze

[10] TC+'bandtbl.tb' 'bandtb2.tb' 'bandtb3.tb’' 'bandtbb.tb’
[111 :Select FLAG

[12] iCasze 1

[13] ShowCaptions+~ShowCaptians

[14] TC OWS"c'ShowCaptions ' ShowCaptions

[15] iCaze 2

[16] Style«(1+'FlatList '=Stylel='FlatList' 'FlatButtons'
[17] TC OWS™c'Style'Style

[18] :Caze 3

[19] MultiLinet~MultiLine

[20] TC OWS"c'Multiline ' MultilLine

[21]

[22] | :End

[231 [ :End

Function Lask saved by Dvadic: 29 Ockober 1998 17115 Pos: 0fz24,1
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Sections

Functions and scripted objects (classes, namespaces etc.) can be subdivided into Sec-
tions with :Section and :EndSection statements. Both statements may be fol-
lowed by an optional and arbitrary name or description. The purpose is to split the
function up into sections that you can open and close in the Editor, thereby aiding
readability and code management. Sections have no effect on the execution of the
code, but must follow the nesting rules of other control structures.

The following picture illustrates the use of sections in a function called
DumpWindow. The function is divided into 5 sections named Comments, Init,
NAs, MakeBitmapand CopyToClipBoard.

The first picture shows the function with all sections closed.

5 Editor - [DumpWindow] M=%

J Bile Edit Refactor Window  Yiew -8 x
1A A X ~|dh 4h *m *F *P

[0] Dumpkindow ref:0OI0;0OML

[1] tSection Comments I

[&] tSection Init

[10] tSection MAs

[25] tSection MakeBitmap

[37] [# :Section CopyTaClipBoard

< 2]
Maodified Funckion Pete: 17/12/2010 Pos: 1/44,28
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The next picture shows the effect of opening the Comments section. Notice how this
is delineated by the statements:

:Section Comments

:EndSection Comments

1 Editor - [DumpWindow] =JoEd
[P Ble Edt Refactor Window View -8 x
A A X v b 4% *m *F °P

[0] DumpWindow ref;OI0;0OML

[1] :Section Comments

[2] f eg DumpWindow f A note unquoted name

[3] fi Mote only the visible part of the window is dumped

(L] fi you may need to set 'OnTop' to ensure total window visibility
[5] tEndSection Comments

[6] iSection Init

[10] tfection NAs

[25] tfection MakeBitmap

[37]¢ iH:Sectiaon CopyTollipBoard

< 2]
Madified Function Last sawved by: Pete: 17 December 2010 14:52 Pos: Of44,0

And with the Init section opened too:

§ Editor - [DumpWindow] =JoEd
S Fle Edt Refactor indow Yiew R
1A A X ~|o8 4 m*F

[0] DumpWindow ref:;OI0:0OML

[1] [ :Zection Comments

[2] A eg DumpWindow f A note unquoted name

[3] A Note only the visible part of the window iz dumped

(L] A you may need to set 'OnTop' to ensure total window visibility

[5] L :EndSection Comments

(6] E :Section Init

(71 OML OI0<0

[g8] OSHADOWS (= ref ") ~=" "~ LOREF 32051

[9] | :EndSectior|

[10] iSection Mas

[25] iSection MakeBitmap

[37] [:Section CopyToClipBoard

<] 2]
Modified Function Last saved by: Pete: 17 December 2010 14:52 Pos: 944,12
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Finally, with all the sections opened:

F =
P Editor - [DumpWindow] M=)
Jp Ele Edt Refactor Window View -8 x
¢l A A X v |6 4 *m *F *p

[o] Dumphindow ref;0OI0:0OML -
[1] [ :3ection Comments

[2] A &g DumpWindow f A note unquoted name

[3] A Mote only the visible part of the window iz dumped

[u] fi you may need to set 'OnTop' to ensure total window wisibilie
[5] L :EndSection Comments

[6] E :Section Init

[7] OML OI0«0

[a] OSHADOWT (=" ref " )~=" "~~"JOREFS=0S1

[9] | :EndSection

[10] El :Section MAs

[11] OWA' UL user32|GetWindowdl UL »
[12] ONA'UL user3?|GetWindowRect Ub ={UL UL UL ULt 3
[13] OWA' U4 user32|ReleaseDC UL UL »
[14] OWA' UL user32|0penClipboard UL 3
[15] OWA' U4 user32|EmptyClipboard 3
[16] OWA' UL user32|SetClipboardbata UL Uy 3
[17] OWA' UL user32|CloseClipboard 3
[18] OMA'UL  gdi32|CreateCompatibleDl UL >
[19] OMA'U4  gdi32|CreateCompatibleBitmap Uk UL UL 3
[20] OMA'UY  gdi32|SelectObject UL Lk .
[21] OMA'UL  gdi32|DeleteDl UL -
[22] OMA'UL  gdi32|DeletelObject Uk 3
[23] OWA'Us  gdi32|BitBlt U U Ub U U U U Uy e
[24] | :EndSection NAs

[25] [ :Section MakeBitmap

[26] hwnd+ref .OWE"Handle'

[27] hdetGetWindowDC hwnd

[28] szet-—/82 2plaGetWindowRect hund(bpl)

[29] mdc+CreateCompatibleDC hdc

[30] hbm+CreateCompatibleBitmap hdc,sze

[21] old+SelectObject mdc hbm

[32] jnk<BitBlt mdc O O,zze,hdc 0 0 13369676 m SRCCPY

[33] jnk+SelectObject mdc old

[3L4] jnk+ReleaseDl hdc 0

[35] jnktDeleteDl mdc

[36] L :EndSection MakeBitmap

[37] tSection CopyToblipBaoard

[2a1 ink<Onenflinhnard 0 had
< >
Modified Function Last saved by Pete: 17 December 2010 14:52 Pos: 9/44,12
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Editing Classes

The picture below shows the result of opening the ComponentF i Le class. Notice
how each function is delineated separately and that each function is individually

line-numbered.

)ed ComponentFile

5 Editor - [ComponentFile]

Fp File Edt Refactor window Yiew -8 x
1 A A X v 6 84 *m *F *p
= [ED #. ComponentFil I:Elass ComponentFile ”~
5% [Constructor & tField Private Instance tie ]
o’ [DEns] & tField Private instance temp<0 A Tew
& 1l
+£FI[F1E]E|S] [0] = % Open filename
& a.:l [Methods] [1] f Open MNamed File
* 3{:' [Nested Clas) o] :Implements Constructor
#3 [Nested MName| [[3] tAccess Public Instance
+-3°0 [Properties]| |[4]
149 [Sections] [5] = :Trap 0
[&] tie+filename OFSTIE 0
[7] tElze
[8] OFUNTIE filename OFCREATE O naw |
[9] tiecfilename OFSTIE 0 i3
[10] tEndTrap
[11] v
[o] =] ® OpenTemp:OUSING: =
[1] fi Default: Open temporary file
[2] :Implements Constructor
[3] tAccess Public Instance
[4]
[5] OUSIHG+""
[6] z+System. [0.Path.GetTempFileName
[7] z OMERASE z OWTIE O A Erase the t®
[a] tie+z OFCREATE 0O
[3] temp+1
[10] v
[0] 7 Clase
[1] tImplements Destructor
[2] tIf tieeOFMUME
[3] :If temp ¢ Name OFERASE tie
[4] tElze ¢ OFUNTIE tie
[5] tEndIf
[&] tEndIf
[7] v |
<] 2 J< (2
Class Pos: 0/111,0
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The outlining feature really comes into its own when editing classes because you can
collapse and expand whole functions. The picture below shows the effect of col-
lapsing all but the Append method.

5 Editor - [ComponentFile] E]@
b File Edt Refactor window View -9 %
FR A X [v|6b & m*F %P
= ED #.ComponentFile kclass ComponentFile
@& [Constructars] & iField Private Instance tie
wa™ [Dfns] & tField Private instance temp<( ®
wal [Fields] ,
[+] 0 fil
@Y [Methods] [+ ¥ Open filename
Cl
®-81 [NESth E]EISSES] 7 0|:|enTem|:|;|:|USING:2
@& [Nested Namespaces
wm & [Properties] 7 Close
w3 [Sections]
fi --- Instance Methods ---
[o] v rAppend data
[1] tAccess Public Instance
[2] r+data OFAPPEND tie
[3] v
7 Rename name
v Replacelcomp datal
A --- Instance Properties ---
tProperty Mame
:Property Count
:Property Access
tProperty Mumbered Default Com e
fi —-- 3hared Members
v Delete fileitie
tEndClass A Class ComponentFile
(<] I RN Im | (2]
Class Pios; 04111,0
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When you edit a class, a separate treeview is optionally displayed in the left pane to
make it easy to navigate within the class. When you click on a name in the treeview,
the editor automatically scrolls the appropriate section into view (if necessary) and
positions the edit cursor at its start. The picture below illustrates the result of opening
the [Methods ] section and then clicking on Rename.

5 Editor - [ComponentFile]

BEX

F Pl Edt Refactor window View -3 %
1 A A X | 4B 40 'm *F P
= [EJ 4. ComponentFile (91 L temp+l |
59 [Constructors] [1o] v
+ Sfil [DFnS]
5% [Fields] [o] 7 Close
S %1 [Methods] [1] :Implnlaments Destructor
[2] If tiesOFHUMS
£] Append (3] t1f temp © Name LFERAS »
£]Close [u] iElse ¢ OFUNTIE tie
| Delete (5] tEndIf
a Rename (6] tEndIf
B Replace [7] v
+-%°1 [Nested Classzes]
5 &9 [Hested Namespaces i -== Instance Msthods ---
& i
* Sf:l [F‘ropnlarhes] [0] = 7 r+Append data
#30 [Sections] [1] tAccess Public Instance
[z1 r<data OFAPPEND tie
[zl L 7
(o] = 7 Rename name
[1] tAccess Public Instance
[21 name OFREMAME tie
[3] L 7
[o] =] 7 Replacelcomp data)
[1] tAccess Public Instance
[z2] data OFREPLACE tie,camp
[3] L 7
A --- Instance Properties —-®
tProperty Name
tAccess Public Instance
[o] ¥ r+get
[1] If tieeOFNUMS < p<0OFN »
[21 tElze ¢ r«'' © :EndIf
[3] v i
- tFndPranertw . .-v-
Class Pos: 45/111,0
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Sections within Scripts

Scripts can also be subdivided into Sections using : Sectionand :EndSection
statements. As with single functions, the purpose is only to split the script up into sec-
tions that you can open and close in the Editor. Sections have no effect on the exe-

cution of the code.

The following picture illustrates a Class named actuarial which, for editing pur-
poses, has been sub-divided into five separate Sections named Main,
MenuHandlers,Validation,Utilities and OldCode. In this picture, all

the Sections are closed.

5P Editor - [actuarial]

ﬁﬁile Edit Refactor Window Wiew

A A X

- 46 84 | m *F P
[ |

BELX

- #.actuarial
+.#" [Constructors]
+.85 [Dfns]
w48 [Fields]
¥ [Methods]
+#% [Nested Classzes]
+-#% [Nested Mamespaces]
+-%% [Properties]
S.4% [Sectians]
T Main
T MenuHandlers
F oldtode
B outilities
f

Yalidation

F

Class

iClass
tlUszing
ilUsing
tUsing
tlUszing
tUsing

HEHEHEMH

tAccess Public

tSection Main

:Zection MenuHandlers

tZection Yalidation

tSection Utilities

iSection OldCode
tEndClass

actuarial: Page

System

System.Web Ul,system.web.dll
System.Web.UI.HtmlControls
System.Web.Ul.Weblontrols
System.Data,system.data.dll

Pos: 0f1504,0
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The next picture shows the effect of opening just the Mai n section.

5 Editor - [actuarial]

LA A X

ﬁ File Edit Refactor Window iew

~| 46 4 | *m *F TP
[ |

+

+

+

F

F

+

+

- [0 #. actuarial

#® [Constructors]
#%1 [Dfns]
&1 [Fislds]
g% [Methads]
#*) [Hested Classes]
%% [Mested Mamespaces]
%% [Properties]
g¥ [Sectiong]
T Main
T MenuHandlers
B oldCode
B Utilities
i

Validation

Maodified Class

tClass actuarial: Page

tlsing System

ilsing System.Web. Ul system.web.dl |
tlUsing System.Web. Ul .HtmlControls
tlUsing System.Web. Ul . WebControls
tlsing System.Data,system.data.dl|
tAccess Public

tSection Main
7 Page_Load; INT;AGE; DUR: TERM: TAE_DUR®
v CALC_FSLTAB_RESULTS(abj ewl:X:ULT:w
7 CALC_FSL_RESULTSCobji ew):®;CHANGE;w
tEndSection Main
tS3ection MenuHandlers
tsection Yalidation
tSection Utilities
t3ection OldCode

tEndClass

[(+H+H+H1]

HEEFHEF

Pos: 445/1500,7

Notice that this section is delimited by the two statements:

:Section Main

:EndSection Main

In this picture the 3 functions within the Mai n section are temporarily closed.

Similarly, the section called Val idation is delimited by:

:Section Validation

:EndSection Validation
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5 Editor - [actuarial]

A A X

@Eile Edit Refactor Window View

| ob & | *m *F %P

+

T

+

+

S ED #.actuarial

#%1 [Constructors]
% [Dfns]
% [Fields]
% [Methods]
#% [Nested Classes]
%Y [Nested Mamespaces]
ity [Froperties]
%1 [Sections]

T Main

F MenuHandlers

F oldtode
Foutilities
i

Yalidation

Modified Class

[o]
[1]
[2]
[3]
[4]
[5]
[6]
[7]
[a]
[a]
[10]

[o]
[1]
[2]
[2]
[4]
[5]

reci

—HMH

iflazs actuarial: Page

tlsing System

tUsing System.Web.Ul,system.web.dl|
itlUsing System.Web.UI.HtmlControls
tUsing System.Web.UI.WebControls
tUsing System.Data,system.data.dl!
tAccess Public

tSection Main
tSection MenuHandlers
:Zection Validation

7 WALIDATE_AGE(source args) A Yal »

tAccess Public
t3ignature YALIDATE_AGE Object
tTrap 0

-

AGE+Convert.Tolnt32 args.Wa »

tElse
args. [s¥alid«0
iReturn
tEndTrap
args. IsYalide(10<AGE) ~BOzAGE
7

7 VYALIDATE_DUR(zcurce args):DT A
tAccess Public
:Signature YALIDATE_DUR Object
tIf 2=GET_RUN_QOPTION
bT+1
tElze

RT. A 4 TA TRY Aol

Pos: 0f1500,0

-

-
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Find and Replace Dialogs

The Find and Find/Replace dialog boxes are used to locate and modify text in an
Edit window.

Find / Replace
Search Faor: | j Find fext |
Feplace with: | j Replace
v Match Caze [ Match W hole 'Woard heeael]

[ Use Regular Expreszions 4
Direction
v Autokdove Llose
" Up " Down
Enter the text string that you want to find. Note that the
text from the last 10 searches is available from the drop-
Search For down list. If appropriate, the search text is copied from the

Find Objects tool. This makes it easy to first search for
functions containing a particular string, and then to locate
the string in the functions.

Enter the text string that you want to use as a replacement.
Replace With | Note that the text from the last 10 replacements is available
from the drop-down list.

Match Case Check this box if you want the search to be case-sensitive.

Match Whole | Check this box if you want the search to only match whole
Word words.

Use Regular Check this box if you want to use various wild card
Expressions symbols.

If checked, the Find or Find/Replace dialog box will
AutoMove automatically position itself so as not to obscure a matched

search string in the edit window.

Direction Select Up or Down to control the direction of search.
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Using Find and Replace

Find and Replace work on the concept of a current search string and a current
replace string which are entered using the Find and Find/Replace Dialog boxes.
These boxes also contain buttons for performing search/replace operations.

Suppose that you want to search through a function for references to the string
"Adam". It is probably best to work from the start of the function, so first position the
cursor there (by pressing Ctrl+Home). Then select Find from the Edit menu. The Find
Dialog box will appear on your screen with the input cursor positioned in the edit
box awaiting your input. Type "Adam" and click the Find Next button (or press
Return), and the cursor will locate the first occurrence. Clicking Find Next again will
locate the second occurrence. You can change the direction of the search by select-
ing Up instead of Down. You could search another function for "Adam" by opening
anew Edit window for it and clicking Find Next. You do not have to redefine the
search string.

Now let us suppose that you wish to replace all occurrences of "Adam" with
"Amanda". First select Replace from the Edit menu. This will cause the Find Dialog
box to be replaced by the Find/Replace Dialog box. Enter the string "Amanda" into
the box labelled Replace With, then click Replace All. All occurrences of "Adam" in
the current Edit window are changed to "Amanda". To repeat the same global change
in another function, simply open an edit window and click Replace All again. If
instead you only want to change particular instances of "Adam" to "Amanda" you
may use Find Next to locate the ones you want, and then Replace to make each indi-
vidual alteration.

Saving and Quitting

To save the function and terminate the edit, press Esc (EP) or select Exit from the File
menu. The new version of the function replaces the previous one (if any) and the edit
window is destroyed.

Alternatively, you can select Fix from the File menu. This fixes the new version of
the function in the workspace, but leaves the edit window open. Note that the his-
tory is also retained, so you can subsequently undo some changes and fix the func-
tion again.

To abandon the edit, press Shift+Esc (QT) or select Abort from the File menu. This
destroys the edit window but does not fix the function. The previous version (if any)
is unchanged.
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The Tracer

The Tracer is a visual debugging aid that allows you to step through an application
line by line. During a Trace you can track the path taken through your code, display
variables in edit windows and watch them change, skip forwards and backwards in a
function. You can cutback the stack to a calling function and use the Session and
Editor to experiment with and correct your code. The Tracer may be invoked in sev-
eral ways as discussed below.

Tracing an expression

Firstly, you may explicitly trace a function (strictly an expression) by typing an
expression then pressing Ctrl+Enter (TC) or by selecting Trace from the Action
menu. This lets you step through the execution of an expression from the beginning.

In the same way as when you execute a statement by pressing Enter, the expression is
(if necessary) copied down to the input line and then executed. However, if the
expression includes a reference to an unlocked defined function or operator, exe-
cution halts at its first line and a Trace window containing the suspended function or
operator is displayed on the screen. The cursor is positioned to the left of the first line
which is highlighted.

Naked Trace

The second way to invoke the Tracer is when you have a suspended function in the
State Indicator and you press Ctrl+Enter (TC) on the empty input line. This is termed
naked trace. The same thing can be achieved by selecting Trace from the Action
menu on the Session Window or by clicking the Trace button in the Trace Tools.
However, in ALL cases it is essential that the input cursor is on the empty Input line
in the Session.

The effect of naked trace is to open the Tracer and to position the cursor on the cur-
rently suspended line. It is exactly as if you had Traced to that point from the Input
Line expression whose execution caused the suspension.

Automatic Trace

The third way to invoke the Tracer is to have the system do it automatically for you
whenever an error occurs. This is achieved by setting the Show trace stack on error
option in the Trace/Edit tab of the Configuration dialog (Trace_on_error para-
meter). When an error occurs, the system will automatically deploy the Tracer. Note
that this means that when an error occurs, the Trace window will then receive the
input focus and not the Session window.
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Tracer Options

From Version 10.1 onwards, the Tracer is designed to be docked in the Session win-
dow.

In previous versions of Dyalog APL, the Tracer was implemented as a stack of sep-
arate windows (one per function on the calling stack) or as a single, but still separate,
window.

You can disable the standard behaviour by selecting Classic Dyalog mode from the
Trace/Edit tab of the Configuration dialog box.

If you do so, you may then choose to have the Tracer operate in multiple windows or
in a single window.

These alternatives are discussed later in this Chapter.
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The Trace Window

The Tracer is implemented as a single dockable window that displays the function
that is currently being executed. There are two subsidiary information windows
which are also fully dockable. The first of these (SIStack) displays the current func-
tion calling stack; the second (Threads) displays a list of running threads.

In the default Session files, the Tracer is docked along the bottom edge of the Session
window. When you invoke the Tracer, it springs up as illustrated below. In this
example, the function being traced is [JSE . UCMD, which is invoked by typing a user-
command, in this case Jdisplay.

5 CLEAR WS (cSE)- Dyalog APLAW [ =13
Tools  Wiew

fws D D8 bl 3] icbiec B B Ss V B lw B2 B 13 (Too @ G [ W Ede By B o o« Session
Language Bar Zlelx| ﬂ
l|||\|||E|||||||f|l\||||¢||||||¢|||||||T|*|||U|4>|1’|||||||||f’|\|"\*|-iJ

Dyalog APL/W Yersion 12.1.0
Serial No @ 0000LZ
Unicode Editiaon
Mon Aug 17 10:28:20 2009
clear ws

Tdisplay 113

i

Debugger =lalx|
3 T M D ’ D Z X ﬂ [E=] ﬂ UCMD[1]+m User Command Processor.
o
[0] ar+{THIS}UCMD Input il
[1] /i User Command Processor.
[2] A Spice is used, see documentation for d »
[2]
[4] +(Input~.=" '1/0 A do nothing?
[5] =
[6] 'SALT needs to be enabled OSIGNAL 11p%9 » | =
[71 ar<0SE.SALTUti1s.Spice Input &
x
. 1l = 5
ksl B =
Function johnd: 11/0&/... Pos: 1§80 =] w
¢ Ready... Ins NUM
C Curdbj: &1 Opg:o  OTRAP  OSI:1  OIO0:1  [OML:0

In the default layout, the Sistack window is displayed alongside the main Tracer win-
dow, although this can be hidden or made to appear as a separate floating window, as
required.
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Trace Tools

The Tracer may be controlled from the keyboard, or by using the Trace Tools which
are arranged along the title bar of the Debugger window. Note that the button names
are solely for reference purposes in the description that follows.

Key

Button Name Code Keystroke Description
;_/b Exec ER  Enter Executes the current line
3 Trace TC Ctrl+Enter Traces execution of the current
line
4 Back BK  Ctrl+Shifi+Bksp Skips back one line
M Fwd FD  Ctrl+Shift+Enter Skips forward one line
> Restart RM -{JLC Restarts execution of the current
thread, closing all its trace
windows
[> Restart all Restarts execution for all threads,
closing all trace windows
> Continue BH Continues execution of the
current thread, leaving Trace
windows displayed
= Edit ED  Shift+Enter Invokes the Editor
¢ Exit EP Esc Closes the Trace window, exits
the current function
T) Intr Ctrl+Pause Interrupts execution
ﬂ Reset CB Clears all break-points (resets

OSTOP on every function)
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Using the Trace Tools, you can single-step through the function or operator by click-
ing the Exec and/or Trace buttons. If you click Exec the current line of the function
or operator is executed and the system halts at the next line. If you click Trace, the
current line is executed but any defined functions or operators referenced on that line
are themselves traced. After execution of the line the system again halts at the next
one. Using the keyboard, the same effect can be achieved by pressing Enter or
Ctrl+Enter.

The illustration below shows the state of execution having clicked Exec 6 times to
reach JSE.UCMD[7].

£ CLEAR WS (oSE)- Dyalog APLAW (=1
Tools  Wiew

ws D E obe: BEE YV B B Bk Tl @G W e By B o cu Session
Language Bar Zlelx| ﬁ
l|||\|||E|||||||f|l\||||¢||||||?‘||||||||||||3|4>|“?|||||||||f|\|\|-'-fE

Dyalog APL/W Yersion 12.1.0
Serial No @ 0000LZ
Unicode Editiaon
Mon Aug 17 10:28:20 2009
clear ws

Jdisplay 113

e

Debugger =lal=|
STUMN D P PEXTHN ﬂ UCMDL[7]+4r+OSE. SALTUt i 1s.Spice Inp
o
[o] ar+{THIS}UCMD Input |
[1] A User Command Processor.
[2] A Spice is used, see documentation for d
[2]
[u] +(Input~.=' '1/0 A do nothing?
[5] —
[6] 'SALT needs to be enabled'DSIGNAL 11p%3 » | =
[7] [&r+OSE.SALTUtils.Spice Input =
=
L {| = 5
il EA =
Function johnd: 11/08/... Pos: 7j5,0 L] <] 3| W
 Ready... Ins  MUM
© Curdbj: a1 Op@:0 | OTRAP  OSI:1  QOI0:1  [ML:O

Execution Reached [JSE . UCMD[ 7]

The next illustration shows the result of clicking Trace at this point. This caused the
system to trace into [JSE . SaltUti ls.Spice, the function called from
OSE.UCMD[71].

Notice how each function call on the stack is represented by an item in the Sistack
window.
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55 CLEAR WS (sSE.SALTUtils)- Dyalog APLAW =JoEd
Tools  iew
fws @ OF bl 3] iobjec BBV Es V B bk B2 B B3 Tool @ GY [ M Edt By @ v o Session
Language Bar Hax | =

o|
l\IIIIIIEIII||\llfllll|||¢||||||¢|||||||+|+|||D|4>|1’||||||||\f’|\|*‘|*|- o
Dyalog APL/W Yersion 12.1.0
Serial Mo & 0000LZ
Unicode Edition
Mon Aug 17 10:28:20 2009
clear ws
ldisplay 113

B

Debugger ~=lolx|
ST MM P PEXI - x| Spicell]l#m Handle KeyPress in SPIC
[28] a - ﬂ UCMDL 7] ar<0SE.SALTUti1s.3pice Inp
[29] Lv =
[0] 7 {R}<Spice msgicmdiarg:listiiscifinm
[1] A Handle KeyPress in SFICE command w *
[2] A The function can also be used dire —
21 ReT1 =
[u] tIf ~Quiet<isChar cmd<msg now E
[51] +04%"ER '=32msg A Ente w |
el crade' T e lhi1ameal FWE " Tavt ' A oarahoel® | D P
< > e =
Function johnd: 11/08f... Pos: 40/960,0 i ( | W
Ready... Ins  HUM

CurObj: &:1 OpQ:0  OTRAP | OSI:2  0OIO:=1  [OML:3

Execution Reached JSE.SALTUtils.Spice [1]
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The illustration below shows the state of execution having traced deeper into the sys-
tem.

S CLEAR WS (5SE.SALT)- Dyalog APLAY [ =13

File Edit Wew Windows 3Session Log Action ©Options Tools Threads Help

fws D 08 bl 3] icbec BB S V B b B B I3 (Too @ G [ W Ede By B o o« Session

Language Bar EJEE] ﬁ
[[-[<[e[le[Ble[ 7] (MMLs]] [Fll<lel=le] [-P] [HH=R0f [ve]ln]=[] [N 2
ldisplay 1.3 ”~
Isi b |

OSE.SALT.Load[11+
OSE.SALTUti1s.BootSpicel17]
OSE. SALTUti1s.Spice[18]
OSE.UCMD[7]

]
Debugger =lalx|

3%’« 44 D ’ D Z X ﬂ [E=] Load[1]+:Access Shared Public
[16] LPEF*‘ﬂ.DNEH(LDad cmd) , hasargs/cargs — Boot3pice[17] OSE.SALT.Load SALTYP

L-lolx

[171] ) b | Spice[18] :If 0=0ONC'OSE.cbbot.band
= UCMDL 7] ar+0SE.SALTUti1s.5pice Inp
[0] 7 {reF}+{protect}Load clazs:filesaThA »
[1] fAccess shared Public
[2] A This function returns either a ref » —
[3] fi or a message for anything else (fa® =
[u] :If isHelp class E
[5] ref<'Load [pathlclassname’ '' 'Load » | 7
ral raf.e'' 'Madifiere:’ b = =
> = =
Mamespace Pos: 118/872,0 g 3| W
¢ Ready... Ins NUM
C Curdbj: &1 OpQ: o OTRAP | OSI:4 | OIO:1 | [OML:2

Execution reached four levels deep

At this stage, the State Indicator is as follows:

)SI
OSE.SALT.Load[1]=*
0OSE.SALTUtils.BootSpice[17]
OSE.SALTUtils.Spice[18]
OSE.UCMD[ 7]
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Controlling Execution

The point of execution may be moved by clicking the Back and Fwd buttons in the
Trace Tools window or, using the keyboard, by pressing Ctrl+Shift+Bksp and
Ctrl+Shift+Enter. Notice however that these buttons do not themselves change the
State Indicator or the display in the SIStack window. This happens only when you
restart execution from the new point.

You can cut back the stack by clicking the <EP> button in the Trace Tools window.
This causes execution to be suspended at the start of the line which was previously
traced. The same effect can be achieved using the keyboard by pressing Esc. It can
also be done by selecting Exit from the File menu on the Trace Window or by select-
ing Close from its system menu.

The <RM> button removes the Trace window and resumes execution. The same is
achieved by the expression ~[JL C. The <BH> button also continues execution, but
leaves the Trace window displayed and allows you to watch its progress.

Using the Session and the Editor

Whilst using the Tracer you can skip to the Session or to any Edit window and back
again. While it is docked, you may resize the Tracer pane by dragging its title bar,
and you may use the buttons provided to maximise, minimise and restore the Tracer
pane within the Session window.

Unless you move it, the cursor is positioned to the left of the suspended line in the
top Trace window.

Depending where the cursor is in the tracer window, pressing Shift+Enter (ED) or
selecting Edit from the File menu may cause an edit window to open. If the cursor is
in the first column of the Trace window, or on whitespace, the Editor is opened on
function or operator on top of the stack. If the cursor in on a name, the Editor is
opened on the name under the cursor (point-and-edit). With the cursor in any other
location, no action is undertaken.

When you finish editing, the window reverts to a trace window with the new defin-
ition of the function or operator displayed.

You may also open a new edit window from within the Tracer using point-and-edit.

You can copy text from a trace window to the session for editing and execution or
for experimentation.

It is possible to skip from the Tracer to the Session and then re-invoke the Tracer on a
different expression.
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Setting Break-Points

Break-points are defined by JSTOP and may be toggled on and off in an Edit or
Trace window by clicking in the appropriate column. The example below illustrates
a function with a [JSTOP break-point set on line [5].

7 Editor - [BUILD_SESSION] (=1
[ Fle Edit Refactor Window View _ 3 %
1A A X ~|d8 dh *m *F *p

[o] I {FILE}EBUILD SESSION LANG:OBJ;MSG:DIO;DML:OLD;NEH:MOTIFI'_Al
[1] A Build the zeszion object and save if deszired L)
[21 :If O=0OMC'HoPrompt' ¢ NoPrompt«d < :EndIf

[21] :If O=0ONC'FILE' ¢ FILE+'' ¢ :EndIf

[u]

[5] L] OW¥+05E.OW¥+1 < OML OI0+1 < OPATH+'#.Trans'

(6] OPW+122 A allows room for Status Bar

[7] MOTIF<'M'=3=2t+", "OWG 'APLYerzion'

[&8] W12+12<2o0YFI{ (T 1+w . "1 tw}2ot

[3] LANG+upCase, LANG A translation assumes uppercase

[10] UWICODE<«E0=0DR" '

[11] "Unkonwn language 'OSIGMAL(Trans.CODESe™cLANGY L1 |
a B
Modified Funckion Lask sawed by: Danb: 19 May 2009 11:42 Pos: 0J207,0

[STOP break-points set or cleared in an Edit window are not established until the
function is fixed. JSTOP break-points set or cleared in a Trace window are estab-
lished immediately.

Clearing All Break-Points
i

You can clear all break-points by pressing the above button in the Trace Tools win-
dow. This in fact resets [JSTOP for all functions in the workspace.
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The Classic mode Tracer

If you select Classic Dyalog mode from the Trace/Edit tab in the Configuration dia-
log box, the Tracer behaves in the same way as in Dyalog APL Version 8.2.
However, the Tracer is not dockable in the Session.

Ifyou select the Classic mode Tracer, you may choose between multiple trace win-
dows or a single trace window using the Single Trace Window option.

Multiple Trace Windows

The following behaviour is obtained by deselecting the Single Trace Window
option.

Each function on the SI stack is represented by a separate trace window.
The top window contains the function that is currently executing, other win-
dows display functions further up the stack, in the order in which they were
called.

When you press Ctrl+Enter or click the Trace button on a line that calls
another function, a new trace window appears on top of the stack and dis-
plays the newly called function.

When a function exits, its trace window disappears and the focus moves to
the previous trace window. When the last function in a traced suspension
exits, the last trace window disappears.

If you click the Quit this function button in the Trace Tools window, or
press Escape, or close the trace window by clicking on its [X] button or typ-
ing Alt-F4, the top trace window disappears and the focus moves to the pre-
vious trace window

If you close any of the trace windows further down the stack, the stack will
be cut back to the corresponding point, i.e. to the line of code that called
the function whose trace window you closed.

The <RM> button removes all the trace windows and resumes execution.
The same is achieved by the expression »{JLC. The <CS> button also con-
tinues execution, but leaves the trace windows displayed and allows you to
watch their progress.

If you minimise any of the trace windows, the entire stack is minimised to a
single icon, from which it may be restored.
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Single Trace Window

The following behaviour is obtained by selecting the Single Trace Window option.

The trace window contains a combo box whose drop-down displays the con-
tents of the SI stack. This box is not provided if there are multiple trace win-
dows.

The trace window is re-used when tracing into, or returning from, a called
function. This means that there is never more than one trace window
present.

When the last function in a traced suspension exits, the trace window dis-
appears.

If you click the Quit this function button in the Trace Tools window, or
press Escape, the current function is removed from the stack and the trace
window reused to display the calling function if there is one.

Closing the trace window by clicking on its [X] button or typing Alt-F4
removes the window and clears the current suspension. It is equivalent to
typing naked branch (=) in the session window.

If you move or resize the trace window, APL remembers its position, so that
it reappears in the same position when next used.
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The Threads Tool

The Threads Tool is used to monitor and debug multi-threaded applications. To dis-
play the Threads Tool, select Show Threads Tool from the Session Threads menu, or
Threads from the Session pop-up menu.

ﬁThreads E]@
Tid Location State Flags | Treq ||| 2 [1002,
0: Run =AUMCA3] OTGET... Session Mormal ﬂ g
1: GUI SHOWCZZ2] ODR*F* aog Paused
2: Lift 1 GOTOC10] ODL 0.2 ODL Paused :

d: Lift 2 GOTOC10] ODL 0.2 ODL Paused =
5: HMan § PERZOWNC?] OTG... OTGET... Paused G52 =
G: Lady & PERSOWCY] OTG... OTGET... Paused 12 =
7: Han 7 PERSOWC4] Lif... OTGET... Paused 2 E
B: Lady B PERS0OMC4] Lif... OTGET... Paused 2 =
3 2l =

The above picture illustrates a situation using the LIFT.DWS workspace after execut-
ing the function RUN. The Pause on Error option was enabled and a Stop was set on
RUN[63]. When RUN suspended at this point, all other threads (1-8) were auto-
matically Paused. Note that all other threads happen to be Paused in the middle of
calls to system functions

The columns of the Threads Tool display the following information.

Column Description

Tid The Thread ID (OTID) and name (OTNAME) if set
Location The currently executing line of function code
State Indicates what the thread is doing. (see below)
Flags Normal or Paused.

Treq The Thread Requirements (OTREQ)
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Thread States
State Description
Pending Not yet running
Initializing Not yet running

Defined function Between lines of a defined function

Dfn Between lines of a dfn

Indicates that the thread is suspended and is able to

Suspended accept input from the Session window.

Indicates that Session window is connected to this

Session
thread.

Indicates that the thread has no SI stack and the Session
(no stack) is connected to another thread. This state can only occur
for Thread 0.

Exiting About to be terminated

:Hold Waiting fora :Hold token
:EndHold Waiting fora :Hold token

0oL Executing DL

aoQ Executing [0DQ

0ONA Waiting for a DLL ([0NA) call to return.
OTGET Executing OTGET, waiting for a token
OTGET

(Ready to continue) Executing JTGET, having got a token

OTSYNC Waiting for another thread to terminate

Indicates a thread that is associated with a NET system

Awaiting request .
£1eq thread, but is currently unused

Called .NET Waiting for a call to .NET to retumn.

Paused/Normal

In addition to the thread state as described above, a thread may be Paused or Normal
as shown in the Flags column. A Paused thread is one that has temporarily been
removed from the list of threads that are being scheduled by the thread scheduler. A
Paused thread is effectively frozen.
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Threads Tool Pop-Up Menu

Switch ko
Interrupk

Refresh Mow
v Auko Refresh

v Pause Threads on Errar

v Paused
Pause All
Resume All
Restark all
Selecting this item causes APL to attempt to suspend (if
Switch to necessary) and switch to the selected thread, connecting

it to the Session and Debugger windows.

Refresh Now

Refreshes the Threads Tool display to show the current
position and state of each thread.

Auto Refresh

Selecting this item causes the Threads Tool to be
updated continuously, so that it shows the latest
position and state of each thread.

Pause Threads on

If this item is checked, APL automatically Pauses all
other threads when a thread suspends due to an error or

Error .
an interrupt.
This item toggles a thread between being Paused and
Paused Normal. It Pauses a Normal thread and resumes a
Paused thread.
Pause All This item causes all threads to be Paused.
Resume All This item resumes all threads.
Restart All This item resumes all Paused threads, restarts all

suspended threads, and closes the Debugger.
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Debugging Threads

The Debugger provides a tabbed interface that allows you to easily switch between
suspended threads for debugging purposes. To keep things simple for non-threaded
applications, Tabs are only displayed if there is a thread suspended that is other than
Thread 0. The following picture shows the Debugger open on a multi-threaded
application (LIFT.DWS) when only Thread 0 is suspended. This has been achieved
by setting a stop on RUN[63]

5 C:\Program Files\Dyalog\Dyalog APL 12.1 Unicodetws\lift - Dyalog APLAY =[]
Fle Edt View Wndows Sesson Log Acon Options Toos Thieads Help

ws O 08 3 ot BB g T o b @ b Tod O G R e ©) Cu CSession B APLIES Unicode v |[ 162

Language Bar P =/
[T [l ] (UL [FEsRFEER] TR [e[efn[<]] [Ele[¢f[s] [TELL] ROEL] ERFokE [ & =
Serial No @ 0000LZ A

Unicode Edition
Mon Aug 17 11:20:28 2009

lelx

clear ws

C:%Program Files\Dyalog\Dyalog APL 12.1 Unicodedws\lift saved Wed Mar L1 11:17:02 2009
Lift simulation designed to illustrate multi-threading

and thread synchronisation, using the Token Paol.

To run it:

RUN 20 A Simulate 20 arrivals

RUN 5
RUNT63]
v.
Debugger =lalx
FTFMUP D PEXNHN v| 00 @ |[RUNTE31+OTRET 2[v ﬁ RUN[631+0TGET 2pTobbone W
i OTGET GUTReady |0
F.LIFTI F.LIFT2 LIFT&"<FLOORS GAPAGITY n Start Lift threads
tFor I tIn uN A Start <H> peaple thraads
PERSON&FLODRS =
ObL 0.2x710 # Simulste random(ish) srrival E]
tEndFor o
OTFUT AllDons A Tell Lifts "that’s it" =
[OTGET ZeTabbone i Wait until Lifts have finfshed delivering men g
OTKILL OTHUMS f Zap any threads =z
v & .
T m =3
< N z
Function Last saved by: Dyalog: 09 July 2004 08:36 Pas: 63{65,0 o ¢ > w
Ready... Ins  HUM

CurGbj: RUN (Function) &:8 opg:0  OTRAP  OSI:1  OIo:1 OML:0
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In the next picture, the user has chosen to display the Threads Tool and then dock it
between the Session and Debugger windows. Note that only one thread, thread 0

(Run) is suspended. All the other threads are Paused (because Pause on Error is
enabled).

B C:Program Fi log APL 12.1 Unicodewslift - Dyalog APL/W (=]
Ele Edit Yew Windows Sesson Log Action Options Tools Threads Help
s N EMEHY ot BB YV Bk & 10 QG H K ek BB o o Sesion B AL Unicode  |v|[ 1872
Language Bar EEE| L
DEEEEDEEREY NNAEREEE! AV [O[4f] []efu[o]e]-] L Lfelelele] [TFELT] [0l [rallufell] [¢] = o
RUN S ~
RUN[E3] ]
)
Threads P =T}
Tid Location State Flags | Treq
0: Run +RUN[63] OTRET 2pToblone R Wai... Session Hormal
1: GUI SHOW[22] ODQ'F* opa Paused
2: Lift 1 GOTO[10] ODL 0.2 ooL Paused
3: Lift 2 GOTO[10] ODL 0.2 ooL Paused
S: Man 5 PERSON[7] OTGET Lift REACHED MYFLO... OTGET [Ready to continue) Paused b1
6: Lady 6 PERSON[7] OTGET Lift REACHED MYFLO... OTGET [Ready to continue) Paused b2
7: Man 7 PERSON[L] Lift+OTGET Eoinglp OTGET (Ready to continue) Paused 2
8: Lady 8 PERSON[4] Lift<OTEET Eoinglp ... OTGET (Ready to continue) Paused 2
Debugger =lolx
SFUBD P DPEZEXINHE v|ah A% | RuNLE31+OTGET 2|v ﬁ RUN[631+OTGET 2plobDone A W
[56] OTGET GUIReady Al
571 F.LIFT! F.LIFTZ LIFT& <FLOORS CAPACITY m Start Lift threads
[58] tFar 1 :In UM A Start <N> people threads -
[59] PERSON&FLOORS <
[60] ool 0.2x710 A Simulate randem(ish] arrival &
[61] :EndFor &
[62] OTPUT AllDone A Tell Lifts “that’s it" =]
[63] i@ [OTGET ZplobDone A Wait until Lifts have finished delivering men E
[64] OTKILL OTHUMS M Zap any threads vl 3 L
IS 5
C = 5 =
Function Last saved by: Dyalog: 09 July 2004 08:36 Pos: 63[65,0 0 [g 3w
i Ready... Ins  NUM
: CurObj: RUN (Function) 8:8 OpQ:0 OTRAP  0OSI:1 QOIO:1 [OML:O
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The user then uses the context menu to Switch To Thread 6 (whose name is Lady 6)
which was Paused on PERSON[ 7] in the middle of a[JTGET. The act of switching
to this thread caused it to be suspended at the beginning of its current line PERSON
[7] and the Debugger now displays two Tabs to represent the two suspended
threads. Note that both the thread id and the thread name are displayed on the Tabs.

£ c:\Program Files\Dyalog\Dyalog APL 12.1 Unicodews\lift - Dyalog APLAY M=
Ble Edt View Windows Sesson Log Action Options Tols Threads Help
ws O 08 B & G obier: BB Bg v @ T QG W e By W3 O Sesson (B | APL3BGUnicode | [ TE[S
Language Bar Zle1x| ﬁ
[fRleBR ] (L] [F=FEER ABER[EH (=]l [Fleltl=le) [FELL] DR FlaREE [ &)
MYFLOOR K
m
v
Threads =lsl=]
Tid Lacation State Flags | Treq
u: Run  +RUN[631 OTGET 2gJobbons W Wai... Tuspended Paused
10 BUI SHOWI 221 ODY'F' oo Paused
2: Lift 1 BOTO[10] OOL 0.2 ooL Paused
3: Lift 2 BoTol1o] OOL 0.2 ool Paused
5: Man 9 FPERSOM[?] OTBET Lift REACHED MYFLO... QOTBET (Ready to continue) Faused LI
6: lady & *PERSOM[?] OTEET Lift REACHED MYFLO... Session Normal
7t Man 7 PERSOM[W] Lift<OTGET GoingUp ... OTGET (Ready to continue) FPaused 2
8: Lady 8 PERSON[4] Lift<OTGET Goinglp ... OTEET (Ready to continue) Paused 2
Debugger =lol=l
i Run| 6t Lady 6 ﬂ PERSONLTI+OTGET Lift REACHED MYFL
o
STUMDP P PEXNHH ~| B 80 | PERSONL7]+0TGE v | | 2
3] ARRIVE M Arrive at 11ft shaft &
[u] Lift<OTGET Goinglp Wit for 1iFt door to be apsn/fres =
[5] Lift GETIN MYFLOOR«?FLOORS A Get into the Lift, tell the 1ift where I’ » E
[5] MYFLOOR OTPUT Lift.ID+Manln @ Clasr the Lift door for nsxt person =
[?1 OTGET Lift REACHED MYFLOOR A Wait for 1ift to reach my floor =
[s] Lift GETOUT MYFLOOR W De-Lift g
[3] OTPUT Lift. ID+*Man0ut m Tell Lift 1°'m out, thread ends Sl =
< > £ E]
Function Last saved by: Dyalog: 02 July 2004 13:28 Pas: 7/10,0 @ ¢ 5 i
Ready. .. Tns  HUM
CurObj: MYFLOOR (Yariablel &:8 gog:0  OTRAP  [QSI:2  QpIo:1l oMLz o

Note also that the Session window is connected to the thread indicated by the selec-
ted Tab. In this case, typing MYF LOOR into the Session window displays the value of
the local variable MYFLOOR in Thread 6 (Lady 6).
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You can use the Tabs to switch between the suspended threads, so clicking the Tab
labelled 0 : Run causes the display to change to the picture shown below. The Ses-
sion is now connected to Thread 0 (Run), so the value of [JLC is 63.

B C:Program Fi log APL 12.1 Unicodewslift - Dyalog APL/W (=]
Fle Edt Wew Windows Session Log Action Options Tools Thesads telp
s D EME Y o BB RV b = @ Too Q G) O Ed (B ) cu o Session B APLIGUnicode  |w|[ 16[2]
Language Bar el x| :
FEDEEERE [l FREEREER R0 [eof[=]] [Telelele) CEELLe] o[l FlREblleR] [f] & 2
oLe ~
63
)
Threads P =T}
Tid Location State Flags | Treg
0: Run +RUN[63] OTGET ZpTobbane A Wai... Session Harmal
1+ GUI SHOW[22] ODQ'F* ope Paused
2: Lift 1 GOTO[10] ODL 0.2 opL Paused
3: Lift 2 GOTO[10] ODL 0.2 opL Paused
S: Man 5 PERSON[7] OTGET Lift REACHED MYFLO... OTGET (Ready to continue) Faused b1
6: Lady 6 *PERSON[7] OTGET Lift REACHED MYFLO... Suspended Hormal
7i Man 7 PERSON[L] Lift+OTGET Goinglp OTGET (Ready to continue) Faused 2
8: Lady 8 PERSON[L] Lift+OTGET Goinglp ... OTGET (Ready to continue) Faused 2
Debugger =lolx
05 Run | g: Lady 6 ﬂ RUNL631+OTGET ZpJobbane n Ha
- - |
STUW D P PZEXNHE ~| 08 & |[Runles1-OTeeT [+ |
(561} OTGET GUIReady ~
[571: F.LIFTL F.LIFTZ LIFT&"=FLOORS CAPACITY m Start Lift threads =
[58]} iFor [ iln N A Start <M= people threads =
[591; PERSON&FLOORS e
[60]] OoL 0.2x710 # Simulate randomish) arrival =
[611} :EndFor =
[62] ! OTPUT AllDone A Tell Lifts "that’s it" v =
<] 3 || = 5
= 2
Function Last saved by: Dyalog: 03 July 2004 08:36 Pas: 63/65,0 o (¢ 5 i
i Ready... Ins | NUM
{ CurObj: MYFLOOR (Yarisble) a8 ODQ:0  OTRAP  OSI:l  [OL0:1 [ML:O
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The Event Viewer

The Event Viewer can be used to monitor events on Dyalog APL GUI objects. To dis-
play the Event Viewer, select Event Viewer from the Session Tools menu.

You can choose:

¢ which types of events you want to monitor
e which objects you want to monitor

ﬁ Event Yiewer
Spy  Columns  Select  Options
Object | E wentt ame | Parameters dction | EventlD |
#F GotFocus n s
#F Mouzellp 4505208206 2510 n 53
#F MouzeDbIChick 4505208206 2510 n B0
#F Mouzellp 45 05208206 2510 n B1
#F Configure 11.58854198 28320312, #FOO B2
#F Configure 11.58854198 28320312, #FOO B4
#F Canfigure 11.58854198 2832012, #FOO BG
#F Canfigure 11.58854198 2832012, #FOO B3
#F Configure 11.58854198 28320312, #FOO il
#F Configure 11.58854198 28320312, #FOO T2
#F Canfigure 11.58854198 2832012, #FOO 74
#F Canfigure 11.58854198 2832012, #FOO 76
#F Configure 11.58854198 28320312, #FOO 7a
#F Configure 11.58854198 28320312, #FOO an
#F LostFocus I} a2

In the example illustrated above, the user has chosen to monitor events on a Form
# . F. Furthermore, the user has chosen to monitor GotFocus, LostFocus, MouseUp,
MouseDblClick and Configure events. Notice that there is a callback #. FOO
attached to the Configure event.
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The Spy Menu

Close
|ear

= 4
Az Queyed
Snapshok

Stop Logging

The Spy menu, illustrated above, provides the following options and actions.

Close:

Closes the Event Viewer

Clear:

Clears all of the event information that is currently
displayed in the Event Viewer.

All:

In this mode all the events are displayed in the Event
Viewer as they occur, whether or not there is an action
associated with them.

As Queued:

In this mode only events that have associated actions

are displayed in the event viewer. Note that KeyPress

events are always queued and therefore always appear,
even if there is no associated action.

SnapShot:

In this mode the Event Viewer displays a snapshot of
the internal event queue. Only those events that are
currently in the internal APL event queue waiting to be
processed are displayed.

Stop Logging:

When checked, this item switches event logging off.
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The Columns Menu

v Cbject

v EventMame
Eventiurnber

v Parameters

W Ackion
ThreadID
MCed

w EventID

The Columns menu allows you to choose which information is displayed for the
events you are monitoring.

Object

If checked, this item displays the name of the object on
which the event occurred.

Event Name

If checked, this item displays the name of the event that
occurred.

Event Number

If checked, this item displays the event number of the
event that occurred.

If checked, this item displays the parameters for the

Parameters event that occurred. These are the items that would be
passed in the argument to a callback function.
If checked, this item displays the action associated with

Action the event, for example the name of a callback function,
or an expression to be executed.

Thread ID .If che(.:ked, this item displays the thread id of the thread
in which the event occurred
If checked, this item displays 0 or 1 according to

Nqed whether or not the event occurred naturally or was
generated programmatically by [INQ.

Event ID If checked, this item displays the event id of the event

that occurred. This id is used internally.
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The Select Menu

Select Matching Events
Select All Events On This Ohject
Select All Events OF This Type

The Select menu allows you to highlight certain events in the Event Viewer. For
example, if you are monitoring TCP/IP events on a number of TCPSockets, you can
highlight just the events for a particular socket.

Highlights all the events that have the same Object and
Event Name (or Event Number) as the currently selected
event.

Select Matching
Events

Select All Events | Highlights all the events that have the same Object as
On This Object the currently selected event.

Select All Events | Highlights all the events that have the same Event
Of This Type Name (or Event Number) as the currently selected event

These items are also available from the pop-up menu that appears when you press the
right mouse button over an event displayed in the Event Viewer window.

The Options Menu

v Always on Top
v Use APL Fant

Settings. ..

The Options menu allows you to choose which information is displayed for the
events you are monitoring.

If checked, this item causes the Event Viewer window to
Always on Top be displayed above all other windows (including other
application windows).

If checked, this item causes the information displayed in
the Event Viewer window to be displayed using the
Use APL font APL font (the same font as is used in the Session
window). If not, the system uses the appropriate
Windows font.

Settings... Displays the Event Viewer Options Dialog Box.
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Options Dialog Box

The Event Viewer Options dialog box allows you to select the objects and events
that you wish to monitor.

-

Event Viewer Options

Options l

Events to view: Dbjects to view:
Name [ nfa FindToot 639 Select Fram List...
tauzel own 1
touzellp 2 M ame:
touzebd ove 3
i ouzeClick 4 Type:
MouzeD bIClck ]
ouzeE nter g .
Mouzel eave 7 ThreadiD:
rouzetafheel a
Diraglwer 10 Handle:
DragDrop 1
DragStart 12 p
DragListtave 15 B Pt O el
DrraglistCopy 16 ) _
KeyDown 20 [~ Child Objects
Keylp 21
KewPress 22 [ Same Thread
K.enEmror 23 ™

et Select Al Tompy | A
E event|z] selected

Events to view

The list box shows all the events that are support by the Dyalog APL GUI and
allows you to select which events are to be monitored. Only those events that are
selected will be reported. You can sort the events by name or by event number by
clicking the appropriate column header.
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Objects to view

All Objects

If checked, this item enables event reporting on all
Dyalog APL GUI objects.

Objects of Type

If checked, this item activates the adjoining Select
button and disables all other Object selection
mechanisms. Clicking the Select button brings up a
dialog box that allows you to choose which types of
Dyalog APL GUI objects you want to monitor.

Find Tool

This tool allows you to choose a single specific Dyalog
APL GUI object that you want to monitor. To use it,
drag the Find Tool and move it over your Dyalog APL
GUI objects. As you drag it, the individual objects are
highlighted and their details displayed in the Name,
Type, Thread ID and Handle fields. Drop the Find Tool
on the object of your choice.

Select

Clicking this button brings up a dialog box that
displays the entire Dyalog APL GUI structure as a tree
view. You can choose a single object by selecting it.
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The Session Object

Purpose: The Session object [JSE is a special system object that represents
the session window and acts as a parent for the session menus, tool
bar(s) and status bar.

Children Form, MenuBar, Menu, MsgBox, Font, FileBox, Printer, Bitmap,
Icon, Cursor, Clipboard, Locator, Timer, Metafile, ToolBar,
StatusBar, TipField, TabBar, ImageList, PropertySheet, OLEClient,
TCPSocket, CoolBar, ToolControl, BrowseBox

Properties  Type, Caption, Posn, Size, File, Coord, State, Event, FontObyj,
YRange, XRange, Data, TextSize, Handle, HintObj, TipObyj,
CurObj, CurPos, CurSpace, Log, Input, Popup, RadiusMode,
MethodList, ChildList, EventList, PropList

Methods ChooseFont, FileRead, FileWrite

Events Close, Create, FontOK, FontCancel, WorkspaceLoaded,
SessionPrint

Description

There is one (and only one) object of type Session and it is called JSE. You may use
OWG,OWS and OWN to perform operations on [ISE, but you cannot expunge it with
OEX nor can you recreate it using JWC. You may however expunge all its children.
This will result in a bare session with no menu bar, tool bar or status bar.

(SE is loaded from a session file when APL starts. The name of the session file is spe-
cified by the session_file parameter. If no session file is defined, JSE will have no
children and the session will be devoid of menu bar, tool bar and status bar com-
ponents.

You may use all of the standard GUI system functions to build or configure the com-
ponents of the Session to your own requirements. You may also control the Session
by changing certain of its properties.

Note that the Session reports a Create event when APL is first started, and a Work-
spaceLoaded event when a workspace is loaded or on a clear ws.

The Session also reports a SessionPrint event when certain types of output are about
to be displayed. This may be used to alter the normal default display.
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Read-Only Properties

The following properties of JSE are read-only and may not be set using [JWS:

Type

A character vector containing 'Session'

Caption

A character vector containing the current caption in the title bar
of the Session window.

TextSize

Reports the bounding rectangle for a text string. For a full
description, see TextSize in Object Reference.

CurObj

A character vector containing the name of the current object.
This is the name under or immediately to the left of the input
cursor.

CurPos

A 2-element integer vector containing the position of the input
cursor (row and column number) in the session log. This is JI0
dependent. IfJIO is 1, and the cursor is positioned on the
character at the beginning of the first (top) line in the log,
CurPos is (1 1). If0I0 is 0, its value would be (0 0).

CurSpace

A character vector which identifies the namespace from which
the current expression was executed. If the system is not
executing code, CurSpace is the current space and is equivalent
to the result of @' '[INS " *.

Handle

The window handle of the Session window.

Log

A vector of character vectors containing the most recent set of
lines (input statements and results) that are recorded in the
session log. The first element contains the top line in the log.

Input

A vector of character vectors containing the most recent set of
input statements (lines that you have executed) contained in the
input history buffer.

ChildList

A vector of character vectors containing the types of object that
can be created as a child of [JSE.

MethodList

A vector of character vectors containing the names of the
methods associated with [JSE.

EventList

A vector of character vectors containing the names of the events
generated by OSE

PropList

A vector of character vectors containing the names of the
properties associated with [JSE.
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Read/Write Properties

The following properties of JSE may be changed using [JWS:

Coord

Specifies the co-ordinate system for the session window.

Data

May be used to associate arbitrary data with the session object
OsE.

Event

You may use this property to attach an expression or callback
function to the Create event or to user-defined events. A callback
attached to the Create event can be used to initialise the Session
when APL starts.

File

The full pathname of the session file that is associated with the
current session. This is the file name used when you save or load
the session by invoking the FileRead or FileWrite method.

FontObj

Specifies the APL font. In general, the FontObj property may
specify a font in terms of its face name, size, and so forth or it may
specify the name of a Font object. For applications, the latter
method is recommended as it will result in better management of
font resources. However, in the case of the Session object, it is
recommended that the former method be used.

HintObj

Specifies the name of the object in which hints are displayed.
Unless you specify HintObj individually for session components,
this object will be used to display the hints associated with all of
the menu items, buttons, and so forth in the session. The object
named by this property is also used to display the message
“Ready...” when APL is waiting for input.

Popup

A character vector that specifies the name of a popup menu to be
displayed when you click the right mouse button in a Session
window.

Posn

A 2-clement numeric vector containing the position of the top-left
corner of the session window relative to the top-left comer of the
screen. This is reported and set in units specified by the Coord

property.

Size

A 2-element numeric vector containing the height and width of the
session window expressed in units specified by the Coord property.
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State

An integer that specifies the window state (O=normal,
I=minimised, 2=maximised). You may wish to use this property to
minimise and later restore the session under program control. If you
save your session with State set to 2, your APL session will start
off maximised.

TipObj

Specifies the name of the object in which tips are displayed. Unless
you specify TipObj individually for session components, this
object will be used to display the tips associated with all of the
menu items, buttons, and so forth in the session.

XRange

See Object Reference

YRange

See Object Reference

Special Events

In addition to the events and methods which are provided by OSE in common with
other GUI objects, the following events are unique to JSE.

This event is reported when a value is about to be
displayed in the Session window. The default display of

SessionPrint the value may be intercepted by a callback function and

displayed differently. This event is used by the Jbox
and ]Jrows user commands.

WorkspaceLoaded

This event is generated when a workspace is loaded or
upon )CLEAR.

Special Properties

In addition to the properties which are provided by [SE in common with other
GUI objects, the following properties are unique to JSE.

StatusWindow

This read-only property returns a reference to the Status
Window. The expression:
(OSE.OWG'StatusWindow').Text retums the (read-
only) contents of the status window.

Editor

This read-only property returns a reference to the Editor
Window. It is used by SALT and may be changed in future
versions of Dyalog.
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SessionPrint Event 526

Applies To: Session

Description

Ifenabled, this event is reported when a value is about to be displayed in the Session.
It is generated by the display of a variable or the result of a function including system
variables and functions. Error messages and output from system commands do not
generate this event.

The event message reported as the result of JDQ, or supplied as the right argument to
your callback function, is a 2-element vector as follows :

[1] [Object ref or character vector

[2] |Event 'SessionPrint' or

The attachment of a callback function intercepts and annuls the normal display of
any value.

Note that this event may be extended in future; in particular the number of elements
in the event message may be increased, and the event may be generated by some sys-
tem commands. You should therefore allow for such extensions in any code which
refers to SessionPrint.

When the event is generated, the left argument of the callback function contains the
value which was about to be displayed. The callback function may display this or
any other value, using default output or by assignment to [. If so, this output will be
processed normally, without generating a subsequent SessionPrint event. If the call-
back fails to explicitly display anything, nothing will appear in the Session.

Example

OVR'OSE.TimeStamp'

V VAL TimeStamp EV
[1] 0TS VAL

v

'OSE'OWS'Event' 'SessionPrint' '[SE.TimeStamp'

2
2014 9 18 16 20 38 318 2

OA
2014 9 18 16 20 44 668 ABCDEFGHIJKLMNOPQRSTUVWXYZ
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The result (if any) of the callback function is ignored.

You may not disable the event (by setting its action to ~ 1), nor generate the event
using [NQ, nor call it as a method.

WorkspaceLoaded Event 525

Applies To: Session

Description

Ifenabled, this event is reported when a workspace is loaded orona clear ws.
You may not nullify or modify the event with a O-returning callback, nor may you
generate the event using [INQ, or call it as a method.

The event message reported as the result of [IDQ, or supplied as the right argument to
your callback function, is a 2-element vector as follows :

[1] [Object ref or character vector

[2] |Event 'WorkspacelLoaded' or 525

This event is fired immediately after a workspace has been loaded and before the exe-
cution of (L X.

The callback function you attach should be defined in [JSE.
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Configuring the Session

As supplied, your default session will have a menu bar, a tool bar and a status bar.
There are many ways in which you may configure this set-up, including the fol-
lowing:

You may select a different APL font or character size.

Y ou may alter the appearance of the menus by changing the Caption properties of
the various Menu and Menultem objects. For example, you may prefer the menus to
appear in your own language.

You may alter the structure of the menus. For example, you may wish to create a
Search menu directly on the menu bar rather than having Find and Replace as part of
the Edit menu.

You may add new Menu and Menultem objects to the menu bar, or new Button
objects to the tool bar, that execute APL functions or expressions for you. You can
store the code inside the [JSE namespace so that it is remains available when you
switch from one workspace to another.

You may add other objects to the tool bar to allow you to provide input for your func-
tions or to display output. For example, you may display a Combo object that offers
you a selection of names applicable to a particular task.

You may add additional toolbars.

You may remove objects too; for example, you can remove fields from the StatusBar
or even delete it entirely. Indeed, you may dispense with the menu bar and/or tool
bar as well.

This section illustrates how you can configure your session using worked examples.
The examples are by no means exhaustive, but are designed to demonstrate the prin-
ciples. Please note that the structure and names of the objects used in these examples
may not be identical to your default session as supplied. Before you attempt to
change your session, please check the structure and the object names using JWN and
[WG. The supplied session was created using the function BUILD SESSION in the
workspace BUILDSE. If you wish to make substantial changes to your session, you
may find it most convenient to edit the functions in this workspace, re-run BUILD
SESSION, and then save it.

Please note that these examples assume that Expose Session Properties is enabled.
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Changing the Font

The APL session font is defined by the Font property of JSE. To change the font per-
manently, you should select a different Font and/or size of Font using the combo and
spinner boxes on the Session toolbar, and save your Session.

Classic Edition is distributed with bitmap fonts suitable for use on your screen, and
TrueType fonts for your printer. You can use the TrueType font on the screen, but it
is less attractive than the bitmap fonts at low resolutions. The bitmap fonts come in
two sizes (16 x 8 and 22 x 11) and two weights (normal and bold). You may select
other sizes, so long as the height is a multiple of 16 or 22. The scaling is performed
automatically by Windows.

Changing Menu Appearance

The name of the Session MenuBar is [ISE . mb". To simplify the specification of
object names, we will first change space to the MenuBar itself:

)CS [OSE.mb
OSE.mb

The names of the Menu objects owned by the MenuBar are given by the expression:

‘Menu' [OWN "'
file edit view windows session Llog action options
tools help

The current caption on the file menu is:

file.Caption
&File

To change the Caption to Workspace:
file.Caption<«'Workspace'
To change the colour of the New option in the File menu to red:

file.clear.FCol«255 0 O
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Reorganising the Menu Structure

This example shows how you may alter the structure of the session menus by adding
a Search menu to the menu bar to provide access to the Find and Find/Replace dia-
log boxes and removing these options from the Edit menu.

To simplify the process, we will first change space into the MenuBar object itself:

)CS [SE.mb
(OSE.mb

Then we can begin by adding the Search menu. You can specify where the new
menu is to be added using its Posn property. In this case, Search will be added at pos-
ition 3 (after Edit).

'search'DWC 'Menu' '&Search' 3

Next we will remove the Find and Replace Menultem objects from the Edif menu.
Their names can be obtained from [JWN:

‘MenuItem'[OWN'edit’
edit.prev edit.next edit.clear edit.copy edit.paste
edit.find edit.replace

It is worth noting that these Menultems perform their actions because their Event
property is set to execute the system operations [Find] and [Replace] respect-
ively when they are selected.

edit.find.Event
Select [Find]

edit.replace.Event
Select [Replacel

The following statement removes them from the Edit menu:
OEX"'edit.find' 'edit.replace'’
and the following statements add them to the Search menu:

'search.find' OWC 'Menultem' '&Find'
('Event' 'Select' '[Find]"')
‘search.replace' OWC 'Menultem' '&Replace’
('Event' 'Select' '[Replace]')
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Adding your own Menultem

This example shows how you can add a menu item that executes an APL expression.
In this case we will do something very simple; namely add a Time option to the
Tools menu which will execute (JTS. Notice that the statement also defines a Hint.
This will be displayed when you select the option, prior to releasing the mouse but-
ton to action it.

Once again, we will start by changing space into the 7ools menu itself

)CS [SE.mb.tools
OSE.mb.tools

Then we will define a new Menultem to perform the action we require:

"ts'OWC'Menultem' '&Time'
('Event' 'Select' 'e¢[TS"')
('Hint' 'Display Timestamp')

The ¢ symbol is very important and distinguishes an expression to be executed imme-
diately, as in this case, from a callback function. The resulting Tools menu now
appears as follows:

Explarer...
Search...
Skatus...

v AukboStakus
Event Viewer

Time
A customised Tools menu
Selecting Time produces the following output in the session:

2007 12 10 17 10 2 O
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Adding your own Tool Button

This example shows how you can add a button to the session tool bar that executes
an APL function.

The example function we will use is called XREF. This function analyses another
function, listing the sub-functions that it calls. Instead of returning a result, this
example displays the sub-functions in a Form.

v XREF FN;REFS

[1] :If 0<pFN

[2] :AndIf 3=[INC FN

[3] REFS«[REFS FN

[4] REFS«(3=[INC REFS)#REFS

[5] REFS«(4REFS)~"" '

[6] REFS«REFS~cFN

[7] :If 0<pREFS

[8] 'F'OWC'Form' ('Functions called by ',FN)
[9] F.FontObj<«OSE.FontObj

[10] '"F.L'OWC'List'REFS(0 0)(100 100)
[11] tEndIf

[12] tEndIf

To make this function available from a Session tool button, we need to do a number
of things.

Firstly, we must install the function in JSE so that it is always there, regardless of the
current active workspace. This is easily achieved using the Explorer or JNS.

'OSeE’ ONS 'XREF'

Secondly, we need to find another way to specify its argument FN. One possibility
would be to display a dialog box, asking the user to specify the name of the function
to be analysed. A neater solution is to use the CurObj property of JSE which reports
the name under the cursor. Using CurObj, the user can simply place the cursor over
the name of the function to be analysed, and then click the XREF tool button.

To get FN from CurObj, all we need to do is to change the header and lines 1-2 to:

[0] XREF;FN;REFS
[1] :If O<pFN<«[JSE.CurObj
[2] :AndIf 3=[ONC FN<[JSE.CurSpace,'.',FN

Notice that the function name reported by CurObj is prefixed by its pathname which
comes from the CurSpace property. This reports the user’s current namespace.
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Next we will add a new button to the tool bar in the Tools CoolBand. Ideally we
would use a suitable bitmap, but to simplify the example, we will use a standard text
button:

)CS [SE.cbtop.bandtb3.tb
[SE.cbtop.bandtb3.tb

"xref' [OWC 'Button' 'XREF'
'xref' [OWS 'Event' 'Select' '&[JSE.XREF'

Tool @, G [ ﬂ@

Adding a tool button
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User Commands

Dyalog APL includes a mechanism to define User Commands.

User commands are developer tools, written in APL, which can be executed without
having to explicitly copy code into your workspace and/or save it in every work-
space in which you want to use it.

A User Command is a name prefixed by a closing square bracket, which may be
niladic or take an argument. A User Command executes APL code that is typically
stored somewhere outside the current active workspace.

By default, the existing SPICE command processor is hooked up to the user com-
mand mechanism, and a number of new SPICE commands have been added. For
example:

Jdisplay 'hello' (5'world')

7
hello| ‘w

o

£ 0~—7

-€

The implementation of User Commands is very simple: If a line of input begins with
a closing square bracket (]), and there exists a function by the name [JSE . UCMD,
then the interpreter will call that function, passing the input line (without the
bracket) as the right argument.

To add a user command, drop a new Spice command file in the folder SALT\Spice.
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Chapter 2:

APL Files

Introduction

Most languages store programs and data separately. APL is unusual in that it allows
you to store programs and data together in a workspace.

This can be inefficient if your dataset gets very large; when your workspace is
loaded, you are loading ALL of your data, whether you need it or not.

It also makes it difficult for other users to access your data, particularly if you want
them to be able to update it.

In these circumstances, you must extract your data from your workspace, and write it
to a file on disk, thus separating your data from your program. There are many dif-
ferent kinds of file format. This section is concerned with the APL Component File
system which preserves the idea that your data consists of APL objects; hence you
can only access this type of file from within APL

The Component File system has a set of system functions through which you access
the file. Although this means that you have to learn a whole new set of functions in
order to use files, you will find that they provide you with a very powerful mech-
anism to control access to your data.
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Component Files

Overview

A component file is a data file maintained by Dyalog APL. It contains a series of
APL arrays known as components which are accessed by reference to their relative
position or component number within the file. Component files are just like other
data files and there are no special restrictions imposed on names or sizes.

A set of system functions is supplied to perform a range of file operations. These
provide facilities to create or delete files, and to read and write components. Facil-
ities are also provided for multi-user access, including the capability to determine
who may do what, and file locking for concurrent updates.

Tying and Untying Files

To access an existing component file it must be tied, i.e. opened for use. The tie may
be exclusive (single-user access) or shared (multi-user access). A file is untied, i.e.
closed, using JFUNTIE oron terminating Dyalog APL. File ties survive ) LOAD,
[JLOAD and ) CLEAR operations.

Tie Numbers

A file is tied by associating a file name with a tie number. Tie numbers are integers
in the range 1 - 2147483647 and, you can supply one explicitly, or have the inter-
preter allocate the next available one by specifying 0. The system functions which
tie files return the tie number as a ‘shy’ result.

Creating and Removing Files

A component file is created using [JF CREATE which automatically ties the file for
exclusive use. A newly created file is empty, i.e. contains 0 components. A file is
removed with [JF ERASE, although it must be exclusively tied to do so.

Adding and Removing Components

Components are added to a file using JF APPEND and removed using [JFDROP. Com-
ponent numbers are allocated consecutively starting at 1. Thus a new component
added by [JF APPEND is given a component number which is one greater that that of
the last component in the file. Components may be removed from the beginning or
end of'the file, but not from the middle. Component numbers are therefore con-
tiguous.
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Reading and Writing Components

Components are read using [JFREAD and overwritten using [JFREPLACE. There are
no restrictions on the size or type of array which may replace an existing component.
Components are accessed by component number, and may be read or overwritten at
random.

Component Information

In addition to the data held in a component, the user ID that wrote it and the time at
which it was written is also recorded. This control information is useful in providing
an audit trail and in facilitating partial backups of components that have changed.

Multi-User Access

OF STIE ties a file for shared (i.e. multi-user) access. This kind of access would be
appropriate for a multi-user UNIX system, a network of single user PCs, or multiple
APL tasks under Microsoft Windows.

(F HOLD provides the means for the user to temporarily prevent other co-operating
users from accessing one or more files. This is necessary to allow a single logical
update involving more than one component, and perhaps more than one file, to be
completed without interference from another user. JF HOLD is applicable to External
Variables as well as Component Files

File Access Control

There are two levels of file access control. As a regular data file, the operating system
read/write controls for owner and other users apply. In addition, Dyalog APL man-
ages its own access controls using the access matrix. This is an integer matrix with 3
columns and any number of rows. Column 1 contains user numbers, column 2 an
encoding of permitted file operations, and column 3 passnumbers. Each row specifies
which file operations may be performed by which user(s) with which passnumber.

User Number

This is a number which is defined by the aplnid parameter. If you intend to use
Dyalog APL’s access matrix to control file access in a multi-user environment, it is
desirable to allocate to each user, a distinct user number. However, if you intend to
rely on under-lying operating system controls, allocating a user number of O to every-
one is more appropriate. A user number of 0 (which is the installation default), causes
APL to circumvent the access matrix mechanism described below.



186 Dyalog APL/W User Guide

Permission Code

This is an integer representation of a Boolean mask. Each bit in the mask indicates
whether or not a particular file operation is permitted as follows:

Bit No.

15(14113]|12(11)10(9(8|7|6|5|4|3]|2]|1

File Access
A A R R ) O N R N Operation Code

‘ L—— OFREAD 1
OFTIE 2
OFERASE 4
OF APPEND 8
OFREPLACE 16
OFDROP 32
OFRENAME 128
OFRDCI 512
OFRESIZE 1024
QOFHOLD 2048
OFRDAC 4096
OFSTAC 8192
OFHIST 16384

For example, if bits 1, 4 and 6 are set and all other relevant bits are zero only
OFREAD,OF APPEND and [JF DROP are permitted. A convenient way to set up the
mask is to sum the access codes associated with each operation.

For example, the value 41 (1+8+32) authorises JFREAD, JF APPEND and (JF DROP.
A value of 1 (all bits set) permits all operations. Thus by subtracting the access
codes of operations to be forbidden, it is possible to permit all but certain types of
access. For example, a value of "133 (T1- 4+128) permits all operations except
[F ERASE and [JFRENAME. Note that the value of unused bits is ignored. Any non-
zero permission code allows JF STIE and OFSIZE.OFCREATE,OFUNTIE,JFLIB,
[OF NAMES and [JF NUMS are not subject to access control. Passnumbers may also be
used to establish different levels of access for the same user.

When the user attempts to tie a file using OF TIE orJF STIE arow of the access mat-
rix is selected to control this and subsequent operations.

Ifthe user is the owner, and the owner's user ID does not appear in the access matrix,
the value (JAI[1] ~1 0)isconceptually appended to the access matrix. This
ensures that the owner has full access rights unless they are explicitly restricted.
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The chosen row is the first row in which the value in column 1 of the access matrix
matches the user ID and the value in column 3 matches the supplied passnumber
which is taken to be zero if omitted.

If there is no match of user ID and passnumber in the access matrix (including impli-
citly added rows) then no access is granted and the tie fails with a FILE ACCESS
ERROR.

Once the applicable row of the access matrix is selected, it is used to verify all sub-
sequent file operations. The passnumber used to tie the file MUST be used for every
subsequent operation. Secondly, the appropriate bit in the permission code cor-
responding to the file operation in question must be set. If either of these conditions
is broken, the operation will fail with FILE ACCESS ERROR.

If the access matrix is changed while a user has the file tied, the change takes imme-
diate effect. When the user next attempts to access the file, the applicable row in the
access matrix will be reselected subject to the supplied passnumber being the same as
that used to tie the file. If access with that password is rescinded the operation will
fail with FILE ACCESS ERROR.

When a file is created using JF CREATE, the access matrix is empty. At this stage, the
owner has full access with passnumber 0, but no access with a non-zero passnumber.
Other users have no access permissions. Thus only the owner may initialise the
access matrix.

User 0

If a user has an aplnid of 0, the access matrix and supplied passnumbers are ignored.
This user is granted full and unrestricted access rights to all component files, subject
only to underlying operating system restrictions.

General File Operations

(FLIB gives a list of component files in a given directory. JFNAMES and (JF NUMS
give a list of the names and tie numbers of tied files. These general operations which
apply to more than one file are not subject to access controls.
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Component File System Functions

See Language Reference for full details of the syntax of these system functions.

General

OFAVAIL Report file system availability
File Operations

OFCREATE Create a file

OFTIE Tie an existing file (exclusive)
OFSTIE Tie an existing file (shared)
OFUNTIE Untie file(s)

gdrcorPy Copy a file

OFERASE Erase a file

OFRENAME Rename a file

File information

OFHIST Report file events

OF NUMS Report tie numbers of tied files
OFNAMES Report names of tied files
gFLIB Report names of component files
OFPROPS Report file properties

OFSIZE Report size of file

Writing to the file

OFAPPEND

Append a component to the file

OFREPLACE

Replace an existing component

Reading from a file

OFREAD

Read one or more components

OFRDCI

Read component information
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Manipulating a file

(FDROP Drop a block of components
OFRESIZE Change file size (forces a compaction)
OF CHK Check and repair a file

Access manipulation

OFSTAC Set file access matrix

[OFRDAC Read file access matrix

Control multi-user access

(FHOLD Hold file(s) - see later section for details

Using the Component File System

Let us suppose that you have written an APL system that builds a personnel data-
base, containing the name, age and place of birth of each employee. Let us assume
that you have created a variable DATA, which is a nested vector with each element
containing a person's name, age and place of birth:

DISPLAY 21DATA

Then the following APL expressions can be used to access the database:

Example 1:
Show record 2

DISPLAY 2>5DATA

Example 2:
How many people in the database?

pDATA
123
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Example 3:
Update Pauline's age

(2 2oDATA)<«16
Example 4:

Add a new record to the database
DATA ,« c'Maurice' 18 'London'
Now let's build a component file to hold our personnel database.

Create a new file, giving the file name, and the number you wish to use to identify it
(the file tie number):

'COMPFILE' [JFCREATE 1

Ifthe file already exists, or you have already used this tie number, then APL will
respond with the appropriate error message.

Now write the data to the file. We could write a function that loops to do this, but it
is neater to take advantage of the fact that our data is a nested vector, and use each

).
DATA OFAPPEND™ 1

Now we'll try our previous examples using this file.

Example 1:
Show record 2

DISPLAY [FREAD 1 2

Example 2:
How many people in our database?

OFSIZE 1 A First component, next
1 125 10324 4294967295 A component, file size,
A maximum file size

“1+2o5[JFSIZE 1 A Number of data items

The fourth element of JF SIZE indicates the file size limit. Dyalog APL does not
impose a file size limit, although your operating system may do so, but the concept is
retained in order to make this version of Component Files compatible with others.
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Example 3:
Update Pauline's age
REC « [OFREAD 1 2 A Read second component
REC[2] « 18 A Change age
REC [OFREPLACE 1 2 A And replace component
Example 4:

Add a new record

('Janet' 25 'Basingstoke') [FAPPEND 1

Example 5:
Rename our file

"PERSONNEL "' [FRENAME 1

Example 6:

Tie an existing file; give file name and have the interpreter allocate the next avail-
able tie number.

"SALARIES' OFTIE O
2

Example 7:
Give everyone access to the PERSONNEL file
(1 3p0 ~1 O)OFSTAC 1

Example 8:
Set different permissions on SALARIES.

AM <« 1 3p1 "1 0 A Owner ID 1 has full access
AMs<« 102 1 O A User ID 102 has READ only
AM;« 210 2073 0 A User ID 210 has

A READ+APPEND+REPLACE+HOLD

AM [OFSTAC 2 A Store access matrix

Example 9:

Report on file names and associated numbers

OFNAMES ,[OF NUMS
PERSONNEL 1
SALARIES 2
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Example 10:
Untie all files
JFUNTIE [FNUMS

Programming Techniques

Controlling Multi-User Access

Obviously, Dyalog APL contains mechanisms that prevent data getting mixed up if
two users update a file at the same time. However, it is the programmer's respons-
ibility to control the logic of multi-user updates.

For example, suppose two people are updating our database at the same time. The
first checks to see if there is an entry for ' Geof f ', sees that there isn't so adds a new
record. Meanwhile, the second user is checking for the same thing, and so also adds a
record for ' Geof f '. Each user would be running code similar to that shown below:

Vv UPDATE;DATA;NAMES
[1] A Using the component file
[2] "PERSONNEL"' [FSTIE 1
[3] NAMES<>o[JFREAD ™ 1, 171+2>5[JFSIZE 1
(4] >ENDx1(c'Geoff')eNAMES
[5] ('Geoff' 41 'Hounslow')FAPPEND 1
[6] END:[JFUNTIE 1

\'4

The system function [JF HOLD provides the means for the user to temporarily prevent
other co-operating users from accessing one or more files. This is necessary to allow a
single logical update, perhaps involving more than one record or more than one file,
to be completed without interference from another user.
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The code above is replaced by that below:

VvV UPDATE ;DATA;NAMES

1] A Using the component file

2] 'PERSONNEL' [FSTIE 1

3] ([FHOLD 1

4] NAMES<«>0o[JFREAD ™ 1, 1~1+2>5[FSIZE 1
5] -ENDxi(c'Geoff')eNAMES

6] ('Geoff' 41 'Hounslow')[JFAPPEND 1
7] END:FUNTIE 1 ¢ [FHOLD 10

\'4

Lo B e B e B s N s N e N e |

Successive JF HOLDs on a file executed by different users are queued by Dyalog
APL; once the first JF HOLD is released, the next on the queue holds the file.

OF HOLDs are released by return to immediate execution, by JFHOLD 8, or by eras-
ing the external variable.

It is easy to misunderstand the effect of JF HOLD. It is NOT a file locking mechanism
that prevents other users from accessing the file. It only works if the tasks that wish to
access the file co-operate by queuing for access by issuing [JF HOLDs. It would be
very inefficient to issue a JFHOLD on a file then allow the user to interactively edit
the data with the hold in operation. What happens if he goes to lunch? Any other
user who wants to access the file and cooperates by issuing a JFHOLD would have to
wait in the queue for 3 hours until the first user returns, finishes his update and his

OF HOLD is released. It is usually more efficient (as well as more friendly) to issue

OF HOLDs around a small piece of critical code.

Suppose we had a control file associated with our personnel data base. This control
file could be an external variable, or a component file. In both cases, the concept is
the same; only the commands needed to access the file are different. In this example,
we will use a component file:

"CONTROL '[JFCREATE 1 A Create control file

(1 3p0 "1 0) OFSTAC 1 @A Allow everyone access

& OFAPPEND 1 A Set component 1 to empty
OFUNTIE 1 A And untie it



194

Dyalog APL/W User Guide

Now we'll allow our man that likes long lunch breaks to edit the file, but will control
the hold in a more efficient way:

vV EDIT;CMP;CV
[1] A Share-tie the control file

[2] "CONTROL' [FSTIE 1
[3] A Share-tie the data file
[4] "PERSONNEL"' [FSTIE 2

[5] A Find out which component the user wants to edit
[6] ASK:CMP<ASKAWHICHARECORD

[7] A Hold the control file

[8] [(FHOLD 1

[9] A Read the control vector

[10] CV<[JFREAD 1 1

[11] a Make control vector as big as the data file
[12] CV«(~1+2>o[FSIZE 2)tCV

[13] nA Look at flag for this component

[14] >(FREE,INUSE)[1+CMP>CV]

[15] A In use - tell user and release hold

[16] 1INUSE:'Record in use' ¢ [JFHOLD & ¢ ->ASK

[17] A Ok to use - flag in-use and release hold
[18] FREE:CV[CMP]«1 o CV [JFREPLACE 1 1o [JFHOLD &
[19] @A Let user edit the record

[20] EDITARECORD RECORD

[21] @A When he's finished, clear the control vector
[22] OJFHOLD 1

[23] CV<[JFREAD 1 1 oCV[CMP]«0 ¢ CV [FREPLACE 1 1
[26] [(JFHOLD @&

[27] A And repeat

[28] -+ASK

v

Component 1 of our CONTROL file acts as a control vector. Its length is set equal to
the number of components in the PERSONNEL file, and an element is set to 1 ifa
user wishes to access the corresponding data component. Only the control file is ever
subject to a JFHOLD, and then only for a split-second, with no user inter-action
being performed whilst the hold is active.

When the first user runs the function, the relevant entry in the control vector will be
set to 1. If a second user accesses the database at the same time, he will have to wait
briefly whilst the control vector is updated. If he wants the same component as the
first user, he will be told that it is in use, and will be given the opportunity to edit
something else.

This simple mechanism allows us to lock the components of our file, rather the than
entire file. You can set up more informative control vectors than the one above; for
example, you could easily put the user name into the control vector and this would
enable you to tell the next user who is editing the component he is interested in.
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File Design

Our personnel database could be termed a record oriented system. All the inform-
ation relating to one person is easily obtained, and information relating to a new per-
son is easily added, but if we wish to find the oldest person, we have to read ALL the
records in the file.

It is sometimes more useful to have separate components, perhaps stored on separate
files, that hold indexes of the data fields that you may wish to search on. For
example, suppose we know that we always want to access our personnel database by
name. Then it would make sense to hold an index component of names:

A Extract name field from each data record
"PERSONNEL' [OFSTIE 1
NAMES<«>o[JFREAD"1, "1 71+2>5[FSIZE 2

A Create index file, and append NAMES
"INDEX' [FCREATE 2
NAMES [FAPPEND 2

Then if we want to find Pauline's data record:

NAMES<[JFREAD 2,1 A Read index of names
CMP<NAMESi1c'Pauline’ A Search for Pauline
DATA<[JFREAD 1,CMP A Read relevant record

There are many different ways to structure data files; you must design a structure that
is the most efficient for your application.

Internal Structure

If you are going to make a lot of use of APL files in your systems, it is useful for you
to have a rough idea of how Dyalog APL organises and manages the disk area used
by such files.

The internal structure of external variables and component files is the same, and the
examples given below apply to both.

Consider a component file with 3 components:

'"TEMP' [JFCREATE 1
'One' 'Two' 'Three' [FAPPEND™1

Dyalog APL will write these components onto contiguous areas of disk:

| One | Two | Three |
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Replace the second component with something the same size:
'Six' [OFREPLACE 1 2

This will fit into the area currently used by component 2.

If your system uses fixed length records, then the size of your components never
change, and the internal structure of the file remains static.

However, suppose we start replacing larger data objects:
'Bigger One' [FREPLACE 1 1

This will not fit into the area currently assigned to component 1, so it is appended to
the end of the file. Dyalog APL maintains internal tables which contain the location
of each component; hence, even though the components may not be physically
stored in order, they can always be accessed in order.

121 13l 1]

The area that was occupied by component 1 now becomes free.
Now we'll replace component 3 with something bigger:
'‘BigThree' [JFREPLACE 1 3

Component 3 is appended to the end of the file, and the area that was used before
becomes free:

Dyalog APL keeps tables of the size and location of the free areas, as well as the
actual location of your data. Now we'll replace component 2 with something bigger:

'BigTwo' [FREPLACE 1 2
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Free areas are used whenever possible, and contiguous holes are amalgamated.

You can see that if you are continually updating your file with larger data objects,
then the file structure can become fragmented. At any one time, the disk area occu-
pied by your file will be greater than the area necessary to hold your data. However,
free areas are constantly being reused, so that the amount of unused space in the file
will seldom exceed 30%.

Whenever you issue a monadic JFRESIZE command on a component file, Dyalog
APL COMPACTS the file; that is, it restructures it by reordering the components and
by amalgamating the free areas at the end of the file. It then truncates the file and
releases the disk space back to the operating system (note that some versions of
UNIX do not allow the space to be released). For a large file with many components,
this process may take a significant time.

Error Conditions
FILE SYSTEM NOT AVAILABLE

A FILE SYSTEM NOT AVAILABLE (Error code 28) error will be generated if the
operating system returns an unexpected error when attempting to get a lock on a com-
ponent file.

FILE SYSTEM TIES USED UP

A FILE SYSTEM TIES USED UP (Error code 30) error will be generated when a
attempt is made to open more component files than is possible.

FILE TIED

A FILE TIED errorisreported if you attempt to tie a file which another user has
exclusively tied.
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Limitations
File Tie Quota

The File Tie Quota is the maximum number of files that a user may tie concurrently.
Dyalog APL itself allows a maximum of 1024 under UNIX and 512 under Windows,
although in either case your installation may impose a lower limit. When an attempt
is made to exceed this limit, the report FILE TIE QUOTA (Error code 31)is given.
This error will also be generated if an attempt is made to exceed the maximum num-
ber of open files that is imposed by the operating system.

File Name Quota

Dyalog APL records the names of each user's tied files in a buffer of 40960 bytes.
When this buffer is full, the report FILE NAME QUOTA USED UP (Error code 32)
will be given. This is only likely to occur if long pathnames are used to identify files.

The Effect of Buffering

Disk drives are fairly slow devices, so most operating systems take advantage ofa
facility called buffering. This is shown in simple terms below:

| Operating System | Sommmmme- . Smmmmmm - .
| instruction to |-->] BUFFER |--->] File on |
| write large data | --------- . | disk |
| object to a file |  —-mmmm——e- .

When you issue a write to a disk area, the data is not necessarily sent straight to the
disk. Sometimes it is written to an internal buffer (or cache), which is usually held in
(fast) main memory. When the buffer is full, the contents are passed to the disk. This
means that at any one time, you could have data in the buffer, as well as on the disk.
If you machine goes down whilst in this state, you could have a partially updated file
on the disk. In these circumstances, the operating system generally recovers your file
automatically.
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Ifthis facility is exploited, it offers very fast file updating. For systems that are I/O
bound, this is a very important consideration. However, the disadvantage is that
whilst it may appear that a write operation has completed successfully, part of the
data may still be residing in the buffer, waiting to be flushed out to the disk. It is usu-
ally possible to force the buffer to empty; see your operating system manuals for
details (UNIX automatically invokes the sync () command every few seconds to
flush its internal buffers).

Dyalog APL exploits this facility, employing buffers internal to APL as well as mak-
ing use of the system buffers. Of course, these techniques cannot be used when the
file is shared with other users; obviously, the updates must be written immediately to
the disk. However, if the file is exclusively tied, then several layers of buffers are
employed to ensure that file access is as fast as possible.

You can ensure that the contents of all internal buffers are flushed to disk by issuing
OFUNTIE @ atany time.

Integrity and Security

The structure of component files, the asynchronous nature of the buffering performed
by APL, by the Operating System, and by the external device sub-system, introduces
the potential danger that a component file might become damaged. To prevent this
happening, the component file system includes optional journaling and check-sum
features. These are optional because the additional security these features provide
comes at the cost of reduced performance. You can choose the level of security that is
appropriate for your application.

When journaling is enabled (see [JF PROPS)), files are updated using a journal which
effectively prevents system or network failures from causing file damage.

Additional security is provided by the check sum facility which enables component
files to be repaired using the system function [F CHK. See Language Reference: File
Check and Repair.

Level 1 journaling protects a component file from damage caused by an abnormal ter-
mination of the APL process. This could occur if the process is deliberately or acci-
dentally terminated by the user or by the Operating System, or by an error in Dyalog
APL.

Level 2 journaling provides protection not just against the possibility that the APL
process terminates abnormally, but that the Operating System itself fails. However, a
damaged component file must be explicitly repaired using the system function

OF CHK which will repair any damaged components by rolling them back to their pre-
vious states.
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Level 3 provides the same level of protection as Level 2, but following the abnormal
termination of either APL or the Operating System, the rollback of an incomplete
update will be automatic and no explicit repair will be needed.

Higher levels of Journaling inevitably reduce the performance of component file
updates.

For further information, see JFPROPS and [JF CHK.

Operating System Commands

APL files are treated as normal data files by the operating system, and may be manip-
ulated by any of'the standard operating system commands.

Do not use operating system commands to copy, erase or move component files that
are tied and in use by an APL session.
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Chapter 3:

Error Trapping

Error Trapping Concepts

The purpose of this section is to show some of the ways in which the ideas of error
trapping can be used to great effect to change the flow of control in a system.

Most APLs have error trapping facilities in one form or another, but this section dis-
cusses the facilities available to a Dyalog APL programmer.

First, we must have an idea of what is meant by error trapping. We are all used to
entering some duff APL code, and seeing a (sometimes) rather obscure, esoteric error
message echoed back:

10+0
DOMAIN ERROR
10+0

A

This message is ideal for the APL programmer, but not so for the end user. We need a
way to bypass the default action of APL, so that we can take an action of our own,
thereby offering the end user a more meaningful message.

Every error message reported by Dyalog APL has a corresponding error number (for a
list of error codes and message, see JTRAP, Language Reference). Many of these
error numbers plus messages are common across all versions of APL. We can see that
the code for DOMAIN ERRORis 11, whilst LENGTH ERROR has code 5.

Dyalog APL provides two distinct but related mechanisms for the trapping and con-
trol of errors. The first is based on the control structure :Trap ... :EndTrap,
and the second, on the system variable JTRAP. The control structure is easier to
administer and so is recommended for normal use, while the system variable provides
slightly finer control and may be necessary for specialist applications.
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Last Error number and Diagnostic Message

Dyalog APL keeps a note of the last error that occurred, and provides this inform-
ation through system functions: JEN, JEM and [JDM.

10:0
DOMAIN ERROR
100

A

Error Number for last occurring error:

OEN
11

Error Message associated with code 11:

OeM 11
DOMAIN ERROR

(DM (Diagnostic Message) is a 3 element nested vector containing error message,
expression and caret:

(oM™
DOMAIN ERROR 100 A

Use function DISPLAY to show structure:
DISPLAY [IDM

|
o
>

DOMAIN ERROR 10+

€

Mix (1) of this vector produces a matrix that displays the same as the error message
produced by APL:

+0OM
DOMAIN ERROR
10+0

A
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Error Trapping Control Structure

You can embed a number of lines of code in a : Trap control structure within a
defined function.

[1] cen

[2] :Trap O

[3] e

(4] .

[5] :EndTrap

[6] cen

Now, whenever any error occurs in one of the enclosed lines, or in a function called
from one of the lines, processing stops immediately and control is transferred to the
line following the : EndTrap. The 0 argument to : Trap, in this case represents any
error. To trap only specific errors, you could use a vector of error numbers:

[2] :Trap 11 2 3

Notice that in this case, no extra lines are executed after an error. Control is passed to
line [ 6] either when an error has occurred, or if all the lines have been executed
without error. If you want to execute some code only after an error, you could re-code
the example like this:

[2] ;iéap 0

[5] :Else

[8] :EndTrap

Now, ifan error occurs in lines [ 3-4], (or in a function called from those lines), con-
trol will be passed immediately to the line following the : E L se statement. On the

other hand, ifall the lines between : Trap and : E L se complete successfully, con-
trol will pass out of the control structure to (in this case) line [9].
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The final refinement is that specific error cases can be accommodated using : Case
[L1ist] constructs in the same manner as the : Se Lect control structure.

[1] :Trap 17+121 A Component file errors.
[2] tie<name [ftie 0 A Try to tie file

[3] "OK'

[4] :Case 22

[5] 'Can''t find ',name

[6] :Caselist 25+113

[7] 'Resource Problem'

[8] :Else

[9] 'Unexpected Problem'

[10] :EndTrap
Note that : Trap can be used in conjunction with JSIGNAL described below.

Traps can be nested. In the following example, code in the inner trap structure
attempts to tie a component file, and if unsuccessful, tries to create one. In either case,
the tie number is then passed to function ProcessF i Le. Ifan error other than 22
(FILE NAME ERROR)occurs in the inner trap structure, or an error occurs in func-
tion ProcessF i Le (or any ofits called function), control passes to line imme-
diately to line [9].

[1] :Trap O

[2] :Trap 22

[3] tieename [ftie 0
[4] :Else

[5] tie<name [fcreate 0
[6] :EndTrap

[7] ProcessFile tie

[8] :Else

[9] ‘Unexpected Error'

[10] :EndTrap
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Trap System Variable: JTRAP

The second way of trapping errors is to use the system variable: JTRAP.

(OTRAP, can be assigned a nested vector of trap specifications. Each trap spe-
cification is itself a nested vector, of length 3, with each element defined as:

list of error

The error numbers we are interested in.
numbers

Either 'E"' (Execute) or 'C' (Cut Back). There are

action code
others, but they are seldom used.

APL expression, usually a branch statement or a call to

tion to be tak .
action to be taken an APL function.

So a single trap specification may be set up as:
OTRAP«<5 'E' 'ACTION1'
and a multiple trap specification as:
OTRAP«(5 "E' "ACTION1')((1 2 3) 'C' 'ACTION2')

The action code E tells APL that you want your action to be taken in the function in
which the error occurred, whereas the code C indicates that you want your action to
be taken in the function where the JTRAP was localised. If necessary, APL must
first travel back up the execution stack (cut-back) until it reaches that function.

Example Traps

These action codes are best illustrated by example.

Dividing by Zero
Let's try setting aJTRAP on DOMAIN ERROR:

MSG«'''Please give a non-zero right arg'''
OTRAP«11 'E' MSG

When we enter:
10+0
APL executes the expression, and notes that it causes an error number 11. Before issu-

ing the standard error, it scans its JTRAP table, to see if you were interested enough
in that error to set a trap; you were, so APL executes the action specified by you:

10+0
Please give non-zero right arg
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Let's reset our JTRAP:
OTRAP<0p[TRAP A No traps now set
and write a defined function to take the place of the primitive function +:

V R<A DIV B
[1] R<A+B
[2] v

Then run it:

10 DIV O
DOMAIN ERROR
DIV[1] R«A=B
A

Let's edit our function, and include a localised JTRAP:

vV R«A DIV B;[TRAP
[1] A Set the trap
[2] OTRAP«11 'E' '-ERR1'
[3] A Do the work; if it results in error 11,
[4] A execute the trap

[5] R<A+B
[6] A ALL OK if we got to here, so exit
(7] =0

[8] a Will get here only if error 11 occurred
[9] ERR1:'Please give a non-zero right arg'
\'4

Running the function with good and bad arguments has the desired effect:

10 DIV 2

10 DIV O
Please give a non-zero right arg

[TRAP is a variable like any other, and since it is localised in DIV, it is only effect-
ive in DIV and any other functions that may be called by DIV. So....

10+0
DOMAIN ERROR
10+0

A

still gives an error, since there is no trap set in the global environment.
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Other Errors

What happens to our function if we run it with other duff arguments:

123 DIV LK 5
LENGTH ERROR
DIV [4] R<«A=B
A

Here is an error that we have taken no account of.

Change DIV to take this new error into account:

V R«<A DIV B;[TRAP
[1] A Set the trap
[2] OTRAP«(11 'E' '-ERR1')(5 'E' '-ERR2')
[3] A Do the work; if it results in error 11,
[4] A execute the trap
[5] R<«A + B
[6] A ALL OK if we got to here, so exit
[7] -0
[8] na Will get here only if error 11 occurred
[9] ERRi:'Please give a non-zero right arg'e-0
[10] A Will get here only if error 5 occurred
[11] ERR2:'Arguments must be same length'
\4

JRESET

12 3DIV LS5
Arguments must be the same Llength

But here's yet another problem that we didn't think of:

(2 3p16) DIV (2 3 4pi2k)
RANK ERROR
DIV [4] R<A:B
A
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Global Traps

Often when we are writing a system, we can't think of everything that may go wrong
ahead of time; so we need a way of catching "everything else that I may not have
thought of". The error number used for "everything else" is zero:

JRESET
Set a global trap:

OTRAP « 0 'E' ' ''Invalid arguments'' '
And run the function:

(2 3p16) DIV (2 3 4pi2h)
Invalid arguments

In this case, when APL executed line 4 of our function DIV, it encountered an error
number 4 (RANK ERROR). It searched the local trap table, found nothing relating to
error 4, so searched further up the stack to see if the error was mentioned anywhere
else. It found an entry with an associated Execute code, so executed the appropriate
action AT THE POINT THAT THE ERROR OCCURRED. Let's see what's in the
stack:

)SI
DIV[4]x

+0DM
RANK ERROR
DIV[4] R<«A+B
A

So although our action has been taken, execution has stopped where it normally
would aftera RANK ERROR.

Dangers

We must be careful when we set global traps; let's call the non-existent function
BUG whenever we get an unexpected error:

JRESET
OTRAP « 0 'E' 'BUG'
(2 3p16) DIV (2 3 4pi2k)

Nothing happens, since APL traps a RANK ERROR on line 4 of DIV, so executes the
trap statement, which causes a VALUE ERROR, which activates the trap action,
which causes a VALUE ERROR, which .... etc. etc. If we had also chosen to trap on
1000 (ALL INTERRUPTS), then we'd be in trouble!



Chapter 3: Error Trapping 209

Let's define a function BUG:

v

BUG

A Called whenever there is an unexpected error

"sxxx UNEXPECTED ERROR OCCURRED IN: ',o14[]SI

"xxx PLEASE CALL YOUR SYSTEM ADMINISTRATOR'

"xxx WORKSPACE SAVED AS BUG.',>1i[0SI

A Tidy up ... reset OLX, untie files ... etc

0OSAVE 'BUG.',>1i[SI

"x*x%x LOGGING YOU OFF THE SYSTEM'

[oFF

Now, whenever we run our system and an unexpected error occurs, our BUG function
will be called.

Please

10 DIV O
give non-zero right arg

(2 3p16) DIV (2 3 4p112)

xx%x UNEXPECTED ERROR OCCURRED IN: DIV

xxkx PL

EASE CALL YOUR SYSTEM ADMINISTRATOR'

x%xx WORKSPACE SAVED AS BUG.DIV
xxx LOGGING YOU OFF THE SYSTEM'

The system administrator can then load BUG.DIV, look at the SI stack, discover the

problem, and

fix it.

Looking out for Specific Problems

In many cases, you can of course achieve the same effect of a trap by using APL code
to detect the problem before it happens. Consider the function TIEAFILE, which

checks to see

ifa file already exists before it tries to access it:

V R«<TIEAFILE FILE;FILES

[1] ~n
[2] =~
[3] ~n
[4]
[5] ~n
[6]
[7] =~
[8]

Tie file FILE with next available tie number

ALl files in my directory

FILES<OFLIB 'mydir'

Remove trailing blanks

FILES«dbr™4FILES

Required file in list?

+ERRx1~(cFILE)eFILES

Tie file with next number

FILE OFTIE R«1+[/0,0FNUMS
and exit

-0

Error message

ERR:R«'File does not exist'
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This function executes the same code whether the file name is right or wrong, and it
could take a while to get all the file names in your directory. It would be neater, and
more efficient to take action ONLY when the file name is wrong:

V R«TIEAFILE FILE;0TRAP

[1] A Tie file FILE with next available tie number
[2] n
[3] A Set trap

[4] OTRAP<«22 'E' '-ERR'

[5] A Tie file with next number
[6] FILE OFTIE R<«1+[/0,[JFNUMS
[7] A ... and exit if OK

(8] =0

[9] A Error message

[10] ERR:R«'File does not exist'

Cut-Back versus Execute

Let us consider the effect of using Cut-Back instead of Execute. Consider the system
illustrated below, in which the function REPORT gives the user the option of 4
reports to be generated:

REPORT
|
| | | |
REP1 REP2 REP3 REPL
|
| | |
DIV

vV  REPORT;OPTIONS;OPTION;[TRAP

[1] ~A Driver functions for report sub-system. If an
[2] ~A unexpected error occurs, take action in the
[3] A function where the error occurred

[4] =~

[5] ~n Set global trap

[6] OTRAP«O0 'E' 'BUG'

[7] n Available options

[8] OPTIONS«'REP1' 'REP2' 'REP3' 'REPY4'
[9] A Ask user to choose

[10] LOOP:>ENDx10=pOPTION«MENU OPTIONS
[11] A Execute relevant function

[12] <OPTION

[13] A Repeat until EXIT

[14] -LOOP

[15] A Now end

[16] END:
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Suppose the user chooses REP 3, and an unexpected error occurs in DIV. The good
news is that the System Administrator gets a snapshot copy of the workspace that he
can play about with:

)JLOAD BUG.DIV A Load workspace

)SI A Where did error occur?
DIV[4]x*
REP3[6]

&
REPORT([7]

+[JOM A What happened?
RANK ERROR
DIV[4] R<«A=B
A

v A Edit function on top of stack
[0]R<A DIV B

The bad news is, our user is locked out of the whole system, even though it may only
be REP3 that has a problem. We can get around this by making use of the CUT-
BACK action code.

V REPORT;OPTIONS;OPTION;[JTRAP
[1] A Driver functions for report sub-system. If an
[2] A unexpected error occurs, cut the stack back
[3] A to this function, then take action
[4] n
[5] A Set global trap
[6] OTRAP«O 'C' '-ERR'
[7] a Available options
[8] OPTIONS<«'REP1' 'REP2' 'REP3' 'REPY4'
[9] A Ask user to choose
[10] LOOP:->ENDx10=pOPTION«MENU OPTIONS
[11] A Execute relevant function
[12] <OPTION
[13] A Repeat until EXIT
[14] -LOOP
[15] A Tell user ...
[16] ERR:MESSAGE 'Unexpected error in',OPTION
[17] a ... what's happening
[18] MESSAGE'Removing from Llist'
[19] A Remove option from list
[20] OPTIONS<«~OPTIONS~cOPTION
[21] A And repeat
[22] -LOOP
[23] A End
[24] END:
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Suppose the user runs this version of REPORT and chooses REP 3. When the unex-
pected error occurs in DIV, APL will check its trap specifications, and see that the rel-
evant trap was set in REPORT with a cut-back code. APL therefore cuts back the
stack to the function in which the trap was localised, THEN takes the specified
action. Looking at the SI stack above, we can see that APL must jump out of DIV,
then REP3,then ¢, to return to line 7 of REPORT; THEN it takes the specified
action.

Signalling Events

It would be useful to be able to employ the idea of cutting back the stack and taking
an alternative route through the code, when a condition other than an APL error
occurs. To achieve this, we must be able to trap on errors other than APL errors, and
we must be able to define these errors to APL. We do the former by using error codes
in the range 500 to 999, and the latter by using JSIGNAL.

Consider our system; ideally, when an unexpected error occurs, we want to save a
snapshot copy of our workspace (execute BUG in place), then immediately jump back
to REPORT and reduce our options. We can achieve this by changing our functions a
little, and using JSIGNAL:

vV REPORT;OPTIONS;OPTION;[TRAP
A Driver functions for report sub-system. If an
A unexpected error occurs, make a snapshot copy
A of the workspace, then cutback the stack to
A this function, reduce the option list & resume
A Set global trap
OTRAP«(500 'C' '-~ERR')(0 'E' 'BUG"')
A Available options
OPTIONS«'REP1' 'REP2' 'REP3' 'REPY4'
A Ask user to choose
LOOP : >ENDx10=pOPTION«MENU OPTIONS
A Execute relevant function
¢OPTION
A Repeat until EXIT
~LOOP
A Tell user ...
ERR:MESSAGE 'Unexpected error in',OPTION
A ... what's happening
MESSAGE 'Removing from Llist'
A Remove option from list
OPTIONS«OPTIONS~cOPTION
A And repeat
~LOOP
A End
END:
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vV BUG
[1] A Called whenever there is an unexpected error
[2] "sxxx UNEXPECTED ERROR OCCURRED IN: ',o14[]SI
[3] "sxxx PLEASE CALL YOUR SYSTEM ADMINISTRATOR'
[4] "xxx WORKSPACE SAVED AS BUG.',»o14[]SI
[5] A Tidy up ... reset [LX, untie files ... etc
[6] OSAVE 'BUG.',o14[dSI
[7] "sxxx RETURNING TO DRIVER FOR RESELECTION'
[8] [OSIGNAL 500

Now when the unexpected error occurs, the first trap specification catches it, and the
BUG function is executed in place. Instead of logging the user off as before, an
error 500 issignalled to APL. APL checks its trap specifications, sees that 500
has been set in REPORT as a cut-back, so cuts back to REPORT before branching to
ERR.

Flow Control

Error handling, which employs a combination of all the system functions and vari-
ables described, allows us to dynamically alter the flow of control through our sys-
tem, as well as allow us to handle errors gracefully. It is a very powerful facility,
which is simple to use, but is often neglected.
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Handling Unexpected Application Errors in Windows

When running an APL application, it is possible that an unexpected error will occur.

It is advisable to set a trap at the top level of the application which traps all possible
errors; in this way the programmer can cater for any errors that are not already expli-
citly trapped by, for example, writing information to a file, or saving the workspace.
On UNIX in particular it may also be useful to call JOF F with a positive integer to
the right of the JOF F - this is used as the exit code to APL.

It is also possible to generate an error which it is not possible to trap in APL code;
examples include attempting to access the session in a runtime APL, or generating an
error which causes APL to crash (for example, by the incorrect use of a shared library
function).

By default in such cases, APL will pop up a message box, and cannot continue until
the user selects the OK button.

It is possible to override this behaviour by setting the configuration parameter
DYALOG_NOPOPUPS to 1. This will cause system popups to be suppressed; it does
not suppress application popups generated by APL code.

With DYALOG_NOPOPUPS=1 APL will terminate silently, except that an aplcore
file will be generated. The location of the aplcore file can be controlled by the con-
figuration parameter APLCoreName. It may be more useful to ask the operating sys-
tem to handle the unexpected termination of the APL process, for example, by
bringing up a debugger, or Dr Watson. This can be achieved by setting the con-
figuration parameter PassExceptionsToOpSys to 1. In most cases it is useful to
set DYALOG_NOPOPUPS=1 too.

It is also possible to log such events to the Windows Event Log. Setting the con-
figuration parameter DYALOG_EVENTLOGGINGLEVEL to a value greater than 0
will cause this to happen. If the configuration parameter DYALOG_EVENTLOGNAME
is not set, then an event log called Dyalog will be created which can be viewed from
the Windows Event Viewer. The first time that such an event occurs the following
entries will be added to the Windows registry:
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The key HKEY LOCAL
MACHINE\SYSTEM\CurrentControlSet\Services\Eventlog\Dyalog APL with values

Value Name Value
Sources Dyalog APL
MaxSize 150000000

The key HKEY LOCAL
MACHINE\SYSTEM\CurrentControlSet\Services\Eventlog\Dyalog APL\Dyalog APL
with values

Value Name Value

EventMessageFile DYALOG\dyalog.exe

CategoryMessageFile [ DYALOG\dyalog.exe

Category Count 5

TypesSupported 7

where DYALOG is the directory where Dyalog APL is installed.

IfDYALOG_EVENTLOGNAME is set, it should contain the name of the log to which
events will be logged. For example

DYALOG_ EVENTLOGNAME="MyApp Event Log"

When set, no registry entries are added by Dyalog, but if the above registry entries
have been manually created, the events will be logged to an event log which has the
name "MyApp Event Log". If the registry entries described above have not been cre-
ated, the events will instead be logged into the Application Log, and the Event
Viewer will display text similar to the following when events are viewed:

The description for Event ID (1 ) in Source ( MyApp Event Log ) cannot be found.
The local computer may not have the necessary registry information or message
DLL files to display messages from a remote computer. You may be able to use the
/AUXSOURCE= flag to retrieve this description; see Help and Support for details.
The following information is part of the event: Syserror: 995 code: 2 Aplcore
"aplcorel " has been created.
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